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1. Overview
Welcome to ASE2000 Version 2, the first major release of the ASE2000 Communication Test Set 
since it was first introduced in 1998. ASE2000 Version 2 contains all the functionality of Version 
1 plus several new features, enhancements for ease of use, and upgrades requested from our 
many users over the years. 

The ASE2000 is a communication protocol analyzer and communication test tool designed 
for operation in the SCADA industry with emphasis on protocols used predominantly in the 
electric power utility industry. The ASE2000 supports over 80 such protocols, both serial and 
network based. As a full-featured SCADA communication test tool, the ASE2000 supports three 
basic modes of operational testing; Line Monitor Mode, Master Simulation Mode, and RTU 
Simulation Mode. These are essentially functional test modes and exist within the two ASE2000 
operational modes; Exchange Mode and Task Mode. 

Line Monitor Mode is one of the primary uses of the ASE2000 and is used to provide visibility into 
communication occurring between a master station and remote devices (RTUs, IEDs, or PLCs). 
As such, one of the main features of the ASE2000 is the capability to operate as a line monitoring 
device, presenting communication message data in raw (numeric) format, and also interpreting 
those messages into protocol specific English text for ease of understanding. Input point values 
are extracted from the message and can be viewed in a separate tabular formatted view.

In addition to monitoring communication on a serial line or network connection, the ASE2000 
can also operate as either a master or remote device to further exercise, test, and diagnose 
problems.

Master Simulation Mode provides the ability to simulate a master and to issue messages to 
exercise and diagnose problems in a remote device. All information and views available in 
Line Monitoring mode are also available in Master Simulation mode. The main difference is 
operational in that the ASE2000 takes the place of the master in transmission of messages to 
the remote device.

RTU Simulation Mode provides the ability to simulate one or more remote devices to exercise the 
master and diagnose potential problems. All information and views available in Line Monitoring 
mode are also available in RTU Simulation mode. The main difference is operational in that the 
ASE2000 takes the place of the remote device (or devices) in transmission of messages to the 
master.

For video demonstrations of ASE2000 Communications Test Set V2, visit the Applied Systems 
Engineering website: http://www.ase-systems.com/videos/trainingvideo.asp.

1
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2. Version 1 / Version 2 Comparison
Version 1 of the ASE2000 Communication Test Set was first released in 1998 with thousands of 
copies currently in use worldwide. And, while some areas of ASE2000 Version 2 have a slightly 
different look and feel than Version 1, there was a significant effort made to provide a familiar 
operating interface for users already familiar with Version 1 to minimize the learning requirement 
in making the transition from Version 1 to Version 2. 

2.1. Exchange Mode and Task Mode Highlights
The most significant difference between ASE2000 Version 1 and Version 2 is the addition of Task 
Mode operational mode. ASE2000 Version 1 has a single, unnamed, operational mode but, with 
the addition of Task Mode in Version 2, it became necessary to distinguish between the two 
Version 2 operational modes. In Version 2, the test set features provided in Version 1 as well as 
a Version 1 “look and feel” is available in Version 2 Exchange Mode and, to a certain extent, can 
be thought of as Version 1 “compatibility mode”. The main conceptual different between the two 
modes is in the way communication is organized. For the most part, the same capabilities exist 
in both Exchange and Task Modes. In addition, Task Mode supports some complex operations 
such as file transfers and embedded DNP3 security messages. These capabilities are only 
partially available in Exchange Mode. Exchange Mode can support multiple operations, such 
as scanning a device for data while also periodically issuing control output requests. Task Mode 
currently supports single operations only.

Exchange Mode operations are based on the selection and configuration of one or more 
protocol messages or exchanges. The terms message, protocol message, and exchange will 
be used interchangeably in this document. The user selects one or more messages, edits them 
as necessary for the point configuration of the target device, and enables communication for 
the appropriate functional mode; Monitor, Master, or RTU. Some detailed knowledge of the 
protocol may be required for message preparation. Content of all messages must be configured 
in advance and message content cannot be edited once communication starts.

Task Mode is a new mode of operation introduced in Version 2 and is intended to provide a 
simple, easy to use interface to commonly used test set functions that do not require a detailed 
knowledge of the protocol. As the name implies, it presents a “task” oriented interface for selecting 
test set functionality. For example, instead of a list of individual exchanges, the user is presented 
with a set of functional “tasks” such as “Initialization”, “Acquire Data”, ”Controls”, etc. Within each 
task group is a set of exchanges that, for the selected protocol, provide the functions specific 
to the task group. Instead of configuring individual exchanges as in Exchange Mode, the user 
must configure devices (RTU, IED, PLC, etc.) in terms point types and point counts and the 
device configuration is used in Task Mode to automatically configure the appropriate protocol 
message for the desired task. Once a device configuration is entered, it is saved permanently 
is a device database where it can be re-selected for future test sessions. When operating in 
Task Mode, Master Simulation and RTU Simulation actions are performed on a single, selected 
device. Monitor Mode supports monitoring of one or more selected devices.

2
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2.2. Exchange Mode and Task Mode Operational Basics
From an operational perspective:
• Exchange Mode operates as an ASE2000 Version 1 Test Set. The user selects a protocol, 

is presented with an applicable set of exchanges (messages), configures and enables one 
or more of these exchanges, and starts communication. Master Simulation, RTU Simulation, 
and Monitor modes appear very similar, if not identical, to those in Version 1. Some manual 
editing of the default exchanges to account for specific point configurations may be necessary 
prior to start of communication. The actual editing steps required are largely dependent on the 
protocol selected and is very similar to Version 1 editing requirements.

• Task Mode communication is based on point configuration information for a particular device. 
Before starting Task Mode operation for the first time, the user must define one or more devices 
(RTUs, IEDs, PLCs). The properties for defining a device include a protocol, device address, 
and point configuration information (point types, addresses, and counts). Device definition is 
persistent (retained when the ASE2000 is stopped and restarted). The user starts Task Mode 
operation by first selecting a device from the pre entered list. The ASE2000 responds by 
displaying a list of tasks applicable to the protocol of the selected device. Tasks are grouped 
in functional categories such as Initialize, Acquire Data, and Time Sync. The user proceeds by 
selecting a grouping and a task within the selected group.

In Master Simulation mode, communication is started by selecting one of the Transmit ICONS 
(Send Once or Send Continuously). The ASE2000 automatically transmits messages required 
to accomplish the selected task.

Monitor Mode contains a single task, selection of which starts the line monitoring process. Data 
response interpretation uses point information entered during the device configuration step. 

For some protocols, such as Harris, Conitel, and CDC, the ASE2000 can only parse point data 
from a communication message if it knows, in advance, the device’s point configuration. For 
these, message interpretation replies on correct user data base configuration information entry. 

For other protocols such as IEC and DNP3 where point configuration can be determined from the 
communication message, the ASE2000 automatically creates data base entries for undefined 
points. For these protocols, data base configuration information definition is desirable, but not 
100% required. It suffices to enter only the correct device address or ID.

Task Mode monitoring is oriented to a single device. If you wish to monitor multiple devices on 
a communications line, and have a protocol that requires advanced knowledge of the devices 
configuration then you may find the Exchange Mode better suited for this operation. 

RTU Simulation mode also contains a single task. The ASE2000 builds response messages 
based on point information entered during the device configuration step. Complete point 
configuration information must be entered for all RTU Simulation devices being used, regardless 
of protocol.

During online operation in RTU Simulation mode, values for individual points can be manually 
entered in the Point Values view.

Both Exchange and Task Mode support RTU simulation of a single device. Task Mode enforces 
this by only responding to messages addressed to the selected device.
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2.3. Other Version 1 and 2 Comparisons
• Line Monitor View. Both ASE2000 Versions 1 and 2 show master/remote communication 

messages in a Line Monitor View with Interpreted Data at the right and Raw Data at the left. 
The entirety of each message is always shown. For ASE2000 Version 1, this is the only way 
to view communication line traffic. ASE2000 Version 2 supports this view as well as the new 
Messages View. 

• Messages View. This view provides an alternate format presentation of master/remote 
communication messages, one message per line, with time, direction, and message name. 
This compact format allows presentation of many more messages, in the same monitor space, 
than the Line Monitor view, and makes it easier to locate a particular message. Clicking on 
any message generates an expanded view of that message, frequently with more information 
than contained in the Line Monitor View. The Messages View is useful when the user wants 
to see details of selected messages only. The Line Monitor View is useful to see details on 
all messages.

• Tool Bar. In response to user requests, the layout has been changed to include ICONs for 
frequently selected options.



ASE2000 V2 Communication Test Set User Manual 14

3. Software Installation
The ASE2000 Version 2 Test Set is a .NET application that can operate under Windows XP, 
Windows Vista, or Windows 7 and 8 and requires installation of both ASE and Microsoft 
components. 

ASE
• ASE2000 Version 2 software
• BCOM-USB or USB Dongle I/O driver

Microsoft
• .NET Framework 4 (Later releases of the ASE2000 may require a newer version of Framework).
• SQL Server, Compact Edition Version 3.5

3.1. Windows Operating System Support
ASE2000 Version 2 operates under Window XP, Vista, Windows 7 and 8. It is not supported on 
older Microsoft operating systems or in any non-Windows operating system. A single ASE2000 
executable is supported on both 32-bit and 64-bit versions of the operating systems but requires 
installation of the appropriate I/O driver, 32-bit or 64-bit, for the Windows system being used.

3.2. Hardware Requirements
ASE2000 Version 2 operation requires an ASE-manufactured BCOM-USB device or USB 
Dongle. (An exception exists for trial mode). 

The ASE2000 Version 2 will not operate with an ASE PCMCIA communication card unless 
a BCOM-USB or USB Dongle is also present.

ASE’s BCOM-USB device contains two RS-232 channels both capable of bit or byte 
communication. It also supports 5 VDC power and RS-232 connection to ASE’s dual channel 
modem, similar to connection with ASE’s PCMCIA card.

Users with a PCMCIA-based ASE2000 Version 1 package and wishing to upgrade to Version 
2 must also upgrade their PCMCIA card to a BCOM-USB device or ASE USB Dongle. Contact 
ASE sales at sales@ase-systems.com for details on the upgrade process.
 
ASE2000 Version 1 will continue to operate with the BCOM-USB device as long as release 
1.47 or later is installed. That is, upgrade customers will be able to use Version 1 or Version 2 
software with the BCOM-USB device. Upgrade customers are allowed to retain their PCMCIA 
card until the new BCOM-USB device is delivered.

For serial operations, the ASE2000 can use both ports on the USB-BCOM board or any other 
serial port as long as it is supported by a Windows compatible COM port I/O driver.

For network operation, the ASE2000 operates over any standard network device (NIC) using a 
standard Windows I/O driver. 

3
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3.3. Installation Setup
Microsoft components, .NET Framework and SQL Server, if not already present, will be 
automatically installed during the ASE2000 installation process. Only the English language 
versions will be automatically installed. If non-English versions are required, they should be 
installed manually before the ASE2000 installation. This requires Internet connection.

3.4. Installation Procedure
To install and run the ASE2000 Version 2:
• For non-English operation, make sure the appropriate language .NET Framework and Compact 

SQL components are installed before installing the ASE2000
• Install the ASE2000 Version 2 software. This will install .NET Framework and Compact SQL 

components if required.
• For a fully licensed version, install the I/O driver for the ASE BCOM-USB dual channel device 

or USB key. Install the driver version appropriate for your Windows version (32-bit or 64-bit).
• For a trial version, download and install a trial version setup program from www.ase-systems.

com. More details can be found on that web site
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4. Quick-Start Guide
The following “Quick-Start” sections contain step-by-step procedures that will enable the user to 
quickly get “up-and-running” for basic test set operations. Quick-Start procedures are provided 
for the Operational Modes, Task and Exchange, and for the Communication Modes, Master 
Simulation, RTU Simulation, and Monitor.

The procedures consist of steps which are common for any test set operation and steps that are 
protocol dependent. The set-up for any test set operation consists of the following main areas:

1. Physically connect Test Set PC to the communication circuit
2. Launch ASE2000 Test Set application
3. Select Operational Mode, Task Mode or Exchange Mode
4. Select and configure protocol
5. Configure communication settings
6. Select Communication Mode and start communicating

Additional “quick-start” information is contained in protocol specific sections. These sections can 
be located by performing a search on the string “quick-start” (omit the quotes). 

4.1. Physical Connection to Communication Circuit
The first step of set-up is the physical connection of the test set PC to the communication circuit. 
How the test set PC is connected to the communication circuit depends on a number of factors 
but it is basically determined by the physical characteristics of the communication circuit and the 
test set Communication Mode to be used. Refer to the diagrams and descriptions contained in 
the section ASE2000 Cabling for the configuration that matches the test environment to be used. 
Once the physical connection has been made, proceed to the next step. 

4.2. Launch ASE2000 Test Set Application
From the Windows Start button, select “All Programs > ASE>ASE2000 V2 Communications Test 
Set>ASE2000 V2 Comm Test Set” or, if a shortcut was previously created on the desktop, select 
the ASE2000 V2 icon to launch the ASE2000 application. 

4.3. Select Operational Mode – Task Mode or Exchange Mode
Once the ASE2000 application has started, the next step is to select the desired Operational 
Mode. If it is the first activation of the ASE2000 software on the PC, the ASE2000 will, by default, 
start in Exchange Mode. If there have been previous executions of the ASE2000 on the PC, the 
default Operational Mode will be the mode the test set was in upon exit of the previous execution. 
Also, if the last Operational Mode was Exchange Mode and the test environment was saved in a 
MONX file, the last used MONX file will automatically be opened on start-up. If in Task Mode at 
the time of exit of the previous execution, then Task Mode will be the default start-up Operational 
Mode and the default “active RTU” will be the last RTU selected. To select other than the default 
Operational Mode, select Mode from the task bar then select the desired mode.

4
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4.4. Selection	and	Configuration	of	Protocol
The method for selection and configuration of protocol will depend on the Operational Mode.

4.4.1. Exchange	Mode	Protocol	Selection	and	Configuration
In Exchange Mode, protocol selection is performed in one of four ways:
• Default protocol on start-up – If the default Operational Mode on start-up is Exchange Mode 

and there was a saved “MONX” file during the previous execution, the last used MONX file will 
automatically be loaded on start-up. This will establish operational parameters based on what 
was previously set in the MONX file.

• Open existing MONX file – To establish an operating environment based on a previously 
saved MONX file, from the task bar select “File > Open” and browse to the folder containing 
the previously saved MONX file. Select the file and then select “Open”. This will establish 
operational parameters based on what is contained in the MONX file.

• Open existing MON file – A MON file is similar to a MONX file, but created by ASE2000 Version 
1 software. The procedure for opening a MON file is similar to opening a MONX file. The file 
type, MON or MONX, is selectable from a pull down list in the bottom right portion of the file 
open menu.

• Select protocol from protocol menu – On initial execution of the test set software or if a protocol 
is required for which there is no existing MONX file, the required protocol is selected from 
the Available Protocols menu. From the task bar select “File > Select Protocol” then select 
the required protocol from the list. The Exchange List view will be updated to contain the 
set of exchanges (commands, protocol messages) specific to the selected protocol. All other 
operational parameters will be set to default values and will have to be modified for the current 
test environment. This may include communication settings, device specific settings (RTU ID, 
point configuration, etc.), and protocol specific settings. 
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4.4.2. Task	Mode	Device	Selection	and	Configuration
In Task Mode, protocol selection and configuration is accomplished by selecting a device where 
protocol is a property of the device selected. Device selection is performed in one of three ways:

• Default device on start-up – If the default Operational Mode on start-up is Task Mode and 
there was an “active” device during the previous execution, the last active device will be the 
default active device on start-up. 

• Select	previously	defined	device – To select a device that is different than the current active 
device, select from the list of displayed devices in the “Task” window. If the required device 
has been previously defined but does not appear in the list of displayed devices, select “Edit 
> Configure RTUs…” and check the “Display” check box for the desired device then select 
“Finish”. The device should now be displayed in the devices area of the Task window and can 
be selected as the active device by clicking on the line containing the device.
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• Define	new	device – On initial execution of the test set software or if a new device definition is 
required, use the “Configure RTUs Wizard” to define the new device. Select “Edit > Configure 
RTUs…” to bring up the Configure RTUs Wizard page. On the line containing the *, enter the 
device Name, Id, and select the appropriate protocol from the Protocol drop-down list. When 
the device information has been entered, select the “Next>>” button which will bring up the 
point configuration display. Using the entry fields, enter “Point Type”, “First Point Id”, and “Point 
Count”. When the point configuration entry is complete, select the “Finish” button to exit the 
Configure RTUs Wizard.

Enter device name, select device protocol from pull-down list and enter device (RTU) Id. Note 
that not all protocols are fully supported in Task Mode. If the box in the Display column is checked, 
the device is Active and will appear in the Task pane. Then, select Next to enter device point 
configuration.
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4.4.3. CSV Point List Import / Export
A new RTU and point list may also be imported from text files. The file format used is CSV (comma-
delimited values), a text-viewable format interchangeable with Excel and other applications. In 
some regions, characters other than comma are used as delimiters and are also supported.

A simple example of the file format looks like this (as viewed in Notepad):

Name,Protocol,Id,PointName,PointType,PointId
Conitel,Conitel 2020,5,,AI,0
Conitel,Conitel 2020,5,,AI,1

In Excel, this same file appears as:

Name Protocol Id PointName PointType PointId
Conitel Conitel 2020 5 AI 0
Conitel Conitel 2020 5 AI 1

In the above example, the RTU name is ‘Conitel’, the Protocol is ‘Conitel 2020’, and the RTU Id is 
5. Each line defines a point of type ‘AI’; the first with a point Id of 0 and the second is 1. Note that 
no point names are provided, but the delimiting commas are still required to maintain positioning 
order with the header description in the first line.

Other point fields may be provided, but the minimum requirement is for PointType and PointId to 
be provided with a header line and at least one data point. The minimum data is therefore:

PointType,PointId
AI,0

During import, the user is prompted for additional information necessary to create the RTU: RTU 
Name, Protocol and RTU Id.
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Importing Point Lists
To import a new RTU and its points from a CSV file, select Import from the File menu and choose 
CSV Point List from the sub-menu.

An Open File dialog box will appear. Choose a directory and filename and press the ‘Open’ 
button to begin the import. During import processing, the user is prompted to confirm the RTU 
Name, Protocol and RTU Id. If any information is missing, it must be provided before continuing. 
Duplicate RTU names are not allowed. Press ‘OK’ to proceed with importing.

After a successful import, the RTU is added to the Current RTU List and its points are displayed in 
the lower grid. An imported RTU is not automatically set to Active. To activate the imported RTU, 
use the ‘Configure	RTUs…’ wizard. Another import may be started by pressing the ‘Import’ 
button. 

If the import is not successful, the import file contents and detailed information on the import 
attempt may be viewed. Correct any issues flagged with ‘***’ and retry the import.

Exporting Point Lists
Users may also export an existing RTU and its points to a CSV file for viewing and editing in 
Excel. Since all supported columns are written out, the export feature is helpful in creating a 
template for one or more new RTU Point Lists. To access the Export feature, select Export from 
the File menu and choose CSV Point List from the sub-menu.

The Export dialog box will appear. Select one of the RTU from the Current RTU List. All defined 
RTU are displayed in the list whether Active or not. When the RTU is selected, its point list is 
displayed in the grid below. All fields are read-only. To make changes to the RTU before export, 
close this dialog and use the ‘Configure	RTUs…’ wizard. To export the point list data press the 
‘Export’ button to choose a directory and filename. Press the ‘Save’ button to write the CSV file.

4.5. Protocol	Specific	Configuration	
Quick-Start instructions for protocol specific information is contained in individual protocol specific 
sections. These sections can be located by performing a search on the string “quick-start” (omit 
the quotes). Perform the required protocol specific configuration then proceed with Configuration 
of Communication Settings.

4.6. Configuration	of	Communication	Settings
With the physical connection between the test set PC and the communication circuit established, 
the ASE2000 software running, and the Operational Mode established, the next step is to set 
the communication parameters to reflect the physical properties of the connection. The next 
sections describe the procedures for setting parameters for serial data communication and for 
network connections.

4.6.1. Communication Settings for Serial Data Communication
Configuration of communication settings for serial data utilizes the Properties display and Comm 
tab. From the main task bar, select “Tools > Properties > Comm tab”.
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Verify current settings and, where appropriate, modify the settings for the current test session. 
NOTE: If a switch to a different Operational Mode is performed after modification of a communication 
setting, re-check the settings as they may have changed as a result of the mode switch. 

1. Verify the Channel A and Channel B Direction settings reflect the physical connection 
between the test set PC and equipment being tested. If working in Master Simulation or RTU 
Simulation mode, only one channel connection is necessary.

2. Under Line Properties, set Carrier setting. In most cases, Switched or Constant will be used. 
If the physical connection utilizes a Null Modem or a real modem, the setting should be 
Switched. Otherwise, use Constant. For the other settings, see the more detailed description 
of the communication settings.

3. Verify Baud Rate matches baud rate of device to be communicated with.
4. If the selected protocol is byte-oriented, check the “Native Async Mode” check box. For bit-

oriented protocols, un-check it. 
5. The default Modem Timing settings will usually work in most circumstances.
6. The default Delays & Timeouts will usually work in most circumstances.

Communication Settings for Network Communication
Configuration of communication settings for network communications utilizes the Properties 
display and the “protocol specific” tab (DNP3 WAN/LAN, Modbus TCP, or IEC 60870-5-104). 
From the main task bar, select Tools > Properties > “protocol specific” tab. In most cases, the 
default parameters will be sufficient. For Master Mode, it is necessary to enter the IP address 
of the Slave device. This is entered in the Host field. For RTU Simulation and Monitor Mode 
it is not necessary to enter an IP address. Select IPv6 when monitoring devices or providing 
Host addresses using the broader IPv6 address space. (Other options are protocol specific and 
described in their respective sections.)
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► IPv4 is a 32-bit Internet Protocol addressing mechanism represented as four 8-bit 
decimal values separated by dots as in: “192.168.0.148”. With the explosion of the 
internet and devices using these addresses, IPv6 was introduced with a larger, 128-bit 
addressing mechanism in the form of eight 16-bit hexadecimal values separated by 
colons as in: “2013:08be:9ce8:0000:0000:0000:ff00:034d”.

 

4.7. Select Communication Mode and Start Communicating
With the previous quick-start steps complete, the next step is to select the desired Communication 
Mode. 

In the lower left corner of the test set screen is a set of Communication Mode selection icons. 

The leftmost icon  selects Master Simulation Mode.

The middle icon  selects Monitor Mode

The rightmost icon  selects RTU Simulation Mode

With Communication Mode selected, start/stop communication by selecting the desired action 
from the “Player Bar”. The Player Bar is normally located in the upper left area of the test set 
screen. The content of the Player Bar is context sensitive and displayed content will depend on 
Operational Mode and Communication Mode.

The  icon is the Start Communication icon and is used in all modes
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The  icon is the Stop Communication icon and is used in all modes

The  icon is the Send Continuous icon and is only used in Exchange Mode / Master Simulation 
Mode

The  icon is the Send Once icon and is only used in Exchange Mode / Master Simulation 
Mode

4.7.1. Exchange Mode – Master Simulation Mode
Three communication options are available; Send Once, Send Continuous, Selected Exchanges. 
Send Once and Send Continuous are used with a single exchange. From the Exchange View, 
select the line containing the desired exchange then select Send Once or Send Continuous. It is 
also possible to specify multiple exchanges to be used in a communication session. This is done 
by selecting the Flags field for the desired exchanges, setting the check-box for Transmit, and 
selecting the Start Communication Player icon. All exchanges with the Transmit flag set will be 
repeated continuously at the configured frequency.

4.7.2. Exchange Mode – Monitor Mode
Select the Start Communication icon.

4.7.3. Exchange Mode – RTU Simulation Mode
Select the Start Communication icon.

4.7.4. Task Mode – Master Simulation Mode
In Exchange Mode, one or more individual exchanges are selected for processing. In Task Mode, 
Task Activities are selected for processing. The actual protocol exchanges associated with each 
Task Activity are pre-determined based on protocol. 
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Select the desired Task Group, select the desired Task Activity, and then select the Start 
Communication Player icon. The selected activity will be repeated continuously at the configured 
frequency. To perform the selected activity once, select the Once icon.

4.7.5. Task Mode – Monitor Mode
The only Task Group available is “Scan Responses” so no “Task” selection is necessary. Select 
the Start Communication icon

4.7.6. Task Mode – RTU Simulation Mode
The only Task Group available is “Scan Responses” so no “Task” selection is necessary. Select 
the Start Communication icon
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5. File Types
The ASE2000 Communication Test Set V2 interacts with several different file types referenced 
in their respective topics:

MONX files contain Exchange Mode configuration information including the protocol, window 
layout, and user and data entry values. The default file extension for an ASE2000 Version 2 
configuration file is MONX. MONX files are not compatible with ASE2000 Version 1 configuration 
files, whose extension is MON. MONX files are applicable to Exchange Mode operation only 
and can neither be saved nor opened while running in Task Mode.

MON files contain Exchange Mode configuration information similar to .MONX files, but were 
generated with ASE2000 V1. Once opened in ASE2000 V2, it is recommended to save the 
configuration in a .MONX file. Changes made to the configuration cannot be saved to a .MON 
file format.

MSGX files contain Communication Message data as shown in the Line Monitor and Messages 
view. A saved MSGX file can be sent to another ASE2000 user for viewing.

CSV files are ‘Comma-Separated Value’ columnar data stored in a readable text format. CSV 
files are supported by Microsoft Excel for convenient handling. Although the comma “,” character 
is most frequently used as the column delimiter, other displayable punctuation characters (non-
alphanumeric) are supported. During a Point List import operation, the delimiting character will 
be determined by examining the file contents.

PCAP/PCAPNG files are capture files produced by the Wireshark network utility. Beginning with 
Build 2.17, these files may be directly imported into the ASE2000 V2 Test Set.

TXT files are text files containing communication message data. Beginning with Build 2.18, 
communication data represent as text may be imported into the ASE2000 V2 Test Set if compliant 
with representation guidelines.

5
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6. Communication Message Processing
This section describes the test set capability for saving and viewing previously saved 
communication messages. Communication Messages are initially generated as the result of 
communication or attempted communication between two or more devices. From the test set 
perspective, Communication Messages result from Master Mode operation, Monitor Mode 
operation, or RTU Simulation Mode operation and applies to both Exchange Mode and Task 
Mode. During a live communication session (Master Mode, RTU Simulation, or Monitor Mode), 
communication messages are always stored in the Current Message Buffer. This is an internal 
temporary storage area within the test set specifically intended to store communication message 
data. In addition, the Current Message Buffer is used to store:

• Communication message data resulting from importing previously saved message data from 
a .MSGX file (File > Import> Communication Messages).

• Communication message data previously stored in a capture file when the View Capture option 
is selected.

When the “File > Export > Communication Messages” option is selected, the data stored in the 
Current Message Buffer will be written to the designated .MSGX file. 
The Line Monitor or Messages views will display data currently in the Current Message Buffer 
regardless of where the message data was obtained.

The following screen shot illustrates the same message data displayed in the Messages view 
and the Line Monitor view. 

6
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Also, the message data as shown in the Line Monitor View can be printed to a Windows supported 
printer, a searchable PDF file, or other printer file types. Printing to a file provides a convenient 
means for sharing the message data with another party. In the printed version of the message 
data, the raw data as show in the left window pane above is merged with the interpreted message 
data as shown below.

There are two basic facilities for saving and viewing previously saved messages, the Message 
Export/Import facility and the Capture facility. The two facilities provide similar capability in that 
they both store communication message data in a form that can be later retrieved and viewed. 
The differences are that the Message Export/Import facility can be used to save whatever is 
currently in the Current Message Buffer and is limited by the size of the Current Message Buffer 
whereas the Capture facility must be enabled prior to the start of a communication session.

6.1. Message Export/Import Facility
This facility is used to save current message data and to retrieve message data previously saved 
in a MSGX file. Since the save process is initiated after a communication session has occurred 
and while the data of interest is still in the Current Communication Buffer, it is a useful tool for 
preserving an unexpected occurrence for later analysis. 

To save the contents of the Current Communication Buffer, communication must be stopped. 
Select “File>Export>Communication Messages”, specify a folder and file name, select “Save”.

To retrieve message data from a previously saved MSGX file, Select “File>Import>Communication 
Messages”, specify a folder and file name, select “Open”. The contents of the specified file will 
be read and stored in the Current Communication Buffer where it can be viewed in the Messages 
view, the Line Monitor view, and printed from the Line Monitor view.
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6.2. Message Import Wireshark Files
Release 2.17 and later allows import of pcap and pcapng files generated by the network traffic 
capture program Wireshark. This feature is available only for Wireshark files containing DNP3 
LAN/WAN, IEC 60870-5-104, or Modbus/TCP traffic. 

The ASE2000 V2 must be licensed. While data captured by a licensed ASE2000 V2 and saved to 
a MSGX file can be loaded and read by an unlicensed ASE2000 V2 or by the free ASE Message 
Viewer utility, Wireshark file data import is a licensed feature only.

To import an applicable Wireshark file:
• Exchange Mode: File menu  Select Protocol, choose the applicable protocol
• Task Mode: Select or create a device for the applicable protocol
• It is recommended to select Monitor mode so that filters for both master and remote can be 

entered as described in the next bullet. Import may work in some, but not all, cases from other 
modes 

• To determine message direction, IP addresses for master and remote devices must be entered 
in the IP filter area at the top of the ASE2000 screen. A filter of “Any” can be used for DNP3 
since that protocol contains direction information in each message. “Any” will not work for IEC 
60870-5-104 or Modbus/TCP

• Under Tools, Properties, and the tab specific to the protocol being used (it is always the 
rightmost tab), make sure that the Port setting is the same as used when Wireshark created 
the file. The ASE2000 sets this field to the default port for each protocol, but a different port 
can be configured

• Open the file: File menu  Import  Communication Messages
• From the pull-down list in the bottom right corner of the file open menu, set the type to Wireshark

• Locate and open the file

The Wireshark file will be opened with data applicable to the selected protocol extracted and 
shown in the line monitor and messages views, the same as if the ASE2000 had detected those 
messages in a normal monitoring session.

A Wireshark file may contain more messages than the in-memory import of the Test Set supports. 
If this is the case, start a Test Set capture before import to place Wireshark messages in a Test 
Sets capture file, which can then be viewed or searched. The user may also want to use the 
capture filter feature to pinpoint the messages of interest.
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6.3. Message Import Text Files
Release 2.18 and later allows import of message data from text files, usually with a .txt file 
extension.

The ASE2000 V2 must be licensed. While data captured by a licensed ASE2000 V2 and saved to 
a MSGX file can be loaded and read by an unlicensed ASE2000 V2 or by the free ASE Message 
Viewer utility, text file import is a licensed feature only.

To import message data from a text file:
• Exchange Mode: File menu  Select Protocol, choose the applicable protocol
• Task Mode: Select or create a device for the applicable protocol
• It is recommended to choose Monitor mode so that filters for both master and remote can be 

entered as described in the next bullet. Import may work in some, but not all, cases from other 
modes 

• Open the file: File menu  Import  Communication Messages
• From the pull-down list in the bottom right corner of the file open menu, set the type to Text 

Message Files

• Locate and open the file

The text file will be opened with data applicable to the selected protocol extracted and shown 
in the line monitor and messages views the same as if the ASE2000 V2 had detected those 
messages in a normal communication session.

6.3.1. Text Message File Structure
Data in the text file must comply with the following requirements to be successfully parsed into 
protocol message data.

• Direction Indicator – Master to Slave: ‘>’ character must proceed data bytes
• Direction Indicator – Slave to Master: ‘<’ character must proceed data bytes
• Time Stamp – Time (if present): must be enclosed within ‘[‘ and ‘]’ characters and must comply 

with ISO 8601 format. This is a time zone independent date and time representation
• Data stream – Data is a sequence of hexadecimal bytes separated by space characters. Bit 

protocol data may be parsed if expressed as if it was received by ASE hardware

6.3.2. DNP3 Example
Here is a text file data example for the DNP3 protocol.

> [2016-05-03T13:36:11.2837940-07:00] 05 64 05 C9 41 00 00 00 B0 88 
< [2016-05-03T13:36:11.2847125-07:00] 05 64 05 0B 00 00 41 00 91 5B 
> [2016-05-03T13:36:11.3823358-07:00] 05 64 05 C0 41 00 00 00 FF FE 
< [2016-05-03T13:36:11.3833393-07:00] 05 64 05 00 00 00 41 00 D2 6B 
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6.4. SPT Import Files
Release 2.21 and later allows import of message data from SPT files using a .001 extension. 
This is supported for several protocols (tested using DNP3, Modbus RTU, CDC Type 1 and 
2, and Conitel 2020) using ASE2000’s SPT traffic log files. ASE 2000 can display the details 
of traffic through SPT products using existing offline traffic log files. These logs can be easily 
retrieved from already running SPT gateways using SPT Editor. Note: Users using SPT products 
must save these files using .001 file type.

6.4.1. DNP3 Example
02/14/2018 15:30:08:>W DNP 3.0(1:1) [48.812] PHY ........: 3C 03 06 3C 02 06 3C 01
06 39 9D
02/14/2018 15:30:08:>W DNP 3.0(1:1) [49.125] PHY Rcv (10): 05 64 25 44 00 00 01 00
D9 8D
02/14/2018 15:30:08:>W DNP 3.0(1:1) [49.437] PHY Rcv (36): C7 C7 81 10 00 01 01
00 00 07 00 1E 04 00 00 07
02/14/2018 15:30:08:>W DNP 3.0(1:1) [49.437] PHY ........: 1D 36 00 00 00 00 00 00
00 00 00 00 00 00 00 00
02/14/2018 15:30:08:>W DNP 3.0(1:1) [49.437] PHY ........: 00 00 FF FF

6.5. Message Capture Facility
This facility provides similar capability to the Message Export/Import facility in that it also 
provides for saving and retrieving message data. The primary difference is that it allows the user 
to store a much larger number (user configurable) of messages. Also, message capture must 
be enabled prior to starting a communication session. Unlike the Message Export/Import facility, 
the Message Capture facility does not use a Windows file to store message data but rather a 
Capture Database that contains one or more Capture Sessions. 

To initiate a capture session, use the Capture name select drop-down menu in the task bar 
to select an existing capture name or define a new name and specify the maximum size, in 
messages. The Count field shows the number of messages currently stored in the named capture 
session. 

The currently select capture session name is displayed in the Task Bar. 

Capturing can be started, stopped, and paused using the “player” buttons located in the task bar. 
The capture player controls are independent from the communication player buttons so that it 
is possible to start, stop, and pause capturing without affecting data communication. However, 
only communication messages that occur while capturing is active (start button pressed) will be 
saved. It is important to be aware of the functioning of the capture player buttons as it affects 
when data is captured and when the contents of the capture session are reset. 

• Pressing the Play button  will cause new communication messages to be stored in the 
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current capture session as they occur. The Play icon will be replaced by the Pause  icon 

and the Stop  icon will be selectable. If capturing was in a stopped state, rather than a 
paused state, when the Play button was pressed the prior contents (if any) of the capture 
session will be reset (erased).

• Pressing the Pause  icon will suspend capturing and the Pause icon will be replaced with 
the Play icon. The Stop icon will still be selectable since capturing is only in a paused state. 
Capturing can be resumed without resetting the contents of the capture session by pressing 
the Play icon.

• Pressing the Stop  icon will stop message capturing. CAUTION, from a stopped state, 
pressing the capture play button will cause the contents of the currently selected capture 
session to be erased.

With capturing and communication both in a stopped state, the contents of the currently selected 
capture session can be viewed by selecting “File>View Capture” or a different capture file may 
be selected for viewing.
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7. Screen Layout
The main areas of the ASE2000 screen are, top to bottom:

7.1. Title Line
The Title Line appears at the top of the screen and presents operational information:

• Program Name
• The loaded MONX (configuration) file name
• The currently selected protocol
• Communication Mode (Master Simulation, RTU Simulation, or Monitor mode)
• Operational Mode (Exchange or Task mode)

7.2. Menu Bar
The Menu Bar, the second line from the top, contains the set of pull-down menus.

7.2.1. File Menu
Contents of the file pull-down menu are as shown. Some of the entries in the File Menu are 
context sensitive and will be “grayed out” if the option is not available in the current test set 
mode or test set operation. The first four options are used to create, open, or save a MONX file 
in Exchange Mode.

The print menu items are present only for views that support printing. This would include Line 
Monitor, Event Log, Line Analyzer, and Point List.

7
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Individual items on the file pull-down menu are:

New Set the ASE2000 to default setting and initial values. Valid in Exchange Mode only
Open Open an existing MONX file (or ASE2000 Version 1 MON file)
Save Saves current information into the last used MONX file
Save As Same as Save, except that you will be prompted to enter a file name prior to saving
Page Setup Enter print configuration information
Print Print the current contents of the Line Monitor view
Print Preview Print preview of the current contents of the Line Monitor view
Select Protocol Valid in Exchange Mode only, allows selection of any licensed communication 

protocol. (Task Mode protocol is determined from the selected RTU device.)
View Capture Views contents of the currently selected capture file. A capture file contains 

information from a communication session. Available capture files are listed in the 
sub-menu.

Import Used to import previously saved Communication Messages (MSGX) file, DNP3 
Certification Procedure file, or RTU Point List data in CSV format.

Export Used to export Communication Messages to a MSGX file for later retrieval and 
analysis, DNP3 Certification Test results file, or RTU Point List data in CSV format.

1-File Name
2-File Name
3-File Name
4-File Name

The most recently accessed MONX files are shown for convenience (Exchange 
Mode only).

Exit Exits the ASE2000

7.2.2. Edit Menu
The Edit pull-down list is context sensitive and appears differently depending on the active view. 
The contents of this pull-down list are explained later under the section for each applicable view.

7.2.3. View Menu
The View pull-down list provides access to the various Test Set views. Enabled views are 
identified with a check-box. A disabled view is enabled by selecting that view. An enabled view is 
disabled by selecting that view. 

Tasks Enables the Task List, available only in Task Mode. Task Mode is a new feature not 
present in ASE2000 Version 1

Point List The current Point List view is similar to that in ASE2000 Version 1. It displays point 
names, values, and other point information
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Exchange List The current Exchange List is the same as in ASE2000 Version 1. It displays all 
exchanges (messages) supported by the currently selected protocol. The Exchange 
View is not available when operating in Task Mode

Line Monitor The communication Line Monitor view is the same as in ASE2000 Version 1. It 
displays raw data and expanded interpretation of all communication messages

Message List Presents communication line messages in an alternate form to that of the Line 
Monitor view. The Message List’s compact presentation (one message per line) 
allows more messages to be shown at one time than in the Line Monitor view. 

Event Log The Event Log is the same as in ASE2000 Version 1. It presents one line for each 
event detected, as explained in the subsequent discussion of the Events Properties 
Tab

Line Analyzer The Line Analyzer is a special view available only for serial protocols and only 
when operating with an ASE-manufactured communication equipment. It presents 
a millisecond-resolution plot of receive data and carrier (DCD) on each of two input 
lines

Select Protocol Valid in Exchange Mode only, allows selection of any licensed communication 
protocol. (Task Mode protocol is determined from the selected RTU device.)

View Capture Views contents of the currently selected capture file. A capture file contains 
information from a communication session. Available capture files are listed in the 
sub-menu.

Import Used to import previously saved Communication Messages (MSGX) file, DNP3 
Certification Procedure file, or RTU Point List data in CSV format.

Export Used to export Communication Messages to a MSGX file for later retrieval and 
analysis, DNP3 Certification Test results file, or RTU Point List data in CSV format.

1-File Name
2-File Name
3-File Name
4-File Name

The most recently accessed MONX files are shown for convenience (Exchange 
Mode only).

Exit Exits the ASE2000

7.2.4. Tools Menu
The tools pull-down menu contains three or four selections: 

• Properties – allows entry of many editable properties. This contains much of the information 
that, for the ASE2000 Version 1, was found in the Properties pull-down lists. Properties are 
discussed below by group.

• Customize – controls content of the Tool-Bar line. By default, all Tool-Bar content is enabled. 
Items can be removed by un-checking their selection. For more information, see the Tool-Bar 
description in next section.

• User Preferences – allows customization of ASE2000 display colors

• Runtime Changes – appears only in Exchange Mode when communication is active. It supports 
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changing “Forced Error” conditions in real time. For DNP3 protocol in RTU Simulation mode, 
it also supports changing “Internal Indication” settings. Both can be altered from appropriate 
Properties menu entries, accessible when communication is not active. Please refer to 
descriptions in those sections.

Communication Properties

Comm Tab

The Comm Properties tab contains information controlling serial communications.

Some options apply only to ASE devices.

Channel A and B Defines the communication port(s) to use for serial protocols. Two ports are 
typical for monitor mode operations, and one port for RTU or Master Simulation 
mode
• RTU Simulation mode uses the To Master port for communication to the master
• Master Simulation mode uses the To RTU port for communication to the RTU, 

IED, or PLC
• Line Monitoring mode expects to receive messages from the master on the To 

Master port, and messages from the RTU on the To RTU port
Show ASE Ports 
Only 

If checked, only ports on ASE-manufactured communication equipment are 
shown in the Ports pull-down list. If unchecked, all system COM ports are shown

Carrier Controls treatment of the RTS, CTS, and DCD signals
• Constant: In RTU and Master Simulation modes, causes the ASE2000 to assert 

RTS on start-up and keep RTS asserted until the user ends the communication 
session. (RTS is never asserted in Monitor Mode.) CTS is not checked or required 
for transmission. DCD is not checked or required for reception

• Switched: On transmission, RTS is asserted before each message. The message 
is sent after the Pre-Mark time has elapsed following detection of CTS. RTS is 
de-asserted after the Post-Mark time has elapsed following transmission of the 
last data bit. On reception, DCD is required

• Switched by RTU Only: operates in Constant mode for messages sent from 
the master (transmission in Master Simulation mode or reception in any other 
mode) and switched mode for message sent from the RTU (transmission in RTU 
Simulation mode or reception in any other mode)

• Switched RS-485: On transmission, RTS is asserted before each message. The 
message is sent after the Pre-Mark time has elapsed following RTS assertion. 
RTS is de-asserted after the Post-Mark time has elapsed following transmission 
of the last data bit. CTS is not checked or required for transmission. DCD is not 
checked or required for reception

Baud Rate Standard baud rates can be selected from the pull-down list. Other baud rates 
can be entered manually. The BCOM-USB supports rates to 56 KB for byte 
protocols and to 9600 for bit protocols

Half-Duplex 
Filtering 

The ASE2000 assumes operation over a full-duplex line, or (if half-duplex) 
with half duplex equipment that squelches the receiver while the ASE2000 is 
transmitting. For half-duplex circuits with no squelch capability, data transmitted 
by the ASE2000 may be echoed back to the ASE2000 causing the ASE2000 to 
display transmitted messages twice. Setting the Half Duplex Filtering option 
may, in some cases, filter out duplicate occurrence of transmitting messages. This 
option operates by discarding input data received while the transmit CTS signal is 
on
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Ignore Post-Msg 
Noise 

Can eliminate noise caused when external modems shut down. If enabled, the 
ASE2000 discards all input data received after it determines that a complete 
message has been received. Discarding continues until the incoming carrier 
(DCD) drops

Native Asynch 
Mode

For byte protocols such as DNP3, there are two ways to operate an ASE 
manufactured serial card: Bit Mode and Native Asynch Mode. Bit mode provides 
the ASE2000 with control over low level timing properties, but can result in extra 
communication errors at higher baud rate. Native Asynch Mode operation may 
remove these communication errors

Pre-Xmit Mark For switched carrier operation, specifies the time, in milliseconds, between 
detection of CTS and transmission of the first data bit

Post-Xmit Mark For switched carrier operation, specifies the time, in milliseconds, between 
transmission of the last data bit and de-asserting RTS

Preference This option is applicable to insertion of pre-mark and post-mark times in 
transmission of legacy (bit) protocol messages. Because of hardware operation, 
the actual inserted time may exceed the sum of the entered times by as much 
as 7 bits (i.e., the time required to transmit 7 bits). The ASE2000 has the option 
of assigning this excess to the pre-mark time, the post-mark time, or both. The 
Preference option can be used to specify one of these two times to be transmitted 
as accurately as possible. Any excess time will be assigned to the non-specified 
time. (For no specification, half the excess time is assigned to each).

In practice, we have found this option to be useful only for old CDC protocol 
devices, which operates best by selecting Post-Mark

Receiver Squelch Used for reception of data in switched carrier mode. Defines a time, in 
milliseconds, starting on incoming carrier (DCD) detection. Data received during 
this time is discarded

Inter-Message A minimum time between ASE2000 transmissions of consecutive messages. 
Does not apply to messages received by the ASE2000. This setting applies to all 
messages except the Operate message in a select-before-operate sequence

Intra-Message Similar to the Inter-Message delay explained above, applies only to the Operate 
message in a select-before-operate sequence

Response Time the ASE2000 waits for a response from the RTU before declaring a 
response timeout

Character Gap Time in seconds the ASE2000 should add between characters when calculating 
how long to wait for a response from the RTU before declaring a response 
timeout
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Display Properties

Display Tab

The Display Properties tab contains information located under Properties/Display in the ASE2000 
Version 2 Test Set.

Millisecond Time If checked, each message sent or received is time-stamped to the nearest 
millisecond (based on accuracy of the PC clock). If unchecked, messages are 
time-stamped to the nearest second

RTU Response 
Time

If checked, each RTU response message is shown with an elapsed millisecond 
time, calculated from the last bit transmitted of the prior master request to the 
first bit of the corresponding RTU response. This feature requires ASE serial 
communication hardware and is not available with standard COM ports

Enabled 
Exchanges Only 

If checked, only enabled exchanges identifiable by ASE2000 are displayed (see 
next topic, ‘Filtering Exchanges’, for details).

Raw Data Format Controls display format of raw communication words shown in the Line Monitor 
and Messages views

Default Display 
Formats 

Controls presentation format of interpreted data values for each supported point 
type (Digital, MCD, Analog, and Pulse) and for the Point ID

Capture Filter Settings for the Capture Filter (see topic Message Query Manager for more 
information)

Event Trigger Settings for the Event Trigger (see topic Message Query Manager for more 
information)
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Filtering Exchanges
The ASE2000 V2 has two methods to limit the messages displayed in Exchange Mode.

To display only specific exchanges, disable all unwanted exchanges by removing the ‘Display’ 
flag from all exchanges except those to be displayed and checking the Exchange Filtering option 
on the Display tab of the Properties dialog. The ‘Display’ flag may be set or unset by clicking in 
the Flags and adding or removing the check next to the Display option. This flag can also be 
modified from the Exchange Properties menu. For example, removing the “Display” flag from all 
except control exchanges and checking Enabled Exchanges Only will cause the ASE2000 to 
display only control messages.

A convenient benefit of this option is derived from logic the ASE2000 uses to “identify” an 
exchange. Identification requires an input message with data that matches an entry in the 
exchange list. A “Match” requires all pertinent properties of the message be the same, including 
content items such as function code and device ID. If data for an incoming message is as defined 
in an exchange in all aspects except the device ID, then the message is not identifiable (for 
purposes of this discussion). 

A global device ID value can be entered to apply to all exchanges. If set, messages received 
from any other ID cannot be identified. Therefore, setting the global device ID and checking 
Enabled Exchanges Only will cause the ASE2000 to display messages to and from the selected 
device only.

Filtering of exchanges also applies to Print operations.

Protocol Properties

Protocol Tab
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Default Exchange 
Values 

The contents of the list of enterable values in this section changes based on the 
currently selected protocol. (The example above is for DNP3.) The list provides 
the ability to enter default values for key protocol message components such as 
Device Address, Group Number, Point Number, and so on 

Message Times Controls values to use when transmitting messages containing date and time 
information, typically for time synchronization and sequence of events. The 
default is to use system (PC) time, but each component (hour, minute, etc.) can 
be set to a specific value

Force Errors The contents of this section change based on the currently selected protocol 
and define a list of errors the ASE2000 can generate in message compilation 
and transmission. This feature is useful for verification that a given device can 
process an errant message correctly. The last item in the list is always “Randomly 
Select From Those Checked”. If selected, the ASE2000 will occasionally send 
a message with one type of error selected from all those checked. If “Randomly 
Select From Those Checked” is not checked, then an errant message is sent 
every time and will include errors corresponding to all checked items. 

Point Properties
Point Tab

The Point Tab allows customization of input and output point interpretation parameters. For 
the most part, information in this section is set according to the rules of the active protocol and 
changes may cause the ASE2000 to process point data incorrectly. The user should not change 
information in this menu unless absolutely certain that the change is correct. Changes should not 
be made as a “guess” to correct a perceived problem.
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Bits Per … Defines the number of data bits for each point or block of points. For example, if 
analogs are 12 bits each and digitals are reported in blocks of 8 bits each, then 
the corresponding entries should be 12 and 8. These fields in particular should 
not be changed unless absolutely certain that your device is configured different 
than the protocol standard

First … ID For each point type, contains the index of the first point returned in a 
communication message. This field is present because some companies consider 
the first point reported from a device to be index ‘1’, while others consider the 
first point to be index ‘0’. The value entered here is used for assigning point IDs 
when an ID not explicitly contained in the communication message. For example, 
no point ID information is contained in a Conitel message. When the protocol 
message contains point ID information, such as is the case for DNP3, the 
message information is always used

Analog Point 
Information 

Contains several fields controlling analog value conversion and display. The 
ASE2000 provides default settings consistent with the active protocol. This field 
is present and enterable because some protocols support more than one type of 
analog input conversion

Raw Format Controls converting raw data bits to a numeric value

2’s Compliment, Sign Magnitude, BCD, 1’s compliment, and Unsigned convert the 
value as described

Redac Special is used only for Redac 70H and Redac 70DE protocols

Bias 2048 is a linear conversion where a raw value of all 0’s represents the 
smallest negative number, all 1’s represents the largest positive number, and the 
mid-value (‘1’ in the most significant bit and all 0’s elsewhere) represents 0.

Getac LP is used only for Getac 7020-LP protocol

Reverse Bias is used as the inverse of Bias-2048. Conversion is basically the 
same, but the sign of the result is changed

Low and High 
Limits

Are used for RTU simulation and specify the minimum and maximum values 
the ASE2000 will transmit. They also specify the maximum value for Raw units 
display (see next paragraph)

Raw Units and 
Highest Value

When the selected analog display format is “Volts per Ma”, analog values are 
converted between the linear scale of 
0 to High Limit to the linear scale of 0 to Highest Value

For example, consider a raw input value of 1024 and a High Limit of 2048. This 
represents 50% of full scale (1024 is 50% of 2048). 50% is applied to Highest 
Value, which, if 1, results in a displayed value of 50% of 1, or 0.5.

Another way of looking at this is to consider an A/D converter that accepts inputs 
from 0 to 1 volt and that digitizes those inputs to a value between 0 and 2048. An 
input of 0.5 volts will digitize to 1024, which the ASE2000 will display as 0.5. If the 
Raw Units setting is Volts, then the full ASE2000 display is 0.5 volts.

Pulse Point 
Information

Contains fields controlling pulse accumulator (counter) value conversion and 
display.

Raw Format Is similar to that for analogs
Wrap Value is Used only for RTU simulation and specifies one more than the maximum value 

the ASE2000 should transmit.
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Events Properties
Events Tab

The ASE2000 can detect four classes of events and the user can configure action for the 
ASE2000 to perform as an event is each class is detected. The classes are:
• Point Value – A change in state of certain digital points, or an analog value exceeding an alarm 

limit or returning within limits after having previously exceeded a limit. Points to be considered 
in event processing are defined from the Point Values view

• Exchange – Detection of any event-enabled exchange. Event exchanges are specified from 
the Exchanges properties menu

• Comm Errors – Any communication error, including parity, security, and timeout
• Trigger – Any trigger configured 

Each event class can be enabled for Display, Log, or Audible processing, or for any subset 
thereof
• Display processing causes a one-line entry to appear in the Line Monitoring view
• Log processing causes an entry to be written to the text log file
• Audible processing causes the PC audible to be sounded briefly

The Stop Communications on Display Event option, if checked, causes the ASE2000 to stop 
communication after detection of any event with Display processing enabled

Other Tabs
Other protocol-dependent tabs may be present depending on the currently selected protocol. 
Please refer to protocol-dependent sections of this document for more information. 
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7.2.5. Mode Menu

Used to switch between Task Mode and Exchange Mode. 

7.2.6. Help Menu
The Help menu appears as shown below.

Contents, Index, and Search are standard Help system options

ASE Online opens a browser to the Applied Systems Engineering home page. In addition to 
ASE Product information, ASE2000 support information can be accessed by clicking on the 
Support target and then selecting ASE2000 Knowledge Database.

Contact Support composes an Email to ASE Support. Questions should be answered within 
one business day. (ASE is located in the Pacific Time zone)

Check for Updates interrogates the ASE web site for new ASE2000 Version 2 releases. Updates 
are free for one year after the date of purchase. Extended software (and hardware) support 
contracts are available. The current software-update expiration date is located under Help and 
Licensing… 

Licensing lists the license type (trial, temporary, or normal) and expiration date. 
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A Trial license is available for evaluation and does not require any ASE hardware. 

A temporary license provides full functionality for a specified time. This is granted to customers 
upgrading from a version 1 Test Set until the prior version 1 hardware is returned (typically a 
PCMCIA card)

A temporary license is upgraded, via Email, to a full license on return of version 1 hardware. A 
normal license allows full functionality with no expiration date

About provides the ASE2000 build date and version number

7.3. Tool Bar
The Tool Bar is divided into four areas as shown in the following diagram.

Tool Bar for Network Protocols in Master or RTU Simulation Mode

Tool Bar for Network Protocols in Monitor Mode

Some areas may change based on current mode and protocol settings. Examples above appear 
for:
• Master simulation mode for a serial protocol, and
• Master simulation mode for a network protocol, and
• Monitor mode for a network protocol

7.3.1. Player Buttons
Player Buttons are used to start and stop communication.

ICON Name In Exchange Mode In Task Mode
Start/Continues Starts Master Simulation, 

RTU Simulation, or Monitor 
operation, as configured

In Master Simulation mode, 
starts or continues repetitive 
transmission of messages for 
the current task. In Monitor 
or RTU Simulation mode, 
simply Starts or Continues 
communication.

Send 
Continuously

Starts repetitive transmission 
of the selected (highlighted) 
exchange

N/A

Send Once Transmits the selected 
(highlighted) exchange once

Transmits messages 
associated with the current 
task once
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ICON Name In Exchange Mode In Task Mode
Stop Stops communication Stops communication

Resume N/A Resumes communication

7.3.2. Time Line
The Time Line contains a real-time presentation of communication traffic showing data and 
carrier signals in both directions (master requests and device responses)

7.3.3. Capture File Control
A capture file records communication line traffic over a period of time. A capture file contains 
message information obtained while enabled. 

ICON Name Description
Start Starts file capture

Stop Stops file capture (should use an enabled icon)

File Selection Used to specify and enable a specific capture file. The ICON 
contains the name of the currently active (most recently 
selected) file, Capture1 in this example

Information recorded to the active capture file can be viewed by selecting File and View Capture 
or clicking the file selection icon

7.3.4. Communication Port Selection
This section can show one of two sets of ICONs. The first is shown when a serial protocol is 
selected. The second is show for network protocols.

Serial Protocol Ports, Master and RTU Simulation
The serial protocol set allows entry of two COM ports. One COM port, identified as “To RTU”, 
communicates to the RTU (IED or PLC). In Master Simulation mode, it is the only port used. The other 
COM port, identified as “To Master”, communicates to the master. In RTU Simulation mode, it is the only 
port used. Both ports are used in Line Monitoring mode. Messages from the RTU should be received on 
the “To RTU” port and messages from the master on the “To Master” port1.

ICON Name Description
COM ports Pull-down lists allow for COM port selection

Direction Switches the “To RTU” and “To Master” ports

1 When monitoring communication for a protocol with direction information in the message, such as DNP3, the ASE2000 
interprets messages correctly regardless of which port is “to RTU” and which is “To Master”
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Network Protocol Ports, Master and RTU Simulation
The network protocol set allows entry of the target IP address and includes some limited control 
over connection processing. It appears as:

ICON Name Description
Target Node The data entry in the middle of the network protocol ICON 

area allows entry of a target device, either as an IP address 
or a node name. This field should be entered if the ASE2000 
is to initiate a connection, most typically done when acting as 
a master. This field can be left blank when the ASE2000 is 
accepting a connection, or when operating in monitor mode. 
An IPv6 address may be entered if the IPv6 check-box in the 
Properties page has been selected.

Browse Enables a network browser and selection of a network 
node by name. Right-clicking on the Browse icon will allow 
selection of a network interface card when more than one is 
present.

Connect
Disconnect

Normally, a TCP/IP connection is automatically made 
when master mode communication starts and closed when 
communication complete. Selecting this target will establish 
the connection immediately which will remain until explicitly 
closed. This is useful for IEC 60870 5 104 protocol

Network Protocol, Monitoring Mode
ICON Name Description

Filter Nodes In monitor mode, all detected traffic for the selected 
protocol is displayed. In networks with multiple 
connections, it may be desirable to display traffic only 
for a particular device. An IP addresses entered into the 
left of the two entry fields shown identifies the master 
in a remote/master connection. The right field identifies 
the remote. An IPv6 address may be entered if the IPv6 
check-box in the Properties page has been selected. The 
ASE2000 will only process communication for the address 
or addresses entered. Entry also identifies IP address is 
for the master and which for the remote. This information is 
contained in communication messages for some protocols 
such as DNP3, but not for others such as Modbus.

Browse Enables a network browser and selection of a network 
node by name. Right-clicking on the Browse icon will allow 
selection of a network interface card when more than one 
is present.
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7.4. Work Space
The main client area of the screen is called the work space. The work space is the container for 
all the documents that are used to interact with the test set. Each document has a “Tab” which 
identifies the document. 

7.4.1. Drag Repositioning
Tab documents can be repositioned at runtime by dragging the tab header and dropping it on a 
new position of the drag indicator. The drag indicator is the control in the center of the workspace 
(not the indicators at the edge or the work space).

As the tab document is dragged over the indicator the screen will highlight the new position the 
document will assume.

If the tab document is dropped away from the drag indicator, a “floating” document is created. 
This document is not attached to the main screen. This might be useful in a situation where 
multiple monitors are attached.

7.4.2. Context Menu
The work space shows a context menu when the right mouse button is clicked on the tab of a 
document. This menu has several commands that can be used to operate with the work space. 
The two split commands (horizontal & vertical) can be used to slip the workspace effectively 
creating two independent workspaces. 

7.5. Docking
The work space area real-estate can be maximized by utilizing the docking system. The docking 
system allows document to be attached or docked to edges of the screen. 

7.5.1. Drag Repositioning
Documents can be repositioned at runtime by dragging the header and dropping it on a new 
position of the docking drag indicators. Drag indicators are placed on each edge of the workspace. 

As the tab document is dragged over the indicator the screen will highlight the new position the 
document will assume.

Creating a docked document essentially splits the workspace, thus if you drag a document over 
this docked workspace, the workspace drag indicator for this work space will also appear. This 
can be used to add multiple documents to the same docked work space.

A docked document can also be dragged back to a workspace effectively undocking the document.

If the tab document is dropped away from the drag indicator, a “floating” document is created. 
This document is not attached to the main screen. 

7.5.2. Auto Hide
By pressing the pin button located in the docked header the auto hide state can be toggled. 
When the docked workspace is in the auto hide state, the documents are shown as tabs on the 
side of the screen. When you hover the mouse over the tab the document will slide out. Moving 
the mouse away from the document will result in the document sliding back to the tab state.
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7.5.3. Context Menu
By pressing the drop down button on docked header a context menu can be displayed,

7.6. Layout Persistence
Each test set mode (Task & Exchange) has a separate work space layout state. The workspace 
layout is persisted so that the next time the test set is activated or the test set mode is changed 
the work space layout is returned to its previous state. Default layouts exist for each Test Set 
mode and a menu command exists to restore the default layout.

7.7. Layout Guidelines
Each Test Set document has a preferred orientation. Some documents are vertically oriented 
and work best either docked or positioned to the right or left edge of the workspace. The rest 
of the documents have a horizontal orientation and work best as a tabbed document within a 
workspace. 

7.8. Status Line
The status line at the bottom of the display area appears as follows.

7.8.1. Communication Mode
The three ICONs at the left edge are used to select Communication Mode. The ICON corresponding 
to the current mode is shown is a different color. The current mode is also identified on the title 
line.

ICON Description
Selects Master Simulation Mode

Selects Line Monitoring Mode

Selects RTU Simulation Mode

7.8.2. Communication Statistics
The right portion of the status bar shows communication statistics, representing totals for all 
communication since the ASE2000 was started. 

Each statistic type (except for No Rsp) contains two counters. The first (left) counter contains 
statistic information for Messages Sent by The Master. The second (right) counter contains 
statistic information for Messages Sent by The RTU.

Messages Sent by the Master means:
• In Master Simulation mode, messages sent by the ASE2000
• In RTU Simulation mode, messages received from the master
• In Line Monitor mode, messages detected on the channel designated as “To Master”
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Messages sent by the RTU means:
• In Master Simulation mode, messages received from the RTU
• In RTU Simulation mode, messages sent by the ASE2000
• In Line Monitor mode, messages detected on the channel designated as “To RTU”

Individual counters and their meanings are:
Total The left cell is total Messages Sent by the Master”. The right cell is total “Messages 

Sent by the RTU”
OK Of the total messages transmitted in either direction, the number processed with no 

communication error
No Resp Of the total “Messages Sent by the Master”, those to which the RTU should have 

responded but did not
Line Error Of the total messages transmitted in either direction, the number detected with word 

parity or framing errors
Sec Error Of the total messages transmitted in either direction, the number detected with 

protocol security errors such as CRC, BCH, or Checksum

Totals can be reset by right-clicking in the Status Bar and selecting Reset Statistics
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8. View Menu Details
The Views menu allows selection of which displays (views) will be visible.

Many of the displays contain information which can be modified using check boxes, radio buttons, 
and text data entry. Check boxes and radio buttons are self-explanatory but the methods for 
text data entry require some explanation. Most displays that support text data entry utilize what 
is referred to a “grid” format where the information is organized in a set of rows and columns. 
Individual data items are located in “cells” and it is the contents of the cell that is modified. In 
general, there are two basic edit modes that can be implemented, “Edit on Entry” and “Edit on 
Keystroke”. The ASE2000 utilizes the “Edit on Keystroke” mode. In this mode focus is given 
on entry but edit mode does not begin until a key stroke or mouse click. A row header can be 
selected and a delete key will delete the row. A cell cannot be left without validation occurring.
 
The behaviour of Edit on Keystroke for each cell type is described.

• Checkbox – A single mouse click on the checkbox will select the row, activate the cell and 
change the checkbox.

• Textbox – A single mouse click will select the row and activate the cell. A keystroke or another 
mouse click will begin edit mode. Note that a cell value can be effectively changed with two 
actions, a mouse click and a keystroke. This is the same number of actions as “edit on entry”.

• ComboBox – A single mouse click will select the row and activate the cell.
 – Another mouse click displays the drop down arrow, and clicking the arrow shows the drop 
down box.

 – A keystroke begins the autocomplete feature of the Combobox and displays the drop down 
arrow. This is the most efficient way to deal with a ComboBox.

• CheckBoxDropDown – A single mouse click will select the row and activate the cell.
 – Another mouse click displays the drop down arrow, and clicking the arrow shows the drop 
down box. 

 – Arrow keys and space bar may be used to select/deselect an option

8.1. Tasks
The Tasks List view, applicable only in Task Mode, allows the user to select and perform Tasks. 
Please refer to the section on Task Mode operation.

8.2. Point List View

8.2.1. Point List Overview
The Points List view displays information about all input points detected on the communication 
line. The display is organized by device. When data for more than one device address has been 
detected, TABs appear on the bottom of the Points List view to select the correct RTU.

The tabular presentation contains one point per line. If the point has been detected recently on 
the communication line, its value appears in bold font. If the value has changed recently, it is 
shown with a solid background. If the value has not been detected recently, it is shown in normal 
font.

8
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Points List columns are: 
RTU Remote device ID
Point Point type and ID
Name Optional point name, user enterable
Description Optional point description, user enterable 
Raw Value reported in the communication protocol. Analog and counter values are 

converted to decimal. Digital points are shown as one or two-bit values as defined by 
the protocol

Value Raw value converted according to user entered rules. For analogs, the user can 
specify a scale and offset for linear conversion. For digitals, the use can supply state 
names such as OPEN for a raw value of 0 and CLOSE for a raw value of 1

Quality As reported by the protocol
Time A time stamp, if reported in the communication message for the associated point. If not 

reported, the field is blanked
Limits User defined low/high limits for analogs. If entered, information is shown in red when 

the point’s value is outside the limits.
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8.2.2. Edit Menu for Points List View
When the Points List View is in focus, the Edit Menu appears as follows.

Modify presents a menu for editing parameters for any of the currently defined points

Delete deletes the currently highlighted point

Delete All deletes all points

Save All saves all point information as currently shown. User entered information is automatically 
saved, but point values and quality are not. This option is useful to create a snapshot of the 
current point settings and values

Configure	RTUs is used to define new RTUs and for adding points to existing RTUs

Configure	Tables is used to edit certain global parameter settings such as analog high/low 
alarm limits, analog conversion coefficients, pulse accumulator conversion coefficients, and 
digital point state names

Convert Previous Point List is used to import an ASE2000 version 1 point list. This action will 
erase any existing RTU or point definitions

8.2.3. RTU Simulation and Task Mode
The Point List View has additional capabilities when running as the RTU Simulation Task Mode.

• The user may enter values in the Raw data column, which will be transmitted in the next 
applicable message

• An extra column called Increment appears and is applicable for generation of analog point 
values. A point’s Raw value is automatically calculated in each applicable response by adding 
the Increment value to the previously transmitted Raw value.

Values in the Raw or Increment columns may be copied forward by selecting multiple rows and 
right-clicking to display a pop-up menu. Choose ‘Copy Raw Value’ or ‘Copy Increment’. The 
value from the first row selected is copied to all selected rows. To select multiple rows, click once 
in the first row to select it and hold down the Shift key while clicking in the last row. All selected 
rows will be highlighted.
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8.3. Exchange List View
The Exchange List appears when operating in Exchange Mode. It contains a set of rows, one 
for each exchange (message) applicable to the selected protocol. 

It also contains a set of columns for standard message components applicable to the protocol. For 
example, DNP3 protocol defines Destination and Source address fields used in each message. 
When DNP3 is the active protocol, the Exchange List view contains Dest and Source columns.

Another protocol, such as Conitel, includes components called RTU ID, Group, and Point. Those 
column headings appear when Conitel is the active protocol.

The Exchange List View shown below appears for DNP3 protocol.

Each line contains one exchange (message) that exists for the selected protocol, DNP3 in this 
case. From this list, the user can:
• Edit an exchange, directly in the grid or utilizing a dialog
• Select a single exchange for transmission
• Create and delete exchanges
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8.3.1. Exchange View Menu
To edit an exchange, select the exchange and then the Edit pull-down menu or, alternatively, 
right-click anywhere in the row. This will display an edit menu.

• Cut, Copy, Paste, Insert Row, Remove Row, and Clear All operate on the entire row 
according to conventional meanings

• Since there is no concept of a “blank” exchange, Insert Row will present a list of exchanges 
defined for the active protocol, requiring the user to select one to complete the Insert Row 
operation

• Reset To Defaults erases all existing exchanges, replacing them with the default set for the 
active protocol

• Edit Exchange Properties requests a menu for editing exchange information such as device 
and point addresses and transmission frequency. More details are provided below

• Edit	Exchange	Definition requests a menu for editing detailed structural exchange information. 
It is useful primarily for adjusting scan messages for most legacy protocols. Editing the 
exchange definition is not supported for IEC 60870-5-10x and DNP3; for these protocols, use 
Edit Exchange Properties.

Edit Exchange Properties 
The Exchange Properties Menu supports editing several key properties about each exchange. 
However, since these properties can differ significantly from protocol to protocol, most details 
have been located in the protocol-specific sections. 

The properties common to all protocols and shown in the example below are used for Master 
Simulation mode. 
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Please note the Transmit flag and Frequency field when reading the following section on 
Starting Communication.

Edit	Exchange	Definition	
The Exchange Definition Menu is relevant to most legacy protocols. Editing the exchange definition 
is not supported for DNP3 or for any of the IEC protocols; instead use Edit Exchange Properties. 
This menu provides visibility into ASE2000’s internal exchange definition data structure. It can 
be used to modify the structure of any exchange, including:
• Altering point types and values, 
• Changing function codes, and 
• Moving key fields

The most common use of this menu would be to alter point information. Any other modification 
may have significant impact on ASE2000 operation. Use in one of these alternate manners is 
very rare and should not be undertaken unless absolutely sure about the impact.

This section provides an overview of the Edit Exchange capabilities and specific examples on its 
use to modify input point information.

The menu presents the internal structure of the selected exchange in an expandable tree view. 

Clicking the [+] at the left of the Exchange Definition (Item Sequences) expands definition. The 
example below shows the expansion for the Conitel protocol Scan Exchange.
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An exchange is broken into a request message, identified as To RTU, and a response message, 
identified as From Master. (Some exchanges such as a broadcast pulse accumulator freeze 
may only have a request portion with no response.)

Each message is defined as a set of communication words. The ASE2000 builds a communication 
message as a sequence of these words, with the definition of a word dependent on the protocol. 

• For any protocol using 26/31 BCH communication, each word is 12 bits
• For Indactic 33/41 protocol, each word is 16-bits
• For any other protocol, each word is 8 bits

To edit the exchange definition, highlight any of the elements in the exchange and select one of 
the buttons at the right.

• Add Msg will add a new message, either To RTU or To Master. Use of this option is not 
recommended

• Add Element will add a new line within the current message immediately after the selected 
element. Please refer to the following discussion on Point	Definition	Editing

• Delete will delete the current element
• Replace is the same as selecting Delete followed by selecting Add Element

Selecting either Add Element or Replace results in the following menu.

This menu presents a list of supported element types. The most commonly used elements are:
• Analog – Defines one or more analog input points
• Digital – Defines one or more digital input point blocks. The number of bits in each block is 

protocol dependent
• Pulse – Defines one or more pulse accumulator (counter) input points
• Analog Exception – Defines one or more analog information blocks, each containing a point 

number and value
• Digital Exception – Defines one or more digital information blocks, each containing a point 

number and point state
• Pulse Exception – Defines one or more pulse accumulator blocks, each containing a point 

number and value 
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Use of any other element type is rare and not discussed here. If interested, please contact ASE 
for details.

Point	Definition	Editing
The main use of the Edit Definition menu is to modify the definition of a scan response. Let’s 
take the case above for Conitel protocol. That protocol defines a single scan message called 
Scan. The response to a scan message is a set of points of one or more types. For example, a 
response may include a set of analog points, a set of digital points, or both analogs and digitals. 
Similarly, pulse accumulator data may be included. 

The ASE2000 cannot know, in advance, the data content of a scan response. This is a RTU 
hardware dependency. The default scan exchange contains is shown above. The final element 
is Points: Unknown Quantity of Points. This is exactly what the ASE2000 knows about the 
exchange; only that some number of points will be returned: neither the number nor the type is 
known.

Let’s assume that a particular scan response contains 2 blocks of digital input points followed by 
7 analog points. To define such a message:
• Highlight the Points element
• Select Replace
• Select Digital

Restore the original Edit Exchange Definition menu. This will now appear as:

The Point entry was replaced by a Digital entry. 
• Set the Repeat Count to 2, for 2 blocks 
• Select Add Element
• Select Analog 
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Restore the original Edit Exchange Definition menu. This will now appear as:

A new Analog element has been created
• Set the Repeat Count to 7, for 7 analog points, or, alternatively, to 0. A count of 0 always 

means that the rest of the message is a sequence of values of the current type. So, 7 means 
7 analogs, and 0 means the rest of the message are analogs

• Select OK to end the editing process

The edited definition will cause the input message to be parsed accordingly.

This type of editing is useful for protocols where:
• The type of point returned in a scan request is known by the user, but is neither known in 

advance by the ASE2000 nor can be deduced from the input message
• The number of points in the data response is known by the user, but is neither known in 

advance by the ASE2000 nor can be deduced from the input message

In all other cases, the ASE2000 should be able to analyze the input message and display input 
data point appropriately without editing the Exchange Definition

► Note that exchanges are not used in Task Mode so exchange editing is not required. 
The ASE2000 automatically makes similar adjustment based on user entered Point 
Information 

 
Other Uses 
There is one more important aspect of the Exchange Definition menu applicable to RTU 
Simulation. As a RTU, the ASE2000 can respond with a value for each input point and can 
modify this value in each scan response. 

Refer to the data entry menus for analog and digital input points.
• The Value field defines the value to be included in the next scan response. For analog and 

pulse accumulator points, this is a raw numeric value. For digital input points, value defines 
a block of points. The rightmost bit is the state of the first point. Other point states occupy 
successive bits to the left

• For analog points, the Increment field specifies a number to add to the Value field after each 
response. The new Value will be used in the next response. Once a maximum analog value 
has been reached (depending on the protocol) the sign of the Increment field will change, 
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resulting in a Decrement, until a minimum value is reached. Therefore, the value will ramp up 
and down between high and low limits.

• For pulse accumulator points, the Increment field is similar to analogs, except that the value 
will wrap after exceeding the logical maximum for the protocol. Except when exceeding the 
wrap-around value, the value never decrements

• Digital points contain a Toggle Mask field instead of an Increment. After every response, the 
value is Exclusive-ORed with the mask to produce a value for the next transmission.

8.4. Line Monitor View
The line monitor view shows communication messages in raw and interpreted format. Raw data 
is shown in the left pane and interpreted data in the right pane. Clicking on data in either pane 
highlight the data selected and also the corresponding data in the alternate pane. In the sample 
below, the user clicked on the DNP3 Destination address field in the interpreted pane to show 
the corresponding data bytes in the raw data pane.

► Messages can be saved by selecting File>>Export>>Communication Messages. A 
.MSGX file records the current communication messages. This file can be sent to 
another ASE2000 user to review the communication session.

8.4.1. Edit Menu for Line Monitor View
When the Line Monitor View is in focus, the Edit Menu appears as follows

Clear All Messages erases the Line Monitor view contents

Reset Statistics zeroes communication statistics counters on the Status line

Properties presents a menu for modifying Line Monitor View text color and font

8.4.2. Raw Text Export
Beginning with version 2.20, the user can right click the line monitor panes and select “Export 
Raw Text Data” to save the raw data to a text (.txt) file. This can also be re-imported if the format 
is unchanged.

8.5. Messages View
The Messages View is an alternate presentation format containing the same information as in 
the Line Monitoring view. One message is shown per line making the Messages View a more 
compact presentation than the Line Monitor, but with (initially) less interpreted information about 
each. 
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The messages view contains a main viewing pane on top and a smaller viewing pane on bottom. 
The upper viewing pane shows a list of messages by name. The lower viewing pane shows the 
interpreted data for the one message selected in the upper pane.

The sample below is from a DNP3 protocol communication session.

This screen shows a series of messages with one of the Analog responses highlighted. The raw 
data for this response is shown in the lower pane.
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If more details are required for a particular message, they can be obtained by clicking on the [+] 
at the left edge of the message. In the case above, repetitive clicking of [+] targets will result in:

As you can see, the tree expansion can be continued several levels to significantly detail the 
message. There was insufficient room in a single page to show everything, but the capabilities 
should be obvious.
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8.5.1. Edit Menu for Messages View
When the Messages View is in focus, the Edit Menu appears as follows

Clear All Messages erases the Messages view contents
Collapse All collapses all expanded messages
Expand All expands all messages 
Reset Statistics zeroes communication statistics counters on the Status line
Properties presents a menu for modifying Messages View text color and font

8.6. Event Log
The Event Log presents one line for each event detected. More information on event processing 
can be found in the discussion of the Properties pull-down menu and the Events tab.

8.6.1. Edit Menu for Event Log View
When the Event Log View is in focus, the Edit Menu appears as follows

Clear All Events erases the Event Log view contents
Reset Statistics zeroes communication statistics counters on the Status line

8.7. Line Analyzer
This view is available only for serial protocols and only when operating with an ASE manufactured 
I/O card. It presents a millisecond-resolution plot of receive data and carrier (DCD) on each of 
two input lines. To create Line Analyzer data:

• Select the Line Analyzer view
• Connect the serial cables to receive data on all required circuits (To RTU, To Master, or both)

•  Select the start ICON 
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Data and carrier signals on each incoming line will be monitored. When sufficient data is collected, 
the Line Analyzer view is updated.

The above plot shows data and carrier detected on line A. Plots would also be updated if a 
message was detected at about the same time on line B. it was not in this example. A time 
reference is shown at the bottom of the view. Several controls are available. 

The most useful is zoom:
• Left click on the left edge of an area to zoom
• Keeping the left mouse button pressed and move to the right edge
• Release the mouse button

Proceeding as above on the prior display produces:

Note the expanded data presentation. Also, note that moving the cursor over any point of the plot 
shows the time of occurrence of that point. In the example above, the cursor was moved to the 
start of a bit occurring at 28.8 milliseconds after the start of data collection.
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8.7.1. Edit Menu for Line Analyzer View
When the line Analyzer View is in focus, the Edit Menu appears as follows

Clear erases Line Monitor view data
Properties presents a menu for modifying Line Analyzer View text color and font
Reset Statistics zeroes communication statistics counters on the Status line
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9. Exchange Mode
Exchange Mode, if not the current mode, can be entered by selecting Exchange Mode from the 
Mode pull-down menu.

Exchange Mode uses the views and displays presented in the prior sections, primarily the 
Exchange View. Please refer to discussions on the Exchange View for more information. 

For those familiar with ASE2000 Version 1 operation, Exchange Mode is, effectively, Version 1 
operation. 

9.1. Starting Communication
Exchange mode works in one of three Communication Modes: Master Simulation, RTU 
Simulation, and Monitor. 

9.1.1. RTU Simulation and Monitor Mode

 For RTU Simulation and Line Monitor operation, communication is started by selecting this 
target from the tool-bar line.

9.1.2. Master Simulation
In Master Simulation mode, four targets are displayed.

 causes the currently selected exchange to be transmitted once. The ASE2000 will wait for a 
response and then stop. This option does not appear if no exchange is selected. 

 causes the currently selected exchange to be transmitted once immediately and then again 
at every time interval thereafter, as defined by the Frequency field in the Exchange Properties 
menu. A new request may be delayed while the ASE2000 waits for a response to a previous 
request. This option does not appear if no exchange is selected.

 causes all messages with the Transmit flag set to be transmitted at their specified frequencies. 
A message is first sent at a time as defined by its Frequency. For example, if the Transmit flag 
is set on two messages, one with a frequency of 2.0 seconds and the other with 5.0 seconds, 
then the first message will be sent 2.0 seconds after this target is selected.

 stops any active transmission

9
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10. Task Mode

10.1. Task Mode Operation

► This section provides Task Mode operations overview. Since tasks are protocol 
specific, please refer to the appropriate protocol appendix for further details.

Task Mode operation is started by selecting Task Mode from the Mode pull-down menu. 

Task Mode is an alternate method for building and analyzing communication messages. It works 
from information contained in a device (RTU, IED, PLC) database. Each device is identified by 
name and includes the device’s protocol, address, and point list. The point list defines all input 
points by type (analog, digital, counter) and address.

Task Mode operation is always based on one device selected from the device data base. 

For operation in Master Simulation Mode, only one device may be active at a given time. The 
ASE2000 issues requests to that device. 

For Monitor Mode operation, one device can be active.

For RTU Simulation Mode, one device can be active.

The ASE2000 automatically builds messages from the device database based on the task, mode, 
and active device. The Exchange List is not used in the Task Mode and the user is not required 
to edit any exchange definition information. 

The steps for Task Mode configuration and operation are:

• Create one or more devices in the device database. (Information entered is saved and available 
whenever the ASE2000 is restarted)

• Select the communication mode (Master, RTU, or Monitor)
• Select one device from the device data Select a Task Group
• Select a Task from within the selected Group
• Start communication

10
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10.2. Device	Definition
After installing the ASE2000 for the first time, the device database is empty and the Task Mode 
view appears as follows.

To define a device, right-click anywhere on the device title line (the area showing Name, Protocol 
Name, Id). The device database definition form appears.
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To define a new device:
• Enter an alphanumeric name in the Name field
• Click in the Protocol area to display a pull-down list and select a protocol

• Enter the device ID (address)
• Optionally, setting the device’s active status will activate the device for Task Mode operation

For example, an active DNP3 protocol device entry appears as:

To continue with the point tables, select Next >>.

10.2.1. Point	Definition
Selecting Next from the device definition phase generates an input point definition menu. All input 
points are defined, by point type, in blocks of contiguous point addresses. Each entry contains:
• Point type. Point type names appropriate for the device’s protocol are presented in a pull-

down list. In the example below, the pull-down list contains the set of DNP3 input point types
• Point ID defines the first point in a contiguous set of points
• Point Count defines the number of points with contiguous IDs starting at the entered Point ID
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For example, assume a DNP3 device with:
• 16 analog inputs starting at address 0, 
• 32 binary inputs starting at 0, and 
• 8 frozen counters, also starting at 0

After all information is entered, the menu will appear as shown below.

Complete the definition process by selecting the Finish button.

The Task Menu now shows the newly defined device. Since the device was selected as the 
active device, the Task List now shows tasks from the first task group for the active device’s 
protocol (DNP3).

Make sure the correct communication mode, Master Simulation, RTU Simulation, or Line Monitor, 
is selected. Following sections describe continuing procedures for each mode.

10.3. Task Mode Operation, Master Simulation Mode

10.3.1. Task Selection and Navigation
Tasks are presented in groupings applicable to each protocol. For example, DNP3 protocol has 
task groupings for:
• Initialization
• Acquisition of Static Data
• Acquisition of Event Data
• Counter operations
• Time related operations
• Control outputs
• File operations
• Secure Authentication
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Other protocols may have some of the same or similar groups, some groups may be missing 
entirely, or other groups, not used for DNP3, may exist. 

The sample Task Menu is shown below. The actual presentation is for DNP3 protocol, but other 
protocols show similar information.

The Task menu layout contains information in four sections.
• The Device List with the active device highlighted is shown at the top of the view
• Task Groups are presented in a horizontal ICON row near the middle of the view. The active 

group is shown in a highlighted background color
• Tasks within the selected group are presented between the device and task group ICON lists. 

The active task is shown in a highlighted background color
• Properties applicable to the active task and their values are shown at the bottom of the view. 

These values can be changed if necessary

Because of its compact presentation, task groups are initially identified only by ICON. A Mouse 
over will show the group name, for Example

A less compact presentation is available from the 
Splitter control immediately above the ICON region. Select this splitter and, keeping the mouse 
button pressed, slide the mouse upwards. Names of all task groups appear.
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10.3.2. Task Activation, General
To activate a task, select a task group and, within that group, the desired task. In the example 
above, the Link Status & Reset Link task is selected from the Initialization group. 

To activate this task:
• Select  to send messages required to accomplish this task once
• Or the Start icon  to send task messages repetitively. The repetition rate is set in the tasks’ 

Frequency property, enterable at the bottom of the Task View

Task communication messages are shown in the Line Monitoring and Messages views discussed 
previously.

10.3.3. Task Setup and Activation, Digital Control Tasks
Single Point Control
Control tasks require the user to enter key information before the task is initiated. Information 
is entered into properties for the selected task. While properties differ slightly depending on the 
protocol, the following is typical.
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Control properties are more involved than those for most other exchanges. In this example for 
DNP3 (and the same for many other protocols) the user must enter:
• Point index: The default, ‘*’, indicates that no index has been entered. The ASE2000 will 

reject an attempt to start a control action until a valid address is entered
• Value: Choices in this example are trip and close. Names adjust as appropriate to the active 

protocol and control type. 
• On Time is part of a DNP3 control: It is also part of many other protocols, but not all. The field 

does not appear if not applicable to the active protocol. The default is 1 millisecond.

Once correct values are entered for the above properties, the control task can be activated.

This will control a single point. If the Start icon is selected, the same point will be controlled 
multiple times. 
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Multiple Point Control
To repetitively control a sequence of points, select the [+] target at the left of the Point Index and 
Value properties. The result is:

Note that Point Index has subfields called Start and Stop. Value has subfields called Start 
Value and Stop Value. These specify control ranges. For example:

Configures the ASE2000 to issue both trip and close commands to points 5 through 10. If the 
Start icon  is selected, one command is sent every period of time as specified by the Frequency 
property. Execution will continue until stopped .

The sequence of commands is:
1. A command is issued to the Point Index (5) and the Value state (Trip).
2. In preparation for the next command, if the Value is not the same as the Stop Value, then it 

is set to the Stop Value
3. If the Value is the same as the Stop Value, then it is set to the Start Value and the Point 

Index is incremented.
4. If the Point Index is greater than the Stop Point, then it is set to the Start Point
5. Control continues with step 1

10.3.4. Task Setup and Activation, Analog Control Tasks
As for digital controls, analog control tasks require the user to enter key information before the 
task is initiated. 
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Single Point Control

Before activating an analog control, the user must enter:
• Control point index: The default, ‘*’, indicates that no index has been entered. The ASE2000 

will reject an attempt to activate a control action until a valid index is entered
• Value: Analog output value. Unless modified, the default value, 0, is used

Once correct values are entered for the above properties, the control task can be activated. The 
setup discussed above will result in control of a single point with a single value. If the Start icon 

 is selected, the same control (index and value) will be sent repetitively. 

Multiple Point Control
Properties to control multiple points with multiple values are accessible by selecting the [+] 
targets at the left of the Point Index and Value fields.

The Point Index field has Start Point and Stop Point subfields, the same as described for 
Digital Controls. The Value field has Start, Stop, and Step Percentage subfields. The subfields 
define ranges for analog control commands.

For example, the settings shown above configure the ASE2000 to issue commands to:
• Analog output indices 1 through 5, with
• Values ranging from 0 to 100 in 25% increments
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If values are entered into any of the subfields described above prior to activation of the analog 
output control task, and if activation was initiated with the repetitive transmission ICON, then the 
task will control multiple indices with multiple values consistent with field and subfield settings. 
Each transmission will control one index with one value as described in the following steps.

1. The first command will be issued to the Point Index (1) and Value (0)
1. In preparation for the next command, if the Value is equal to or exceeds the Stop Value, it 

will be set to the Start Value and the Point Index will be incremented. If the Point Index is 
then greater than the Stop Point, it will be set to the Start Point

1. Otherwise (Value less than Stop Value), the Value will be increased by the Step percentage 
applied to the difference between the Start Value and the Stop Value. (If the new Value is 
greater than the Stop Value, it will be set to the Stop Value.

2. The next command will be issued at the task’s frequency with the modified properties

10.3.5. Task Setup and Activation, File Transfer Tasks
For applicable protocols, the ASE2000 can initiate and accept file transfer requests between a 
master and remote device. 

A sample Task Menu for the File Operations group of tasks is shown below.

To initial a transfer, the user must enter a file name for the local machine and a file name for the 
remote device.

The local file is entered in the Local File Name property and can be a complete disk and path 
specification. The local machine can be browsed by clicking in the Local File Name field and 
selecting the browse target at the right of that field.
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The remote file is entered in the Remote File Name property. If a file name is not known, 
the ASE2000 can browse the remote device using appropriate protocol commands (assuming 
directory operations are supported by the protocol and device). A remote browse operation is 
initiated the same way as a local browse operation: click the Remote File Name field and select 
the browse target at the right of that field. This initiates appropriate communication which, if 
successful, results in a menu like that shown below.

This shows all files reported by the remote device. Select a file and OK. The selected file name 
is placed in the Remote File Name field.

Note that the browse operation only fills in the Remote File Name field. It does not initiate the 
selected task: Read File, Write File, Delete File, File Information, or other as supported by the 
selected protocol. 

Once the files names applicable to the selected task have been entered, start the file operation 
as you would start any other task. Messages are interchanged with the remote device until 
the operation completes (successfully or with errors). The Line Monitor and Messages Views 
provide additional information. As an example, following is an expanded Messages View for a 
successfully completed DNP3 File Information task.
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10.4. Task Mode Operation, Monitor Mode
Monitor mode provides a single task called Scan Responses, selection of which starts the line 
monitoring process. Exactly one device from the device data base must be active. When operating 
on a party line where messages from multiple devices could be detected, it is recommended to 
use Exchange Mode.

Communication messages are received and interpreted according to protocol rules and the point 
information for the active device. 

If the number of points reported by a device does not match the number of points defined in the 
point data base, and:

• Protocol rules are such that the ASE2000 can correctly parse the message and identify the 
point types, indices, and values, then the message is valid and the point data base is updated 
with the points reported. If more points are reported than defined, additional points are created. 
Points will be added to the Point Values view, but the device data base will not be modified.

• Protocol rules are such that when the ASE2000 cannot correctly parse the message, then 
results are unpredictable. Most likely, the ASE2000 will report a communication error and no 
point data base updates will be made.
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10.5. Task Mode Operation, RTU Simulation Mode
RTU Simulation mode provides a single task called Scan Responses, selection of which starts 
the RTU Simulation process. Exactly one device from the device data base must be active. The 
ASE2000 cannot, in Task Mode, simulate responses to request for more than one device, this is 
not supported as there is only one state.

When a request for input data is received, the ASE2000 generates its response from the point 
configuration of the device data base. The example below shows values for seven analogs, 
twelve digitals, and one pulse accumulator point.

In the initial case, the values and states for all points are 0. Different values can be entered in 
this view according to the following rules.

• An analog or pulse value, or a digital state, can be entered in the “raw” column. Any such value 
will be used in response to the next applicable scan

• For protocols that support change event processing, entering a new value will generate a 
change event

• For analog points, a value entered in the increment field causes the point value to be 
automatically adjusted after each scan response. The adjusted value is used in the subsequent 
response. In this manner, analog values will ramp up and down between high and low limits 
applicable to the protocol

• For pulse points, a value entered in the increment field causes the point value to be automatically 
incremented after each scan response. The new value is used in the subsequent response. 
Pulse values wrap around at a maximum applicable to the protocol

• For digital points, an increment value of 1 causes the point state to alternate between 0 and 1 
at each scan response

Values in the Raw or Increment columns may be copied forward by selecting multiple rows and 
right-clicking to display a pop-up menu. Choose ‘Copy Raw Value’ or ‘Copy Increment’. The 
value from the first row selected is copied to all selected rows. To select multiple rows, click once 
in the first row to select it and hold down the Shift key while clicking in the last row. All selected 
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rows will be highlighted. The copy operation works within a single point type. If the selected rows 
contain both Analog and Digital points, the copy operation will stop when it reaches a new point 
type.

The table below shows examples of increment values entered for each point type.
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11. Remote Monitoring
ASE2000 version 2 release 2.16 and later adds the ability to monitor communication in a remote 
SPT or ASE Terminal server. 
• The SPT product line includes the SPT-PC, SPT4-NET, and SPT-ARM. Remote monitoring is 

supported in SPT software release x.6.y or later (i.e., the middle digit must be at least 6)
• The Terminal Server product line must be based on an ARM processor. Older Pentium based 

processor solutions do not support remote monitoring

Remote monitoring allows the ASE2000 to make a network connection with any remote SPT 
or Terminal Server package with compatible software support and to display data just as if the 
ASE2000 were located at the remote site. Only non-intrusive monitoring operation is supported. 
No message transmission can be initiated in this mode.

Non-intrusive terminal server hardware can be purchased for installation at remote locations 
to provide remote monitoring connectivity. These units can be configured as listening only to 
alleviate security concerns.

11.1. Activation
Remote monitoring requires activation at both the remote (SPT) site and at the local ASE2000.

11.1.1. SPT	Remote	Monitoring	Configuration
SPT activation is accomplished through the SPT Editor, provided as part of the SPT package. 
From the editor, select the Remote Monitor option from the SPT pull-down.

To provide a selection list of all possible communication channels/ports into the SPT.

In this example, the SPT is configured to report data to the master over DNP3 LAN/WAN IP 
port 20000. After selecting the “Monitor” option, this communication traffic will be reported to a 
remote ASE2000 over port 3000. This is the default and can be changed.

11
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11.1.2. ASE2000	Remote	Monitoring	Configuration
Once the SPT is configured to accept an ASE2000 connection, complete remote monitoring from 
the ASE2000 as follows:
• Select the correct protocol, either in Task or Exchange modes
• Enter Remote Monitoring mode from the bottom left portion of the screen

• To activate

Data will be reported from the SPT/Terminal Server and shown in the ASE2000 he same as a 
local monitoring session.
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12. Project Saving
Beginning with version 2.21, users can now save task properties into a project file (.A2K). Some 
properties are not saved, as altering would affect the overall application behavior, hence user 
will need to make such task property changes explicitly after opening the project or starting the 
application.

To save a project, simply click “File” in the menu bar, then “Save As” and give the appropriate 
name and file location. 

When a user saves a project, it will capture the following information from saved projects.
• Master / RTU Simulation mode
• Exchange/Task mode
• Task mode properties

Note: only static property settings that do not affect application behavior will be saved.

User can open the project by double clicking on the .a2k in Windows or by going to “File” in the 
menu bar and clicking “Open.

12
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13. ASE2000 Cabling 
This section describes various cabling configurations used to connect the ASE2000 for the 
different operational modes (Master Simulation, RTU/IED Simulation, Monitor Mode), the different 
hardware models (BCOM-USB, COM) and different connection types (Modem, RS-232). Cabling 
for network based communication is discussed in a separate section titled ASE2000 Network 
Protocol Use.
• Master simulation: In this mode, ASE2000 simulates the primary station (Master), allowing 

you to construct and transmit requests to one or more secondary stations (RTU/IED). 
• RTU simulation: In this mode, ASE2000 simulates one or more secondary stations (RTU/

IED), allowing you to construct responses or unsolicited messages and transmit them to the 
primary station. 

• Monitor: In this mode, ASE2000 monitors the communication line connecting the primary 
station and one or more secondary stations and displays the messages exchanged between 
them. 

For the three modes of operation, connections can be made at the RS-232 level, at the Telco 
level using ASE supplied or other modems, or at the network level for network based protocols. 

13.1. RS-232 Connections
The following figures illustrate different cabling configurations for connecting the ASE2000 Test 
Set equipment at the RS-232 level. The ASE Dual-Channel RS-232 PCMCIA I/O card is used in 
the illustrations but the same principles apply to any RS-232 I/O device. 

13.2. Master Simulation Mode – RS-232

RTU

Null Modem Adapter

ASE2000 Test Set
 

BCOM-USB

RS-232 Cable

USB Cable

13
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13.2.1. RTU/IED Simulation Mode – RS-232

 
ASE2000 Test Set

BCOM-USB

RS-232 Cable

USB Cable

Master 
Station

RS-232  Cable

Null Modem 
Adapter

13.2.2. Monitor Mode – RS-232

Master 
Station

RS-233
Modem Cable

Master Station 
Modem

RTU

RTU
Modem

RS-232 
Monitor Cable

Communication
Line

ASE2000 Test Set
 

BCOM-USB

RS-232 Cable

USB Cable
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13.3. Modem Connections
The following figures illustrate different cabling configurations for connecting the ASE2000 Test 
Set equipment to the phone line circuits through a modem. The ASE Dual-Channel modem 
is used in the illustrations but the same principles apply to any modem. The ASE modem is a 
dual-channel modem with two DB-25 female connectors and a power connector on one side of 
the modem box, and two RJ-11 receptacles on the opposite side of the box. When using the 
modem for Monitor Mode, ASE recommends setting the monitor mode switch to the ON position 
to correctly balance the line. If you are not running in Monitor Mode, set this switch to OFF.

Note: When set to on, the switch forces the modem to run in high-impedance mode by 
removing the 600  load from the receive line.

13.3.1. Master Simulation Mode – Modem Connection

Master Simulation  Mode
Modem Connection

 

Master 
Receive 

Pair

Master 
Transmit

Pair

RTU 
Receive 

Pair

RTU 
Transmit 

Pair

RTU

Test Set Modem

(Only one channel required)

ASE2000 Test Set

BCOM-USB

RS-232 Cable

USB Cable

 Modem 
Power Cable
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13.3.2. RTU/IED Simulation Mode – Modem Connection

Master 
Station

RS-232
Modem Cable

Master Station 
Modem

Master 
Receive 

Pair

Master 
Transmit 

Pair

RTU 
Receive 

Pair

RTU 
Transmit 

Pair

 

Test Set Modem

ASE2000 Test Set

BCOM-USB

RS-232 Cable

USB Cable

 Modem 
Power Cable

`
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13.3.3. Monitor Mode – Modem Connection

Master 
Station

RS-233
Modem Cable

RTU

RTU
Modem

Communication
Line

Master Station 
Modem

Master 
Receive Pair

Master 
Transmit

PairChannel A
Receive Pair

Channel B
Receive Pair

Dual-Channel
Bell-202 
Modem

Yellow 
Black
Red
Green

Receive

Transmitt

Test Set Phone Line 
Cable Detail

BCOM- USB

USB Cable

Modem Power Cable

RS-232 Cable

RS-232 Cable
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14. ASE2000 Network Protocol Use
The ASE2000 currently supports three network based protocols, DNP 3 LAN/WAN, Modbus 
TCP, and IEC 60870-5-104. All three Communication Modes, Master, RTU, and Monitor mode 
are supported but there are different physical connection requirements depending on which 
mode(s) is to be used. 

The ASE2000 uses the standard PC network interface device (NIC) for all network communication 
but still requires that either the BCOM-USB device or ASE USB Dongle be installed on the PC 
where the ASE2000 software is to be run. Even though the PC network interface is used for 
network communication, the BCOM-USB or USB dongle is still used to enable the ASE2000 
software. 

If the test set computer has multiple network adaptor interfaces, it may be necessary to designate 
which adaptor the ASE2000 test set should use. For devices with multiple adaptors, right-click 
the “…” field (Browse icon) to the right of the IP Address box and select Properties. From the list 
of available adaptors, select the appropriate adaptor. 

Basic test set operation is the same for both network and serial protocols but there are a few 
set-up differences that the user must be aware of. 

14
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14.1. Master Mode 
In Master Mode, the test set will operate as a Master and issue commands to and receive 
responses from a remote device. To address the proper device, it will be necessary to configure 
both the IP address and device (RTU/IED) address in the ASE2000. To set the network address 
of the remote device, select Tools > Properties >DNP3 LAN/WAN>Options tab (or other protocol 
as appropriate). Either Browse for the name of the remote (slave device) or enter the IP address 
in the Host field. Select IPv6 when entering Host addresses using the broader IPv6 address 
space.

For DNP3 LAN/WAN, specify Stream for TCP or Datagram for UDP. Also for DNP3 LAN/WAN 
the Port address can be changed but it is recommended that the default value of 20000 be 
used. The protocol address (RTU address) of the device is specified the same as with the serial 
version of the protocol on the Exchange List view by double-clicking on the exchange name or 
setting the address on all exchanges using the “Tools > Properties > Protocol”

In Master Mode, there are no special connection requirements or connection restrictions. The 
test set PC can be connected directly to the remote device, through a router, a switch, or a hub 
as shown below.
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RTU

Router / Switch / Hub

ASE2000
Test Set

Master Mode

RTU

Router / Switch / Hub

ASE2000
Test Set

 Master Mode Example 1 Master Mode Example 2

Once the address configuration and physical connection is complete, test set operation is the 
same as for serial operation. 

14.2. RTU Mode 
In RTU Mode, the test set will operate as a remote device and respond to commands received 
from a SCADA Master. Special configuration is not necessary for network communication. As 
the “remote” device, the test set software will accept incoming connection requests and, from 
that point on, test set operation is the same as with a serial connection. If the device protocol 
address is set to the default value *, the test set will respond to requests containing any address. 
Alternatively, a specific protocol address (RTU address) for the device is can be specified the 
same as with the serial version of the protocol on the Exchange List view by double-clicking on 
the exchange name or setting the address on all exchanges using the “Properties > Protocol 
Specific	>	Exchange	Defaults	tab”.

In RTU Mode, there are no special connection requirements or connection restrictions. The test 
set PC can be connected directly to the remote device, through a router, a switch, or a hub as 
shown below.

SCADA
 Master

Router / Switch / Hub

ASE2000
Test Set

RTU Mode
SCADA
 Master

Router / Switch / Hub

ASE2000
Test Set

 RTU Mode Example 1  RTU Mode Example 2

Once the address configuration and physical connection is complete, test set operation is the 
same as for serial operation. 

14.3. Monitor Mode 
In Monitor Mode, the test set will monitor and display communication messages between two or 
more devices that are communicating using the designated network protocol.

Unlike Master Mode and RTU Mode, there are physical connection requirements that must be 
followed in order for the test set to have access to the messages between the devices to be 
monitored. 
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In Monitor Mode, the ASE2000 test set forces the network interface to operate in what is called 
“promiscuous” mode. This allows the test set to read network messages that are not addressed 
to the device the test set is running on. In order for this to work, it is necessary for the test set 
PC and either the SCADA Master or the remote device to be on a common network segment. 
This is most commonly accomplished by plugging the devices into a common hub; not a router 
or switch. It is necessary to use a hub in this case so the messages between the devices being 
monitored will be present on the LAN segment the test set is connected to. A router or switch 
will only pass messages to a port if the addressed device is known by the switch or router to be 
connected to that port. So, if you connect the test set directly to a port on a router or switch for 
monitoring purposes it won’t work since the router/switch will not pass the data to that port. As 
described above, a router or switch can be used for Master or RTU mode but not Monitor mode. 
Since a hub passes all data to all connected ports, data for the devices being monitored will be 
available to the test set only if the test set and at least one of the devices being monitored is 
connected to the hub. It is possible, and most likely necessary, to use routers and switches in 
other parts of the network but a hub must be used for the monitored devices. See connection 
examples below.

SCADA
 Master

RTU

Hub

ASE2000
Test Set

Monitor Mode
SCADA
 Master

RTU

Hub
ASE2000
Test Set

 Monitor Mode Example 1  Monitor Mode Example 2

As with serial communication, it is possible to filter the data processed and displayed by ASE2000 
test set using network protocols. With serial communications, the filtering is accomplished by 
setting the device address on the Exchange List view. With network protocols, filtering can be 
set at the IP addresses level and the device address level. 

To set an address filter at the IP address level, enter the host name or IP address of the device to 
be monitored. The default value “Any” will display messages between all devices on the network 
segment using the designated protocol. Select the IPv6 option on the LAN/WAN Properties page 
when entering Host addresses using the broader IPv6 address space.
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15. ASE2000 V2 Command Line Options
The ASE 2000 V2 supports several command line options. To specify command line options you 
can:

1. Add them to a Windows shortcut
• Create a shortcut (select the ASE2000V2 from the start menu, right-click, Send to, Desktop 

(create shortcut))
• Right-click on the shortcut, Properties
• Add command line options to the Target value (outside the quotation marks)

2. Launch the ASE2000 V2 from the command line in a DOS window
• From the start menu, type ‘cmd’ into the search (or run) box
• On the command line, navigate to the ASE2000 V2 program directory
• Add command line options to the end of the program name

For example:
“C:\Program Files (x86)\ASE\ASE2000 V2 Communication Test Set\Ase 2000 Communication 
Test Set.exe” /task /rtu /start=500

The ASE2000 V2 command line options are as follows:

<filename> – open an Exchange mode configuration file (.MONX)
• Only effects Exchange mode
• For example: “Ase 2000 Communication Test Set.exe” DNP3-Serial.monx

/portA or /portB – assigns one or both port number(s)
• /portA=COM<a> and/or /portB=COM<b>
• The port number must include the ‘COM’ prefix (/portb=11 is not valid)
• If the provided port number is not available, the option is ignored
• Command line port numbers override the default assignment

/reset – launch program with Default screen layout (use this option if the screen has been moved 
or arranged in error, such as losing the toolbars or menus)

/task – launch program in Task mode (default is the last mode used)

/rtu – launch the program in RTU Simulation mode

/monitor – launch the program in Monitor mode

/name – select an active RTU in Task mode
• /name=<rtuname> where <rtuname> is an active RTU in the Tasks pane list
• For example: /name=MB-235 or /name=”DNP3 Meter 14”
• Use quotes around name if it includes spaces
• The name must match exactly including upper & lower case
• If the name is not found, the /start command is ignored

15
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• If the program launches in Exchange mode, this option has no effect
• /start – start communications when launched
• /start or /start=time where time is an optional wait time before starting
• If time is not specified, a default wait of one second is used
• A time value of up to 120 will wait that number of seconds, for example /time=10
• A value greater than 120 will be interpreted as milliseconds, for example /time=500
• When /start is specified, communications will be started as though the start button was clicked 

according to the following:

Exchange Mode Task Mode
Master 
Simulation

Attempt to send exchanges with the 
Transmit flag set

Attempt to send first command in list of 
available tasks

Monitor Mode Start monitoring Start monitoring
RTU Simulation Start scanning as RTU Start scanning as RTU
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16. ASE BELL-202 Dual-Channel Modem Adjustment
This section illustrates and explains the gain and sensitivity adjustments on the ASE Bell-202 
Dual-Channel Modem.

T
X
L

R
X
L

C
D
L

T
X
L

R
X
L

C
D
L

Off

On
Monitor
Mode

Dual Channel ModemMODEM B MODEM A

Modem Adjustments
The modem contains six potentiometers as shown in the diagram above, three for Channel A 
and 3 for Channel B. The adjustments control transmitter gain, receiver gain, and carrier detect 
sensitivity levels. 

Note: There are two types of potentiometers that are assembled in the modems. 
Most of the modems are supplied with white potentiometers but some modems 
manufactured after 1998 have yellow or orange colored potentiometers. The 
adjustment direction for these potentiometers is reversed from the white 
potentiometers. Consequently, the meanings of cw and ccw are interchanged.

Make sure you identify the type of potentiometer before attempting adjustments. 

The type of potentiometer can be determined by looking through the adjustment hole to determine 
the color. 

16.1. Adjusting Modems with White Colored Potentiometers
TXL Transmitter Gain - Factory setting is 1/8 of a turn from the counter-clockwise (ccw) end. 
Transmit levels range from –50 dBm in the ccw direction to –6 dBm in the clockwise (cw) direction.
RXLReceiver Gain - Factory setting is ¼ of a turn from the counter-clockwise end. Receive 
sensitivity levels range from –6 dBm in the ccw direction to –54 dBm in the cw direction.
CDL Carrier Detect Sensitivity - Factory setting is completely counter-clockwise. Sensitivity is 
–30 dBm in the ccw direction to –48 in the cw direction.

TXL Transmitter Gain - Factory setting is 1/8 of a turn from the counter-clockwise 
(ccw) end. Transmit levels range from –50 dBm in the ccw direction to –6 dBm 
in the clockwise (cw) direction.

RXL Receiver Gain - Factory setting is ¼ of a turn from the clockwise end. Receive 
sensitivity levels range from –6 dBm in the cw direction to –54 dBm in the ccw 
direction.

16
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CDL Carrier Detect Sensitivity - Factory setting is completely clockwise. Sensitivity 
is –30 dBm in the cw direction to –48 in the ccw direction.

16.2. Adjusting Modems with Orange or Yellow Colored 
Potentiometers

TXL Transmitter Gain - Factory setting is 1/8 of a turn from the clockwise (cw) 
end. Transmit levels range from –50 dBm in the cw direction to –6 dBm in the 
counter-clockwise (ccw) direction.

RXL Receiver Gain - Factory setting is ¼ of a turn from the clockwise end. Receive 
sensitivity levels range from –6 dBm in the cw direction to –54 dBm in the ccw 
direction.

CDL Carrier Detect Sensitivity - Factory setting is completely clockwise. Sensitivity 
is –30 dBm in the cw direction to –48 in the ccw direction.
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17. RS-232 Cable And Adapter Pin-Out

17.1. DB-25 Connector PIN-OUT
Pin Signal Name Signal Description
1 ---- Protective Ground 
2 TXD Transmitted Data 
3 RXD Request To Send 
4 RTS Request To Send 
5 CTS Clear To Send 
6 DSR Data Set Ready 
7 GND Signal Ground/Common 
8 CD Carrier Detect 
9 --- +Voltage 
10 --- -Voltage 
11 --- ---- 
12 SCF 2nd Line Detector 
13 SCB 2nd Clear To Send 
14 SBA 2nd Transmitted Data 
15 DB DCE Element Timing 
16 SBB 2nd Received Data 
17 DD Received Element Timing 
18 ----- Unassigned 
19 SCA 2nd Request To Send 
20 DTR Data Terminal Ready 
21 CG Signal Quality Detector 
22 RI Ring Detector 
23 CH/CI Data Signal Rate Detector 
24 DA DTE Element Timing 
25 ---- Unassigned 

17.2. DB-9 Connector PIN-OUT
Pin Signal Name Signal Description
1 CD Carrier Detect 
2 RXD Receive Data
3 TXD Transmit Data
4 DTR Data Terminal Ready
5 GND Signal Ground/Common
6 DSR Data Set Ready
7 RTS Request To Send

17
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8 CTS Clear To Send
9 RI Ring Indicator

17.3. DB-9 to DB-25 Adaptor
The following table illustrates the pin-out of a “standard” DB-9 to DB-25 adaptor.
DB-9 DB-25 Signal Description
1 8 DCD – Data Carrier Detect
2 3 RXD – Receive Data
3 2 TXD – Transmit Data
4 20 DTR – Data Terminal Ready
5 7 Com – Common
6 6 DSR – Data Set Ready
7 4 RTS – Request To Send
8 5 CTS – Clear To Send
9 22 RI – Ring Indicator

This type adaptor should be used whenever it is necessary to convert between a DB-25 and 
DB-9 connector.

17.4. DB-25 Null Modem Adaptor (Standard)
The following table illustrates the pin-out of a “standard” DB25 to DB-25 Null Modem Adaptor. 

Signal Description DB-25M DB-25F Signal Description
Protective Ground 1 1 Protective Ground
TXD – Transmit Data 2 3 RXD – Receive Data
RXD – Receive Data 3 2 TXD – Transmit Data
RTS – Request To Send** 4 8 DCD – Carrier Detect
CTS – Clear To Send** 5 8 DCD – Carrier Detect
DSR – Data Set Ready 6 20 DTR – Data Terminal Ready
COM – Common (Sig. Gnd) 7 7 COM – Common (Sig. Gnd)
DCD – Carrier Detect 8 4 RTS – Request To Send**
DCD – Carrier Detect 8 5 CTS – Clear To Send**
DTR – Data Terminal Ready 20 6 DSR – Data Set Ready 

 
**Note: Pins 4 and 5 (RTS, CTS) on both the DB-25 Male and DB-25 Female side are 
tied together and connected to pin 8 (DCD) of the other side.
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17.5. DB-9 Null Modem Adaptor (Standard)
The following table illustrates the pin-out of a “standard” DB9 to DB-9 Null Modem Adaptor. 

Signal Description DB-9M DB-9F Signal Description
DCD – Data Carrier Detect 1 7 RTS – Request To Send**
DCD – Data Carrier Detect 1 8 CTS – Clear To Send**
RXD – Receive Data 2 3 TXD – Transmit Data 
TXD – Transmit Data 3 2 RXD – Receive Data
DTR – Data Terminal Ready 4 6 DSR – Data Set Ready
COM – Common (Sig. Gnd) 5 5 COM – Common (Sig. Gnd)
DSR – Data Set Ready 6 4 DTR – Data Terminal Ready
RTS – Request To Send** 7 1 DCD – Data Carrier Detect
CTS – Clear To Send** 8 1 DCD – Data Carrier Detect

**Note: Pins 7 and 8 (RTS, CTS) on both the DB-9 Male and DB-9 Female side are tied 
together and connected to pin 1 (DCD) of the other side.

17.6. ASE RS-232 Monitor Adaptor Cable

DB25 Female

DB25 Female DB25 Male

8 ft.

2
3
4
5
6
7
8

15
17
20
24

2
3
4
5
6
7
8

15
17
20
24

Transmit Data
Receive Data
Request to Send
Clear to Send
Data Set Ready
Signal Ground
Carrier Detect
Transmit  Clock
Receive Clock
Unused
Data Terminal
Ready

3 4 5 7 8 3 4 5 7 8

NOTE: Pins 4 and 5 are
jumpered within the

connector

1 ft. (cable length)

APPLIED SYSTEMS ENGINEERING, INC.

TGEN-110 Monitor Adaptor Cable

Revision 2 4/5/2001

NOTES:
  1.  24 Guage Wire
  2. Unshielded Cable

Please label
connector "DTE"

Please label
connector "DCE"

(DTE) (DCE)
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18. ASE2000 Kit Contents
The ASE2000 is provided in kit form with all the necessary software, cables, adaptors, and 
documentation to configure an operational test set. The actual kit contents will vary according to 
ASE2000 model and are detailed in the following sections. 

18.1. Model ASE2000-USB-M
• ASE2000 Software Installation CD-ROM. This CD contains both the ASE2000 Application 

software installation files and the I/O driver files for the ASE dual-channel BCOM-USB device 
and the SafeNet Pro/SuperPro Security Plug (dongle).

• ASE dual channel BCOM-USB device 
• USB Cable – PC to BCOM-USB
• USB to ASE 2-Channel Modem Power Cable
• Two RS-233 Cables, each with a DB-9 Female connector on one end and a DB-25 Male 

connector on the other end.
• ASE Bell-202 or CCITT V.23 dual-channel modem and two RJ-11 cables with fork-lug 

connectors (optional only with the BCOM-USB models)
• DB-25 female-female gender changer
• DB-25 null modem adapter
• DB-9 to DB-25 adaptors
• RS-232 monitor-mode adapter cable
• ASE2000 documentation - ASE2000 Communication Test Set User Guide.

18.2. Model ASE2000-USB-RS
• ASE2000 Software Installation CD-ROM. This CD contains both the ASE2000 Application 

software installation files and the I/O driver files for the ASE dual-channel BCOM-USB device 
and the SafeNet Pro/SuperPro Security Plug (dongle).

• ASE dual channel BCOM-USB device 
• USB Cable – PC to BCOM-USB
• Two RS-233 Cables, each with a DB-9 Female connector on one end and a DB-25 Male 

connector on the other end.
• DB-25 female-female gender changer
• DB-25 null modem adapter
• DB-9 to DB-25 adaptors
• RS-232 monitor-mode adapter cable
• ASE2000 documentation - ASE2000 Communication Test Set User Guide.

18.3. Model ASE2000-COM
• ASE2000 Software Installation CD-ROM. This CD contains both the ASE2000 Application 

software installation files and the I/O driver files for the ASE dual-channel BCOM-USB I/O card 
and the SafeNet Pro/SuperPro Security Plug (dongle).

• SafeNet parallel port (LPT) or USB dongle for desktop or laptop PCs. The hardware dongle 
included in this package enables the ASE2000 software. 

• Two RS-233 Cables, each with a DB-9 Female connector on one end and a DB-25 Male 
connector on the other end.

18
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• DB-25 female-female gender changer
• DB-25 null modem adapter
• DB-9 to DB-25 adaptors
• RS-232 monitor-mode adapter cable
• ASE2000 documentation - ASE2000 Communication Test Set User Guide.
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19. ASE2000 Kit Components

19.1. ASE dual channel BCOM-USB device with two RS-232 
cables, USB cable, and BCOM-USB to ASE 2-Channel 
Modem power cable. 

19.2. ASE Bell-202/CCITT V.23 Dual-Channel Modem

19
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19.3. DB-25 Female-Female Gender Changer

19.4. DB-9 to DB-25 adapter

19.5. RS-232 Cable with DB-9 Female and DB-25 Male
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19.6. SafeNet USB Port and Parallel Port (LPT) dongle
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20. BCOM-USB Device Guide

20.1. BCOM-USB Overview
BCOM-USB is a 2-channel, serial RS-232 device that connects to a PC through a USB port. 
This device is intended to be used with the ASE2000 Communication Test Set and replace 
the BCOM-PCMCIA board which, due to the eventual obsolescence of the PCMCIA/CardBus 
interface on PCs may not be usable on newer PCs. In addition to handling the traditional byte 
oriented protocols such as DNP3, Modbus, IEC 870-5-101, etc. the BCOM-USB will also handle 
bit-oriented protocols such as Conitel 2020, CDC Type I and II, as well as SDLC/HDLC protocols. 

Please see the ASE web site at http://www.ase-systems.com/DNP-3-protocol/DNP-3.asp for a 
complete list of supported protocols.

20.2. BCOM-USB Device Description
The BCOM-USB device kit consists of the following items:
• 2-channel BCOM-USB device
• Two DB-9 Female / DB-25 Male Cables
• 6’ USB Cable with standard A / B connectors
• 6’ Power cable to power the ASE 2-channel Bell-202 test set modem

20
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20.3. BCOM-USB Components 
When provided as an “Upgrade Kit” to an existing ASE2000 Test Set kit with a PCMCIA card, 
parallel port dongle, or USB dongle, the above components plus documentation and software 
installation CD will be provided. The RS-232 Monitor Cable, DB-9 to DB-25 adaptors, NULL 
modem adaptor, and gender changer from the original test set kit will be retained and used with 
the BCOM-USB. The test set enabling device, BCOM-PCMCIA card or dongle, must be returned 
as part of the Upgrade Procedure. 

When provided with a new, complete ASE2000 Communication Test Set, the BCOM-USB 
components together with the other standard test set kit cables and adaptors will be provided. 

The front of the BCOM-USB device has a USB connector for connection to a PC and LED 
indicators for serial communication activity indications. Each channel has: 

TX – Transmit Data
RX – Receive Data
RTS – Request To Send
CTS – Clear To Send
CD – Data Carrier Detect
ERR – Error Indication

Front View

The back of the BCOM-USB device has two DB-9 Male connectors and a Modem Power 
connector. The +5VDC Modem Power connector (MDM PWR OUT) is only for powering the 
ASE 2-channel Bell-202 Test Set Modem from the BCOM-USB device. IT MUST NOT BE USED 
FOR ANY OTHER PURPOSE!
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Rear View

WHEN CONNECTING THE POWER CABLE BETWEEN THE BCOM-USB DEVICE 
AND 2-CHANNEL ASE BELL-202 TEST SET MODEM, THE USB CABLE BETWEEN 
THE PC AND BCOM-USB DEVICE MUST BE DISCONNECTED.

 
CONNECT ALL POWER AND RS-232 CABLES BEFORE CONNECTING THE BCOM-USB 
DEVICE TO THE PC.

The bottom of each BCOM-USB device contains a serial number which is used for device 
registration and BCOM-USB license management. For certain support and upgrade situations, 
you may be asked to provide this serial number.

Bottom View
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20.4. BCOM-USB RS-233 pin-out
The following table illustrates the pin-out of the BCOM-USB 9-pin connectors. 

DB-9 Signal Description
1 DCD – Data Carrier Detect
2 RXD – Receive Data
3 TXD – Transmit Data
4 DTR – Data Terminal Ready
5 Com – Common
6 RXCLKIN – Receive Clock In
7 RTS – Request To Send
8 CTS – Clear To Send
9 TXCLKOUT – Transmit Clock Out

20.5. BCOM-USB I/O Driver Installation
This section describes the steps necessary to install the I/O drivers for the BCOM-USB Device. 
There are several sets of I/O driver distribution files for different versions of Windows and, for 
Windows 7/8/8.1, a set of driver files for 32-bit systems and another for 64-bit systems. It is 
extremely important that the correct set of files be used for the specific Windows environment. 
For Windows 7/8/8.1 systems, a set of digitally signed driver files are provided for both the 32-bit 
and 64-bit versions of the driver. 

The BCOM-USB I/O Driver files are provided on the ASE2000 Communication Test Set software 
distribution CD and are also available for download from the ASE web site at:

http://www.ase-systems.com/ASE2000-test-set/ase2000-downloads.asp

The digitally signed Windows 7 versions of the driver are available on the ASE web site and on 
ASE2000 Communication Test Set software distribution CD Version 1.52 and later. 

There are two separate sections below containing I/O driver installation instructions; one section 
for Windows 2000/XP/Vista and another section for Windows 7 and 8. Please note, a 64-bit 
version of the BCOM-USB driver is available for Windows 7 and Windows 8. 

There are many similarities in the driver installation instructions between Windows 2000/XP/
Vista and Windows/8/8.1 but there are important differences so please follow the instructions 
appropriate for the version of Windows being used.

Regardless of the version of Windows being used, the driver installation process will involve the 
installation of two separate drivers for each of two serial I/O channels (COM Ports). There are 
four components which Windows must install for a complete installation. As a result, there are 
many repetitive steps which must be followed to insure a complete installation of the components 
required for the BCOM-USB I/O driver. DO NOT ABORT THE INSTALLATION UNTIL ALL 
COMPONENTS HAVE BEEN INSTALLED. 

If installing from the ASE2000 Communication Test Set software distribution CD, insert the CD in 
the PC. The CD is configured to “auto run” the ASE2000 Installation procedure so cancel out of 
this operation. At this point, the Driver installation files can be copied to the PC hard driver and 
installed from there or installed directly from the CD. 
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20.5.1. BCOM-USB Windows 2000/XP/Vista I/O Driver Installation

Note: If you are installing the BCOM-USB I/O driver on a Windows 7 or Windows 8 
system, go to the section “Windows 7 I/O Driver Installation”.

The I/O driver files are distributed on the ASE2000 Installation CD as shown in Figure 1 below 
and may also be obtained from the ASE web site at www.ase-systems.com. 

Figure 1

The set of files will be the same whether obtained from the Installation CD or the web site and 
the same set of files is used for Window 2000/XP/Vista.

Connect the BCOM-USB device to the PC using the supplied USB cable. Following the connection, 
Windows will launch the “New Hardware” Wizard. This will be used for the I/O driver installation. 

1. When the following screen appears, select the radio button “No, not this time” and then select 
“Next”.
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Figure 2

2. Select the radio button “Install from a list or specific location” then “Next”.

Figure 3
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3. Browse to the folder containing the I/O driver installation files then select “Next”.

Figure 4

4. On some systems, Windows will issue several warning messages that the “Driver is Not 
Certified”. At each of these instances, select “Continue Anyway”. 

5. When the “Next” button is selected, Windows will copy the driver files for the CDC Applied 
Systems enumerator. 

Figure 5
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6. When the initial file copy has completed, the following screen will appear to indicate the 
“enumerator” driver for the first BCOM-USB port has completed.

Figure 6

7. Select “Finish” to proceed with the next phase. The same sequence of steps as illustrated in 
Figure 2 through Figure 6 will be repeated to install the “enumerator” for the second BCOM-
USB port.

8. When the “enumerator” for the second BCOM-USB port has completed, the same screen as 
shown in Figure 6 will be displayed. 

9. Select “Finish” to proceed with installation of the BCOM-USB Comm Port portion of the 
procedure.

10. The following steps are virtually identical to the steps described previously but will be related 
to installing the second portion of the BCOM-USB driver files. 

Figure 7
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Note, the message is for installing the “usbcdcacm_6_12328……” 

Figure 8
11. Please note, the files for installing the “ASE BCOM-USB Comm Port” are in the same location 

as for the “enumerator”.

Figure 9
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Figure 10

12. When the files for the first BCOM-USB Comm Port have been copied, the following screen 
will appear.

Figure 11
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13. As with the “enumerator” installation, the steps illustrated in Figures 7 through Figure 11 will 
be repeated to install the second BCOM-USB Comm Port.

Following the completion of installation for the second BCOM-USB Comm Port, a message will 
appear in the lower right corner of the screen that:

Your New Hardware is installed and is ready to use

At this point, the driver installation is complete and the BCOM-USB is ready for use.

Following a successful driver installation, the Device Manager screen 
(Control Panel > System > Hardware tab) will show the devices:

• Ports (COM and LPT)
ASE BCOM-USB Comm Port (COMxx)
ASE BCOM-USB Comm Port (COMyy)

• Universal Serial Bus Controllers
CDC Applied Systems enumerator
CDC Applied Systems enumerator

USB Composite Device

These entries are all associated with the BCOM-USB device. Also, since the BCOM-USB is a 
Plug-n-Play device, the entries will only appear when the device is connected. 
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21. BCOM-USB Windows 7 and Windows 8 I/O Driver 
Installation

Note: If you are installing the BCOM-USB I/O driver on a Windows 2000/XP/Vista 
system, go to the section “Windows 2000/XP/Vista I/O Driver Installation”. These 
instructions also apply to Windows 8.

An example of the folder set on the ASE2000 Communication Test Set software distribution CD 
is shown below. For installing on a Windows 7/8/8.1 64-bit system, browse to the “IO Drivers 
Windows 7\BCOM-USB\x64 or \x86”. The \x86 folder is used on 32-bit systems and \x64 on 64-
bit systems. Once in the appropriate folder, the procedures are the same for 32 or 64 bit systems. 

IMPORTANT! PLEASE NOTE: Windows 7/8/8.1 I/O driver installation is different from previous 
versions of Windows and it is extremely important that the following instructions be followed 
carefully to avoid an incorrect installation. The “automatic” driver installation feature of Windows 
7 does not work with the BCOM-USB driver. It is necessary to use the manual installation 
procedure described below.

There are a number of steps involved for a complete installation of both COM ports for the 
BCOM-USB device. It is extremely important that the step-by-step procedures described below 
be followed completely. 

21
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1. In order to initiate certain steps of the installation, it is necessary to use the Device Manager 
screen. From the Windows Start menu, select “Control Panel” and then select “Hardware and 
Sound”.

2. Select “Device Manager”
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The screen shot below, Figure 16, is similar to one you should see on your system prior to 
installation of the BCOM-USB drivers. The Figure 17 screen shot illustrates the Device Manager 
screen following driver installation. 
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In the Post-Driver Installation screen shot, there are two new sets of entries. Under Ports (COM 
& LPT) the COM ports ASE-BCOM-USB Comm Port (COM9) and (COM10) have been added 
and under Universal Serial Bus controllers two CDC Applied Systems enumerator entries have 
been added, one for each BCOM-USB COM port.

3. Identify the location containing the I/O Driver files to be used for the installation. In the steps 
below, it will be necessary to “point” the windows installer to this folder. The files can be 
obtained from the ASE2000 Communication Test Set installation CD or downloaded from the 
ASE web site at:

http://www.ase-systems.com/ASE2000-test-set/ase2000-downloads.asp

 

This section contains the step-by-step instructions for the actual driver installation. Please follow 
the steps carefully and verify the results of each step with the corresponding screen shots. Due 
to system variations, some information may be slightly different but the general content should 
be similar.

1. Connect the USB cable between the BCOM-USB device and the PC. Upon connection, 
Windows will read certain device information from the BCOM-USB device and attempt to 
locate a previously installed I/O driver for the device. Since no driver has been previously 
installed, Windows will be unsuccessful in locating the driver and will display the following 
screens. Initially, a small message block will be shown in the lower left corner of the screen 
indication the attempt to install the driver with a “Click Here” target to display details. 

2. Click the indicated target to see the screen shown below. Depending on previous driver 
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installations, there are a couple of variations of screen content.

3. Since there are two COM ports, there will, in most cases, be two messages or two entries 
for each step. When status for each “ASEBCOM USB/2Ch Serial” shows “No driver found”, 
select “Close”
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4. Refer to the Device Manager screen and there should be two new entries under Other devices 
for the “No driver Found” BCOM-USB ports.

5. At this point, manually direct Windows to install the drivers. Under Other devices, right-click 
on the first “ASEBCOM USB/2-Ch Serial” entry and select “Update Driver Software”. It is 
extremely important these entries are selected in the correct order so that the COM 
ports will be assigned to the BCOM-USB ports in the correct order.



ASE2000 V2 Communication Test Set User Manual 121

6. When the following screen appears, select the second option, “Browse my computer for 
driver software”.

7. Select the Browse button and browse to the folder containing the driver files. In the example 
below, the system is a Windows 7/8/8.1 64-bit so the folder for the 64-bit version of the driver, 
“x64”, is selected. If you are installing on a Windows 7/8/8.1 32-bit system, select the “x86” 
folder. When the correct folder has been specified, select “Next”.
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8. If digitally signed software from Applied Systems Engineering, Inc. has not previously been 
installed on the PC, the following screen will be displayed. If the check box <Always trust 
software from “Applied Systems Engineering, Inc.”> is checked before selecting the Install 
button, this message will not be displayed in the future. Otherwise, just select the Install 
button.

9. Windows will begin the driver file copy and install.

10. Upon completion of this phase, Windows will display the following screen. Do not select 
the “Close” button until the Device Manager screen updates showing the entry under Ports 
(COM & LPT) and entry under Universal Serial Bus controllers as shown in Figure 29 or until 
the screen shot shown in Figure 30 is displayed. Note: Actual COM port numbers will vary 
on different systems. If this screen is not displayed at this point, skip to Step 11 below for an 
alternative procedure.
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11. Upon completion of this installation phase, the Device Manager screen will be updated to 
indicate the first ASE BCOM-USB Comm Port and CDC Applied Systems enumerator have 
been installed. 

12. On some systems, Windows only performs a partial install in this phase and an additional 
manual step is required to complete installation of the first BCOM-USB COM port. If the 
following screen (or one similar) is displayed following Step 9.
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13. To complete the COM port installation when this partial install occurs, right-click the line 
containing the entry “usbcdcacm_6_nnnnnnnnnn” and then select “Update Driver Software”.

14. Windows will proceed with the COM port installation and will display the following message 
when complete and the first BCOM-USB COM port will have been installed and the Device 
Manager screen should appear as shown in Figure 29 above. 
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15. To install the second BCOM-USB COM port, select (Right-click) the remaining “ASEBCOM 
USB/2-Ch Serial” entry under Other devices then select “Update Driver Software” and follow 
Steps 5 – 8 above. 

16. When both BCOM-USB ports have been installed, the Device Manager screen will appear as 
follows, the installation will be complete, and the BCOM-USB device ready for use.

21.1. BCOM-USB device Troubleshooting
The most common requests for technical support relating to the BCOM-USB device are for I/O 
driver installation support or communication problems.

BCOM-USB I/O Driver Communication Problems

If the I/O drivers appear to be installed correctly but you are unable to communicate with the device 
you want to test, the first thing to do is verify that communications through the BCOM-USB device 
is working properly. To do this, the two BCOM-USB communication channels will be connected 
together and two copies of the ASE2000 software will be used to verify communications. One 
copy will simulate Master operation and the other will simulate RTU operation. Basically the 
ability to send and receive on both BCOM-USB ports will be tested.
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1. Connect the “A” and “B” BCOM-USB channels together using the two RS-232 cables together
with a NULL modem adaptor and gender changer.

2. Use the following link:

http://www.ase-downloads.com/downloads/BCOM-USB-Test.zip 

To download the configuration file which will be used with the ASE2000 software to send/receive 
data. Save the BCOM-USB-Test.monx file in a folder on the local hard drive.

3. Launch the first copy (instance) of the ASE2000 test set by double-clicking on the BCOM-
USB-Test.monx file name. Launch the second copy (instance) of the ASE2000 test set by
double-clicking on the BCOM-USB-Test.monx file name.

4. At this point, there should be two copies of the test set active but not communicating.

http://www.ase-downloads.com/downloads/BCOM-USB-Test.zip
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5. On one of the test copies, select “File > Simulate RTU” or select the “Simulate RTU” icon. 

6. On the other test set copy, move the mouse pointer over the “Data” exchange name in the 
“Exchange List” view then select “File > Send Continuously” or select the “Send Continuously” 
icon.

7. At this point, if the BCOM-USB device is working properly, the screen should look similar 
to the example below. In the Line Monitor view for each test set window there should be a 
series of “Data request” and “Data Response” entries in the interpreted data section and the 
following data in the raw data section:

--> 55 01 02 03 04 05
<-- 55 10 20 30 40 50 

8. If the test set screen looks similar to the above screen, the BCOM-USB device is most likely 
installed and functioning correctly.
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22. ASE License/Firmware Updater 

22.1. ASE License/Firmware Updater Overview
This ASE License/Firmware Updater program will be used whenever a new BCOM-USB device 
license or new device firmware must be installed. 

The BCOM-USB device is the first ASE test set I/O device that utilizes on-board license 
information and field updatable firmware that utilizes an update program rather than firmware 
chip replacement. 

Normally, the License will not need to be updated. However, for PCs running ASE2000 Version 
1.47 or higher, where the BCOM-USB is replacing an ASE 2-Channel PCMCIA Card or Sentinel 
Security Plug (dongle) as part of a BCOM-USB Upgrade transaction, the BCOM-USB devices 
will be shipped with a 60 day license. The license will permit test set operation with the BCOM-
USB device for up to 60 days (from the date of shipment) or 75 executions of the test set using 
the BCOM-USB device. When the original test set equipment (PCMCIA card or Sentinel Dongle) 
is returned to ASE, a new, unlimited, license file will be provided. If the unlimited license file is 
not installed, the BCOM-USB will stop functioning. The only way to re-activate is to install a new, 
unlimited, license. 

Where the BCOM-USB is provided with a new test set purchase, the BCOM-USB will be delivered 
with an unlimited license. 

If the BCOM-USB has a Limited License, the following ASE2000 Test Set message will appear 
each time a request to start communication is made. The specific date and “allowed execution 
count” will depend on when the device was shipped and the number of times the test set 
applications has been run under the Limited License.

22
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22.2. ASE License/Firmware Updater License/Firmware Updater 
Operation

Following installation, the application will automatically launch. If a BCOM-USB device is currently 
connected, the following screen will appear:

The values show in the boxes will be specific to the PC Com Port assignment, Serial Number of 
the BCOM-USB device, and current firmware version number.

When the License/Firmware Updater is launched, it will attempt to locate a BCOM-USB device. 
If one is not attached, the screen will look as follows:
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22.3. ASE License/Firmware Updater New License File 
Installation

New License files will normally be distributed via e-mail. Save the new License file in a convenient 
place on the PC hard drive and start the ASE License/Firmware Updater program:

Select the “New License File” button and the contents of the default folder will appear. Browse to 
the folder containing the new license file and select the appropriate file. Note, the Device Serial 
Number is part of the file name.
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When you double-click on the file name or select “Open”, the program will write the new license 
file to the BCOM-USB device. If the update is successful, the following message will appear:

22.4. ASE License/Firmware Updater New Firmware Installation
The ASE License/Firmware Updater is also used to install new firmware in the BCOM-USB 
device. The BCOM-USB device was released in April 2009 and, although it underwent extensive 
testing prior to release, it is possible that new releases of the firmware will be necessary to 
correct problems found after shipment. Registered users will be notified by e-mail of new firmware 
releases and new release notices will also be posted and available for download from the ASE 
website at www.ase-systems.com. 

Save the new Firmware file in a convenient place on the PC hard drive and start the ASE License/
Firmware Updater program:
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Select the “New Firmware” button and the contents of the default folder will appear. Browse to 
the folder containing the new firmware file and select the appropriate file. Note, the firmware 
release number is part of the file name.

When you double-click on the file name or select “Open”, the program will begin writing the 
new firmware to the BCOM-USB device and a progress bar will be shown on the program main 
screen. 

If the update is successful, the message:

Will be displayed. At this point, the “ERR” LEDs on the BCOM-USB device should be alternating 
on and off (ping-pong). To activate the new firmware, it is necessary to power-off and power-on 
the BCOM-USB device. This is accomplished by removing and re-connecting the USB cable. 
After the firmware update and re-start of the BCOPM-USB device, the current firmware version 
will be displayed on the ASE License/Firmware Updater main display page “Firmware Version:” 
section.
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22.5. ASE License/Firmware Updater Program Installation
This section describes the steps necessary to install the ASE License/Firmware Updater. The 
Updater is distributed on the ASE2000 Installation CD as shown in Figure 43 below and may also 
be obtained from the ASE web site at www.ase-systems.com. 

To initiate installation of the ASE License/Firmware Updater program, double click on the “setup.
exe” file and follow the on-screen instructions.
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23. CDC	Type	I	–	Protocol	Specific
Most test set operations are independent of the specific protocol being used and are described 
in the non-protocol specific topics. The most common protocol specific activity is defining the 
message structure for a particular RTU. This involves defining the number and types of points 
(analog, digital, and accumulator) configured in the device (RTU, IED) under test. This information 
enables the test set to issue the proper data scan request and to parse and correctly display 
information in data response messages. The following sections will describe the protocol specific 
considerations, if any, for Task and Exchange operational modes and, within those modes, any 
communication mode (Line Monitor, Master Simulation, and RTU Simulation) protocol specific 
considerations.

23.1. CDC Type I – Exchange Mode 
For Exchange Mode, protocol specific tasks are editing Exchange Definition and setting RTU 
address information.

23.1.1. CDC	Type	I	–	Edit	Exchange	Definition
Configure one or more Scan exchanges (Scan 1, Scan 2, and Scan 3) with device point 
information. In the following example, the device configuration consists of 16 digital points and 8 
Analog points, in that order. From the Exchange view, right-click on the line containing the Scan 
1 exchange and select Edit Exchange Definition.

23
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Under the “To Master” section, select the element “Points: unknown quantity of points”, select 
“Replace Element”, select “Digital”, then OK.

Expand the updated element and change the repeat count to 1. This indicates 1 “block” of 16 
digital points. Click OK.



ASE2000 V2 Communication Test Set User Manual 136

From the Exchange view, right-click on the line containing the Scan exchange and select Edit 
Exchange Definition. Under the “To Master” section, select the element “Points: Digital: 1 block”, 
select “Add Element”, select “Analog”, then OK. Expand the updated element and change the 
repeat count to 8. This indicates 8 “blocks” of Analog points, one point per block. Click OK.

The modified Exchange Definition for 16 Digital and 8 Analog points is shown above.

Since the Scan 2 command returns only digital points, only the digital point information would be 
configured in the Scan 2 Exchange Definition.

23.1.2. CDC Type I – Set RTU ID and Group
The RTU ID and Group number can be set for all exchanges from the Protocol > Properties 
display or individually on the Exchange List view.

23.1.3. CDC Type I – Exchange Mode Line Monitor
No additional setup is required. If cabling is correct Line Monitoring can be started by selecting 
the Start button. 

23.1.4. CDC Type I – Exchange Mode Master Simulation
If the Communication Properties, Exchange Definition, RTU ID, and Group number have been 
configured, Master Simulation operations can be performed. No additional setup is required.

23.1.5. CDC Type I – Exchange Mode RTU Simulation
If the Communication Properties, Exchange Definition, RTU ID, and Group number have been 
configured, RTU Simulation operations can be performed. No additional setup is required.
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23.2. CDC Type I – Task Mode
For all protocols, Task Mode setup starts by first configuring an RTU and RTU point configuration 
in the device data base or selection of an existing RTU definition. See the non-protocol specific 
section “Task Mode Device Selection and Configuration”. The steps described below for 
activating Line Monitor, Master Simulation, and RTU Simulation activities assume the correct 
RTU configuration has been selected. 

23.2.1. CDC Type I – Task Mode Line Monitor
No additional setup is required. If cabling is correct, Line Monitoring can be started by selecting 

the Line Monitor icon  on the bottom of the test set screen and then selecting the 

Start button.  

While it is best to accurately enter the RTU/point data base as described, it is not required for 
Line Monitor operations. An undefined input point is automatically added to the data base when 
detected.

23.2.2. CDC Type I – Task Mode Master Simulation
Master Simulation operation works by selecting a Task Group and then a Task Activity within that 
group.

For CDC Type I, the Task Groups are Digital & Analog Data (Scan 1), Digital Data (Scan 2), and 
Accumulator Data (Scan 3). 

With the desired Task Activity selected, execute the function one time using the Send Once icon 
or continuously by selecting the Start Button.
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23.2.3. CDC Type I – Task Mode RTU Simulation
Task Mode RTU Simulation utilizes the RTU and Point Data previously configured for the device 
to generate responses to master commands for data values. When RTU Simulation mode is 

selected , the Raw and Increment fields on the Point List view are enterable. This 
provides the capability of changing the simulation value for individual points and to control 
whether the value will change (Increment value) on successive scans. 
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24. CDC	Type	II	–	Protocol	Specific	
Most test set operations are independent of the specific protocol being used and are described 
in the non-protocol specific topics. The most common protocol specific activity is defining the 
message structure for a particular RTU. This involves defining the number and types of points 
(analog, digital, and accumulator) configured in the device (RTU, IED) under test. This information 
enables the test set to issue the proper data scan request and to parse and correctly display 
information in data response messages. The following sections will describe the protocol specific 
considerations, if any, for Task and Exchange operational modes and, within those modes, any 
communication mode (Line Monitor, Master Simulation, and RTU Simulation) protocol specific 
considerations.

24.1. CDC Type II – Exchange Mode 
For Exchange Mode, protocol specific tasks are editing Exchange Definition and set RTU address 
information.

24.1.1. CDC	Type	II	–	Edit	Exchange	Definition
Configure one or more Scan exchanges (Scan 1, Scan 2, Scan 3) with device point information. 
In the following example, the configuration will contain 16 digital points and 8 Analog points, in 
that order. From the Exchange view, right-click on the line containing the Scan 1 exchange and 
select Edit Exchange Definition. 

24
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Under the “To Master” section, select the element “Points: unknown quantity of points”, select 
“Replace Element”, select “Digital”, then OK.

Expand the updated element and change the repeat count to 1. This indicates 1 “block” of 16 
digital points. Click OK. 
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From the Exchange view, right-click on the line containing the Scan 1 exchange and select Edit 
Exchange Definition. Under the “To Master” section, select the element “Points: Digital: 1 block”, 
select “Add Element”, select “Analog”, then OK. Expand the updated element and change the 
repeat count to 8. This indicates 8 “blocks” of Analog points, one point per block. Click OK.

The modified Exchange Definition for 16 Digital and 8 Analog points is shown above.

24.1.2. CDC Type II – Set RTU ID
The RTU ID can be set for all exchanges from the Protocol > Properties display or individually 
on the Exchange List view.

24.1.3. CDC Type II – Exchange Mode Line Monitor
No additional setup is required. If cabling is correct Line Monitoring can be started by selecting 
the Start button. 

24.1.4. CDC Type II – Exchange Mode Master Simulation
If the Communication Properties, Exchange Definition, and RTU ID have been configured, Master 
Simulation operations can be performed. No additional setup is required.

24.1.5. CDC Type II – Exchange Mode RTU Simulation
If the Communication Properties, Exchange Definition, and RTU ID, have been configured, RTU 
Simulation operations can be performed. No additional setup is required.
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24.2. CDC Type II – Task Mode
For all protocols, Task Mode setup starts by first configuring an RTU and RTU point configuration 
in the device data base or selection of an existing RTU definition. See the non-protocol specific 
section “Task Mode Device Selection and Configuration”. The steps described below for 
activating Line Monitor, Master Simulation, and RTU Simulation activities assume the correct 
RTU configuration has been selected. 

24.2.1. CDC Type II – Task Mode Line Monitor
No additional setup is required. If cabling is correct, and the RTU to be tested has been selected, 

Line Monitoring can be started by selecting the Line Monitor icon  on the bottom of 

the test set screen and then selecting the Start button .

While it is best to accurately enter the RTU/point data base as described, it is not required for 
Line Monitor operations. An undefined input point is automatically added to the data base when 
detected.

24.2.2. CDC Type II – Task Mode Master Simulation
Master Simulation operation works by selecting a Task Group and then a Task Activity within that 
group. 

For CDC Type II, the Task Groups are Digital & Analog Data (Scan 1), Digital Data (Scan 2), and 
Accumulator Data (Scan 3). 

With the desired Task Activity selected, execute the function one time using the Send Once icon 
or continuously by selecting the Start Button.



ASE2000 V2 Communication Test Set User Manual 143

24.2.3. CDC Type II – Task Mode RTU Simulation
Task Mode RTU Simulation utilizes the RTU and Point Data previously configured for the device 
to generate responses to master commands for data values.

When RTU Simulation mode is selected , the Raw and Increment fields on the Point 
List view are enterable. This provides the capability of changing the simulation value for individual 
points and to control whether the value will change (Increment value) on successive scans. 
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25. Conitel	–	Protocol	Specific
Most test set operations are independent of the specific protocol being used and are described 
in the non-protocol specific topics. The most common protocol specific activity is defining the 
message structure for a particular RTU. This involves defining the number and types of points 
(analog, digital, and accumulator) configured in the device (RTU, IED) under test. This information 
enables the test set to issue the proper data scan request and to parse and correctly display 
information in data response messages. The following sections will describe the protocol specific 
considerations, if any, for Task and Exchange operational modes and, within those modes, any 
communication mode (Line Monitor, Master Simulation, and RTU Simulation) protocol specific 
considerations.

25.1. Conitel – Exchange Mode 
For Exchange Mode, protocol specific tasks are editing Exchange Definition and set RTU and 
Group address information.

25.1.1. Conitel	–	Edit	Exchange	Definition
Configure one or more Scan exchanges with device point information. In the following example, 
the configuration will contain 24 digital points and 7 Analog points, in that order. From the 
Exchange view, right-click on the line containing the Scan exchange and select Edit Exchange 
Definition. 

25
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Under the “To Master” section, select the element “Points: unknown quantity of points”, select 
“Replace Element”, select “Digital”, then OK.

Expand the updated element and change the repeat count to 2. This indicates 2 “blocks” of 12 
digital points each. Click OK. 
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From the Exchange view, right-click on the line containing the Scan exchange and select 
Edit Exchange Definition. Under the “To Master” section, select the element “Points: Digital: 
2 blocks”, select “Add Element”, select “Analog”, then OK. Expand the updated element and 
change the repeat count to 7. This indicates 7 “blocks” of Analog points, one point per block. 
Conitel documetion refers these “blocks” as sections. Click OK.

The modified Exchange Definition for 24 Digital and 7 Analog points is shown above.

25.1.2. Conitel – Exchange Mode Set RTU ID and Group
The RTU ID and Group number can be set for all exchanges from the Protocol > Properties 
display or individually on the Exchange List view.

25.1.3. Conitel – Exchange Mode Line Monitor
No additional setup is required. If cabling is correct Line Monitoring can be started by selecting 
the Start button. 

25.1.4. Conitel – Exchange Mode Master Simulation
If the Communication Properties, Exchange Definition, RTU ID, and Group number have been 
configured, Master Simulation operations can be performed. No additional setup is required.

25.1.5. Conitel – Exchange Mode RTU Simulation
If the Communication Properties, Exchange Definition, RTU ID, and Group number have been 
configured, RTU Simulation operations can be performed. No additional setup is required.
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25.2. Conitel – Task Mode
For all protocols, Task Mode setup starts by first configuring an RTU and RTU point configuration 
in the device data base or selection of an existing RTU definition. See the non-protocol specific 
section “Task Mode Device Selection and Configuration”. The steps described below for 
activating Line Monitor, Master Simulation, and RTU Simulation activities assume the correct 
RTU configuration has been selected. 

25.2.1. Conitel – Task Mode Line Monitor
No additional setup is required. If cabling is correct, Line Monitoring can be started by selecting 

the Line Monitor icon  on the bottom of the test set screen and then selecting the 

Start butto n . 

While it is best to accurately enter the RTU/point data base as described, it is not required for 
Line Monitor operations. An undefined input point is automatically added to the data base when 
detected.

25.2.2. Conitel – Task Mode Master Simulation
Master Simulation operation works by selecting a Task Group and then a Task Activity within that 
group. 

For Conitel, the Task Groups are Acquire Static Data, Freeze Accumulators, and Controls. 

With the desired Task Activity selected, execute the function once using the Send Once icon or 
continuously by selecting the Start Button.
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25.2.3. Conitel – Task Mode RTU Simulation
Task Mode RTU Simulation utilizes the RTU and Point Data previously configured for the device 
to generate responses to master commands for data values.

When RTU Simulation mode is selected , the Raw and Increment fields on the Point 
List view are enterable. This provides the capability of changing the simulation value for individual 
points and to control whether the value will change (Increment value) on successive scans. 

Another method to change simulation values for individual points is to send control commands 
from the Master as described in the next section.
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25.2.4. Conitel – Mapping Output Controls to Change Input Point Values
To modify values at the RTU by sending controls from the master station, select this feature from 
the Conitel tab in the Properties menu. (This feature is not available for all Conitel variations.) A 
Trip command defaults to a value of zero and a Close command defaults to one. To invert this 
interpretation, check the ‘Invert Trip/Close Value’ option.

Add the control point enclosed in square brackets to the description field of the input point to 
create a link. For Conitel, the point is referenced by group and point number, [Group.Point]. It is 
a one-way link. Individual points may be inverted by prefixing the point ID with an exclamation 
point such as [!2.3].

Binary	link	–	[1.7]	appears	in	the	Description	field	for	Point	MCD	3: Write commands to point 
7 in group 1 will change the value of MCD 3.

Analog	link	–	[2.1]	appears	in	the	Description	field	for	Point	AI	1: A value written to point 1 
in group 2 will be set as the value of AI 1 in group 1. Note that point numbers are relative to their 
position in the group. Point AI 9 represents point 1 in that group (point AI 8 is point 0 in group 2).
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26. DNP3	–	Protocol	Specific	
Most test set operations are independent of the specific protocol being used and are described 
in the non-protocol specific topics. The most common protocol specific activity is defining the 
message structure for a particular RTU. This involves defining the number and types of points 
(analog, digital, and accumulator) configured in the device (RTU, IED) under test. This information 
enables the test set to issue the proper data scan request and to parse and correctly display 
information in data response messages. The following sections will describe the protocol specific 
considerations, if any, for Task and Exchange operational modes and, within those modes, any 
communication mode (Line Monitor, Master Simulation, and RTU Simulation) protocol specific 
considerations.

26.1. DNP3 – Exchange Properties Menu
This Exchange Properties Menu is only available when in Exchange Mode and provides the 
ability to change message processing options. This menu is requested by selecting first an 
Exchange, then the Edit pull-down list, and Edit Exchange Properties option. It is also possible 
to request this menu by double-clicking on the rectangle at the left edge of the exchange.

Following is a sample Edit Properties Menu generated from either of these actions.

26
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26.1.1. DNP3 – Fields
Name is used to identify the exchange on the Line Monitoring and Messages views. This field is 
normally not modified since default names reflect exchange functionality. The name is not used 
by ASE2000 internal processing.

Frequency defines how often a message is to be transmitted (in seconds). It is applicable in 
Master Simulation Mode when communication is started with the Send Continuous or Start 
button. In RTU Simulation Mode, it is used for unsolicited data reporting. It is not applicable in 
Line Monitoring Mode.

When Send Continuous is selected, the selected exchange message is sent immediately and, 
thereafter, at regular intervals specified by the Frequency. 

When Start is selected in Master Simulation mode, each exchange with its Transmit flag 
set is transmitted at the associated frequency. The first transmission occurs at the frequency 
interval after Start, with subsequent transmissions periodically thereafter. For example, if two 
exchanges both have the Transmit flag set, one with a frequency of 2.0 seconds and another 
with 3.0 seconds, the first exchange is sent 2 seconds after Start is pressed and every 2 seconds 
thereafter. The second exchange is sent 3 seconds after Start is pressed and every 3 seconds 
thereafter.

A special frequency value of 0 seconds (along with setting the Transmit flag) causes the 
exchange to be sent once immediately after Start is pressed. 

Note that frequency settings define the desired transmission rate. An exchange is never sent 
before processing of the prior exchange has terminated, either because the entire response has 
not yet been received or because no response has been received and the response timeout 
period has not yet expired.

For RTU Simulation, frequency defines how often an “unsolicited data reporting” message is 
transmitted. Frequency is not used if not operating in unsolicited data reporting mode.

Display	and	Event	flags are as defined in the main ASE200 document. There is no special 
meaning for DNP protocols.

Transmit	flag causes a message to be transmitted according to rules discussed for the frequency 
setting, above. 

Data Link Layer Function is used to select the function code to transmit. Except for one case, 
this field is informational and should not be altered. The one case where it can be changed is to 
switch between User	Data	(No	Confirm) and User	Data	(Confirm). If the default function code 
is either of these, it can be safely modified to the other. The setting (Confirm or Not) is not used 
for processing incoming messages.

Data Link Layer PRM and FCV checkboxes define whether or not the PRM and FCV bits 
should be set in the function code byte. The ASE2000 always sets these fields correctly based 
on the Data Link function code. If modified, an incorrectly formatted message will be sent. The 
checkboxes are included in this menu only for that purpose, that is, to transmit an incorrectly 
formatted message to verify error handling by another DNP3 device.

Dest and Source define the exchange’s Destination and Source addresses. Either an ‘*’ or 
specific value can be entered. An ‘*’ instructs the ASE2000 to use the system default (see 
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Properties Tab and Protocol). If the system default is also ‘*’, then, on reception, any address is 
considered valid. On transmission, 0 is used. If the value is not ‘*’, then the entered value is used 
for both transmission and reception.

Dest and Source are always processed from the point of view of the master. That is, Dest 
is used as the Destination address in messages sent by the ASE2000 acting as a master, or 
received from an external master. For these messages, Source is the source address. 

This is reversed in messages sent by the ASE2000 acting as a RTU, or received from an external 
RTU (outstation). In these cases, Source is used as the destination address and Dest is used 
as the source address.

Application Layer Function is the application layer function code. In most cases, this field is 
set correctly by the ASE2000 and should not be modified. The rare case where modification is 
warranted is for object groups that support both read and write functions. Available application 
layer function codes values are presented in a pull-down list generated by clicking in this field.

Application	Layer	Confirm checkbox requests messages to be sent with the application confirm 
bit set. This option has no impact on the ability of the ASE2000 to correctly process incoming 
messages.

26.1.2. DNP3 – Object List 
The bottom portion of the DNP3 properties Menu presents a list of objects and associated qualifier 
codes. By default, the ASE2000 supplies one object corresponding to the Exchange type. For 
example, the Analog Input exchange contains one object, Object group 30: Analog Input. The 
Object List is empty in Data Link-only exchanges such as Reset Link.

The object list is used for three purposes:
1. To identify an incoming message
2. To allow the user to define variation and qualifier codes for RTU Simulation
3. To allow the user to define point values and modeling parameters for RTU Simulation

Each purpose is discussed in following sections.

26.1.3. DNP3 – Multiple Object Exchanges 

► This subsection provides instructions to configure messages that explicitly address 
multiple object groups, such as a single read for both analog and binary input data. It 
does not contain configuration information for Class Data scans or for read requests 
that address a single object group.

The ASE2000 identifies incoming messages by “best match” against the list of defined exchanges. 
The highest priority in the matching algorithm is the Data Link and Application layer function 
codes. The third level is the object list. Since most DNP3 messages are requests for data, 
which all use the same Data Link and Application layer function codes, the object list becomes 
significant in most matches.

All requests for data use a User Data (confirm or no confirm) data link layer function code and a 
Read application layer function code. These messages are distinguished by the object or list of 
objects they read. The ASE2000 default exchange list includes entries for all single object reads. 
For example, the default list includes a read of static analog data, a read of static binary data, 
and so on. The user may build new exchanges for multiple object reads, for example, a single 
request to read both analog and digital data.
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When a request is received, the ASE2000 matches it against the closest defined exchange. A 
request for a single object only should match one of the default exchanges. A read for multiple 
objects will match a user configured exchange for the same objects, if one exists. If such an 
exchange is not configured, it will match a single object read for the last object in the list. For 
example, a read for static analog and digital data (in that order) will match an exchange configured 
with those two objects in the correct order. If such an exchange does not exist, it will match an 
exchange with only digital data.

The importance of matching a correct exchange is to:
• Identify the exchange in the line monitoring and messages views. The name is selected from 

the exchange matched
• In RTU Simulation mode, transmit the correct response. The response is generated from user 

entries made in the matched exchange 

To create a multiple object exchange:
• Highlight a similar existing exchange, such as Analog input
• Make a copy by highlighting that exchange and selecting Edit/Copy and Edit/Paste. You now 

have two identical exchanges with the same name
• Highlight one of them and select Edit/Edit Exchange Properties. This generates the Exchange 

Properties menu (discussed previously). A portion of the menu for an analog read exchange is:

In the case discussed, you want to modify this exchange to include both analog and binary input 
points.

• Select the line underneath 30: Analog and, using the pull-down lists, create an entry for the 
Binary object

• Notice a third line is created, allowing entry of more objects as required
• When finished, change the exchange name from Analog Input to something more meaningful

The modified exchange will now match a read message requesting both analog and binary input 
data.

26.1.4. DNP3	–	Variation	and	Qualifier	Codes
The variation and qualifier code fields modify message transmission for Master and RTU 
Simulation modes. They are not used to identify an incoming message. 

Variations
Object group variations can be changed from a pull-down generated by clicking in the 
Variation column for the correct object row. The variation pull-down list presents options for the 
corresponding object group.
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If not modified, the ASE2000 uses variation 0 in master request messages and variation 1 in 
RTU response messages.

Qualifier	Codes
Qualifier codes are entered from the object’s properties menu, displayed by double-clicking in 
the area at the far left of the object line.

Selecting the object line and clicking the  button will also display the properties menu.

A qualifier setting is selected from a pull-down list generated by clicking in the qualifier entry 
area.

Click on the desired qualifier. When the selected qualifier requires additional parameter entry, 
such as for a Start/Stop address range, additional entry fields appear under the Qualifier code 
field. For example.
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26.1.5. DNP3 – Point Value Simulation
When acting as a RTU Simulator, the ASE2000 responds to all master requests including those 
for analog, binary, or counter object values. This section provides instructions to define values 
and point modeling parameters for each input object type. 

► The procedures below are used only for Exchange Mode RTU Simulator. For Task 
mode, please refer to the Task Mode RTU Simulation section

Point values and modeling parameters are entered from the Object’s properties menu as 
described in the prior subsection. The appropriate fields from that menu are Value, Increment 
(replaced by Mask for Binary Points), and Quality Code.

Analog Parameters
The menu above shows value and modeling parameters for analog objects.

Value specifies the value to be sent in the next response. This is used for all analogs defined 
by the underlying object group definition. For example, if the definition specifies analog object 
indices 0 to 7, the same value is used for all 8 objects.

Increment specifies an amount to add to the value field after each response. Values are 
incremented to a maximum and then decremented by the same amount to a minimum. The 
cycle is repeated. Maximum and minimum values are set by the ASE2000; the defaults for DNP3 
protocol are +32767 and -32768. They can be viewed and changed from the Properties dialog 
and Point tab.

Quality codes present all Analog object DNP3 quality codes. The message will be sent with all 
quality codes checked.

Binary Parameters
The following menu appears for binary input objects:
 

Value is an 8-bit octet containing states for each set of 8 points. The low bit defines the state of 
the first point in each set of 8. The high bit defines the state for last point in each set of 8. Note 
that this value can be entered in hex by specifying an ‘x’ suffix. For example, 81 is decimal and 
81x is hex.
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Mask specifies an 8-bit mask to exclusive-OR against the value field to create a value for the 
next response. 

Quality codes present all DNP3 Binary object quality codes.

Counters
The following menu appears for counter input objects:

 

Value specifies the value to be sent in the next response. This is repeated for all counters 
contained in the underlying object definition. 

Increment specifies an amount to add the value field for the next response. Values wrap to 
0 after exceeding a maximum. The maximum is set by the ASE2000 and can be viewed and 
changed from the Properties dialog and Point tab.

Quality codes present all DNP3 counter object quality codes.

26.2. DNP3 – Properties Tabs

26.2.1. DNP3 – Protocol Tab (Exchange Mode - Serial and LAN/WAN)
Certain protocol specific properties can entered from the Protocol tab in the Properties menu. 
This menu is accessed by selecting the Tools pull-down list and the Properties option. Following 
is the menu that appears for DNP3 protocol in Exchange Mode.
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Note: Some settings available from the Protocol tab in prior versions of the ASE2000 
V2 have moved to a sub-tab accessible by first selecting the DNP3 Serial or DNP3 
LAN/WAN tab from the Properties menu.

26.2.2. Default Exchange Values
Dest and Source specify default values to use for all exchanges where a specific value is not 
otherwise entered. As stated previously, Dest and Source are entered from the point of view of 
a master. When applied to messages sent from an Outstation (either the ASE2000 acting as a 
RTU or an external outstation), Dest and Source values are swapped.

System Time defines time values to use in all applicable messages sent by the ASE2000, 
both event time stamps and time synchronization messages. When the System time option is 
checked, time is extracted from the host PC. When unchecked, the user specified value is used.

Force Errors contains a list of error-generating instructions that can be followed in preparing a 
message for transmission. Options are:
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Framing Generates a framing error near the start of the message by changing a stop bit 
from 1 to 0. This requires use of an ASE manufactured communication card. 
Also, the Communication properties Native Asynch Mode box must not be 
checked

FCB:0 Transmits the FCB bit state as 0
FCB:1 Transmits the FCB bit state as 1
Header CRC Generates a CRC error in the Data Link header block
Data CRC Generates a CRC error in the first data block following the data link header
NAK Messages Where appropriate, sends a NAK in place of an ACK
Transport FIR Sets the FIR bit in the transport header of all Data link frames
Transport FIN Sets the FIN bit in the transport header of all Data link frames
Application FIR Sets the FIR bit in all application fragment headers
Application FIN Sets the FIN bit in all application fragment headers
Transport Seq Sends incorrect transport header sequence numbers in all Data Link frames 

following the first
Appl Seq/Add 1 In Master Simulation mode, increments the application sequence number by 

2 for each new request (instead of 1). In RTU Simulation mode, responds with 
an application sequence 1 more than in the corresponding request

Appl Seq/Do Not 
Increment

In Master Simulation mode, uses the same application sequence number 
in each request. In RTU Simulation mode, responds with an application 
sequence number 1 less than in the corresponding request

Appl Confirm Seq Uses an application confirm message sequence number 1 less than in the 
message being confirmed

No Data Link Acks Never sends Data link acknowledgement messages
No Application 
Confirms

Never send application layer confirmation messages

DL Start Error Send a message with the first two octets other than 05 64
DFC:1 Transmits the DFC bit state as 1
No Nack Reset Link Never send a NAK to initiate a Reset link resynchronization sequence
Randomly Select Generate an occasional error by applying rules for one of the other Force 

Error options enabled. If this option is not checked, all enabled errors (where 
possible) are processed for every transmission

26.3. DNP3 Options Sub-Tab
Newer versions of ASE2000 V2 display DNP3 features in multiple sub-tabs appropriate to 
the current protocol (DNP3 Serial or DNP3 LAN/WAN) and operational mode (Exchange or 
Task mode). The following topics discuss the Options sub-tab settings. The Options sub-tab is 
accessible by first selecting the DNP3 Serial or DNP3 LAN/WAN tab in the Properties menu. 
(These settings were accessible from the Protocol tab in some earlier versions.)
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26.3.1. DNP3 Serial – Options Sub-Tab (Exchange Mode)
Certain DNP3 Serial protocol specific properties can be entered from the Options sub-tab in the 
Properties menu below the DNP3 Serial tab. Following is the Options menu for DNP3 Serial in 
Exchange Mode.

Asynch. Properties
DNP3 Serial protocol octets are transmitted as 8 data bits, 1 stop bit, and no parity. The ASE2000 
initializes these parameters as defined by the protocol, but allows them to be changed (primarily 
for device testing). Sending a message after any parameter is changed will cause a data reception 
error at any compliant device.

Misc DNP3
AP Fragment Size – DNP3 defines the maximum application fragment size to be 2048 octets. 
The ASE2000 can be configured to use a lesser size in messages it transmits. This field does 
not alter the ASE2000’s ability to parse incoming messages.

Time Base – Time in messages generated by the ASE2000 can use either local time or UTC. 
UTC is the current DNP3 standard.
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26.3.2. DNP3 Serial – Options Sub-Tab (Task Mode)
Additional DNP3 Serial protocol specific properties are added to the Options sub-tab in the 
Properties menu below the DNP3 Serial tab. Following is the Options menu for DNP3 Serial in 
Task Mode.

Use	Data	Link	Confirm
In Task mode, checking this box selects the function code to transmit User	Data	 (Confirm) 
and leaving the box unchecked will transmit User	Data	(Confirm) when applicable. The setting 
(Confirm or Not) is not used for processing incoming messages.

Source Address
DNP3 messages in Task mode will transmit this value as the source address. This source address 
will be used for both Master and RTU simulation in Task mode only.
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26.3.3. DNP3 LAN/WAN – Options Sub-Tab (Exchange Mode)
DNP3 LAN/WAN protocol specific properties can be entered from the Options sub-tab in the 
Properties menu below the DNP3 LAN/WAN tab. Following is the Options menu for DNP3 LAN/
WAN in Exchange Mode.

LAN/WAN Options
Connection Type – Choices are Stream (TCP/IP) or Datagram (UDP/IP)

Port – DNP3 port, the default is 20000

Host – Host to which a connection should be issued. In Exchange Mode, this is used for Master 
Simulation mode only. Either a fixed IP address or remote node name can be entered. The 
Browse button may be used to scan the network for remote node names.

Disable UDP Listen during Master Simulation – This option is used only rarely when multiple 
copies of the Test Set are running on the same machine. When running in Master Simulation, 
the Test Set listens on the UDP port for unsolicited messages from the RTU. In RTU simulation, 
the Test Set also listens on the UDP port for incoming messages from the Master station. Since 
two copies of the application cannot both be listening to the port, the instance running in Master 
Simulation mode will not listen on the UDP port when this option is selected. 

IPv6 – Select IPv6 when providing Host addresses using the broader IPv6 address space. 
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► IPv4 is a 32-bit Internet Protocol addressing mechanism represented as four 8-bit 
decimal values separated by dots as in: “192.168.0.148”. With the explosion of the 
internet and devices using these addresses, IPv6 was introduced with a larger, 128-bit 
addressing mechanism in the form of eight 16-bit hexadecimal values separated by 
colons as in: “2013:08be:9ce8:0000:0000:0000:ff00:034d”.

26.3.4. DNP3 LAN/WAN – Options Sub-Tab (Task Mode)
Following is the Options menu for DNP3 LAN/WAN protocol in Task Mode.

LAN/WAN Options

Connection Type – Choices are Stream (TCP/IP), SSL Stream (Secure TCP/IP), or Datagram 
(UDP/IP)

► SSL certificates are obtained from the Windows Certificate Store. The user requests/
installs his certificates in the store and the ASE2000 Test Set accesses the certificates.

• As a client the Test Set looks for a “user” certificate.
• As a server the Test Set looks for a “machine” certificate.

Port – DNP3 port, the default is 20000

Host – Host to which a connection should be issued. The host is used for Master Simulation 
mode (always) and RTU Simulation Mode (if dual End-Point is checked). Either a fixed IP address 
or remote node name can be entered.

IPv6 – Select IPv6 when providing Host addresses using the broader IPv6 address space. 
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► IPv4 is a 32-bit Internet Protocol addressing mechanism represented as four 8-bit 
decimal values separated by dots as in: “192.168.0.148”. With the explosion of the 
internet and devices using these addresses, IPv6 was introduced with a larger, 128-bit 
addressing mechanism in the form of eight 16-bit hexadecimal values separated by 
colons as in: “2013:08be:9ce8:0000:0000:0000:ff00:034d”.

Dual End Point (Task Mode Only) – Master Simulation Mode tasks always initiate a connection 
on startup. If this option is unchecked, any Master Simulation Mode task will fail if the connection 
is not accepted. If this option is checked, the task will wait until the initiated connection is accepted 
or until it detects an outstation initiated connection. 

In RTU Simulation Mode, a task will initiate a connection on startup if this option is checked

SSL Port – Port to use in conjunction with a SSL Stream Connection Type

26.3.5. DNP3 LAN/WAN – Secured Sockets Layer (SSL)
When using SSL over DNP3 LAN/WAN, the DNP3 Secure Authentication Specification requires 
certificate validation for both sides. These certificates need to be obtained from a trusted 
Certificate Authority (CA). The CA trusted root certificate must also be installed into the appropriate 
certificate store.

• For client operations you must obtain and install into your certificate store a user certificate 
with user authentication.

• For server operations you must obtain and install into your local computer certificate store a 
server certificate.

• Beginning with 2.20, you can now pick the certificates that show up from the user store (Client) 
and local computer store (Server). The certificates are matched by serial number. Note: The 
certificate dropdowns will only show up/populate if you have certificates in your respective 
certificate stores.

► Under Windows 7 and Vista, the test set must be run “As Administrator” in order to use 
SSL in RTU Simulation mode
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26.4. DNP3 Simulation Sub-Tab
Newer versions of ASE2000 V2 display DNP3 features in multiple sub-tabs appropriate to the 
current protocol (DNP3 Serial or DNP3 LAN/WAN) and operational mode (Exchange or Task 
mode). The following topics discuss the RTU Simulation sub-tab settings. The RTU Simulation 
sub-tab is accessible by first selecting the DNP3 Serial or DNP3 LAN/WAN tab in the Properties 
menu. (These settings were accessible from the Protocol tab in some earlier versions.)

26.4.1. DNP3 – Simulation Sub-Tab (Exchange Mode – Serial and LAN/
WAN)

Certain RTU Simulation properties can be entered from the RTU Simulation sub-tab in the 
Properties menu below the DNP3 Serial or DNP3 LAN/WAN tab. Following is the RTU Simulation 
menu for DNP3 in Exchange Mode.

RTU Simulation

Internal Indications – Defines Internal Indication flags to be set in messages transmitted by 
the ASE2000. Clicking in the Internal Indications field generates a pull-down list of all internal 
indications (see above). Note that the Need Time (Time Synch) and Device Restart flags are 
maintained by the ASE2000. Both are set at startup and cleared upon reception of appropriate 
master station commands

Enable Unsolicited – Enables unsolicited data reporting in RTU Simulation mode. When 
enabled, all input object messages with the Transmit flag checked are transmitted at the 
configured frequency

Echo Controls – When selected, responses to select and operate commands are constructed 
as echoes of the incoming request. When unchecked, values to be used in Select and Operate 
responses must be manually entered into the corresponding exchange(s)
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26.4.2. DNP3 – Simulation Sub-Tab (Task Mode – Serial and LAN/WAN)
Both RTU and Master Simulation options are shown in the following Simulation sub-tab menu for 
DNP3 protocols in Task Mode.

RTU Simulation

Self Address Support – Respond to requests for RTU transmission of its address

Allow Link Service not Supported Response – Allows Link Service not Supported Response, 
otherwise NAK is set

Allow Negative Ack Response – Enables unsolicited data reporting in RTU Simulation mode. 
When enabled, all input object messages with the Transmit flag checked are transmitted at the 
configured frequency

Event	Buffer	Size – Configure the number of events stored in the event buffer

Select Timeout – Time in milliseconds before RTU reports a timeout

Max Data Link Retries – Number of data link retries before terminating

Copy Control Output Value to Input – When enabled, control operation data values received 
from the master station are copied to their mapped input points. This feature assists testing of 
master station reaction to different RTU input data without reconfiguring the RTU points list (see 
below for mapping instructions)

Invert Trip/Close Value – This option inverts the value for Copy Control Output mappings such 
that Trip  Close are reversed (see below for mapping instructions)

Master Simulation
Source Address – The source address selects a specific RTU Id for processing Internal Indication 
flags (see below)
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Process IIN – If enabled, this feature will send messages to the RTU Id selected above in 
response to Internal Indications flags appearing in responses from the RTU. In the example 
below, the RTU response to a Binary Input Request contains IIN flags for Need Time and Restart. 
The ASE2000 first forms a Clear Restart Request and sends it to the RTU. In the Clear Restart 
Response, the Restart indication has been cleared. This will be followed by a sequence to 
measure the response delay and write a synchronized date & time to the RTU (not shown).

Disable UDP Listen during Master Simulation – This option is only needed when multiple 
copies of the Test Set are running on the same machine. When running in Master Simulation, 
the Test Set listens on the UDP port for unsolicited messages from the RTU. In RTU simulation, 
the Test Set also listens on the UDP port for incoming messages from the Master station. Since 
two copies of the application cannot both be listening to the same port, the instance running in 
Master Simulation mode will not listen on the UDP port when this option is selected. 

26.4.3. DNP3 – Mapping Output Controls to Change Input Point Values
To modify values at the RTU by sending controls from the master station, select this feature from 
the RTU Simulation sub-tab in the Properties menu. A Trip command defaults to a value of zero 
and a Close command defaults to one. To invert this interpretation, select the ‘Invert Trip/Close 
Value’ check box. 

Add the control point Id enclosed in square brackets to the description field of the input point to 
create the link. The mapping value may appear anywhere in the description field. It is a one-way 
link. Individual points may be inverted by prefixing the point ID with an exclamation point such 
as [!23]. To change digitals using two controls, specify both controls separated by a colon as 
[zero:one]. For example, [3:5], which will set the point value to 0 when operating control point 3 
and set the value to 1 when any control operation to control point 5 is received.

Binary	link	–	[101]	appears	in	the	Description	field	for	Point	DI	201: Write commands to 
point DOs 101 change the value of DI 201

Dual control binary link – [104:107] for Point DI 203: Write zero to DI 203 when operates to 
DOs 104 are received; write one to DI 203 when operates to DOs 107

Negated	 binary	 link	 –	 [!105]	 appears	 in	 the	 Description	 field	 for	 Point	 DI	 205: Write 
commands to DOs 105 change the value of DI 205 to the opposite value

Analog	link	–	[10]	appears	in	the	Description	field	for	Point	AI	22: A value written to point 
AOs 10 will be set as the value of AI 22
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26.4.4. DNP3 Secure Authentication Sub-Tabs
The ASE2000 V2 supports DNP3 Secure Authentication Version 2 (SAv2) and Version 5 (SAv5) 
in Task Mode. Only Secure Authentication Version 5 is supported in Exchange Mode. DNP3 
Secure Authentication can be enabled for all tasks in both Master and RTU simulation modes. 
Messages can then be protected with Challenge or Aggressive Mode challenges.

► See implementation notes on SAv5 for additional technical details.

A few additional tasks, such as Session Key Exchange, are provided to support specific Secure 
Authentication functions.

In Exchange Mode, only Secure Authentication message parsing is supported, allowing 
messages with Secure Authentication functions and objects to be displayed. 

26.4.5. DNP3 – Secure Auth. V2 Sub-Tab (Task Mode – Serial and LAN/
WAN)

The Secure Authentication V2 sub-tab is accessible in Task Mode by first selecting the DNP3 
Serial or DNP3 LAN/WAN tab in the Properties menu. (These settings were accessible from the 
Protocol tab in some earlier versions.) 

Support for Secure Authentication Version 2 is available only when operating in Task Mode. In 
Task Mode, messages can be sent with correct Secure Authentication values, and security of 
incoming messages can be validated. Secure Authentication is discussed in detail in the section: 
DNP3 - Secure Authentication.
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26.4.6. DNP3 – Secure Auth. V5 Sub-Tab (Serial and LAN/WAN)
Full support for Secure Authentication Version 5 is available only when operating in Task Mode. 
In Task Mode, messages can be sent with correct Secure Authentication values, and security of 
incoming messages can be validated. In Exchange Mode, only Secure Authentication message 
parsing is supported, allowing messages with Secure Authentication functions and objects 
to be displayed. Secure Authentication is discussed in detail in the section: DNP3 - Secure 
Authentication Setup.
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26.5. DNP3 – Secure Authentication Setup

26.5.1. DNP3 – Enabling Secure Authentication
Secure Authentication is activated by checking the Enable Secure Authentication checkbox 
from the Secure Auth. sub-tab menu as shown in the prior section. 
 
When Enable Secure Authentication is checked, tasks are processed according to general 
DNP3 Secure Authentication rules and other options selected from this menu. 

It is highly recommended that users be familiar with DNP3 Secure Authentication specifications.

26.5.2. DNP3 – ASE2000 Protection
Secure Authentication processing includes solicitation and storage of an Update Key or Keys, 
required for protecting communication messages. 

► In keeping with standard security procedures, Update Keys are encrypted when stored 
on disk.

Ultimately, the ASE2000 relies on the Windows logon mechanisms for the protection of the 
Update Keys storage. That is, if someone has access to your Windows account, then they will 
have access to any Update Keys you have stored in your account. 
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26.5.3. DNP3 – Update Keys Overview
Central to DNP3 Secure Authentication is the concept of a pre-shared key called the Update 
Key. The Update Key is used to encrypt dynamically created and exchanged Session Keys. 
Session Keys are temporary in that new Session Keys are created and exchanged under various 
circumstances dictated by the DNP3 Secure Authentication Specification. The specification does 
not define a mechanism for the creation and exchange of the Update Key.

The Update Key is the key that must be guarded carefully; knowledge of this key gives you 
complete access to DNP3 Secure Authentication. Each organization has procedures and policies 
regarding the creation of exchange the Update Keys. 

A menu for Update key information entry is accessed by selecting the Manage Update Keys 
option from the DNP3 SAv2 or SAv5 sub-tab menu.
 

The specification defines three types of Update Keys, identified by a non-zero User ID. Only one 
key need be entered to use Secure Authentication, but this key must be the same as used by the 
device to which the ASE2000 communicates. The three types, identified by User ID, are:

Master Key – is a single update key used that can be used for all communication and is entered 
in the Update Key field with a User ID of one (1). 

RTU Key – is a key used for communication to a given RTU. The RTU Key is entered in the 
Update Key field with a User ID of two (2). 

User Key – is a separate key assigned to a given user (master station). On entry, both the User 
ID and associated Key must be provided. A User Key has a User ID of three (3) or higher.

26.5.4. DNP3 – Update Key Entry
The keys themselves are binary, but are displayed in ASCII using a Base64 format, the standard 
format for key display. As the name implies this is a base 64 representation of the key value. 

• A production update key generated from a external source (not the ASE2000) is best entered 
using normal copy and paste operations

• A test update key can be generated by selecting the Key target from the DNP3 Key Entry 
menu. This allows testing of the Secure Authentication functions without the need to acquire 
a key through normal company procedures. The test key must also be provided to the device 
being tested. Obviously, a test key should not be used in a production environment.
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Once the key or keys are specified, from menu fields shown above, select which Active User to 
use: (1) Master, (2) RTU, or (other) User.

26.5.5. DNP3 – Other Secure Authentication Properties
Other global parameters that impact ASE2000 Secure Authentication are:

Aggressive Mode, if checked, enables Aggressive Mode for applicable exchanges. Please refer 
to the Secure Authentication specification for more information.

Session Key Interval defines the maximum time interval, in seconds, between session key 
exchanges

Session Key Count defines the maximum number of application data messages protected by 
Secure Authentication that can occur before a session key update

Maximum Error Count defines the maximum number of Secure Authentication errors that can 
occur before a session key update (SAv2 only)

Session Key Size defines the key size. Use the default, 128, unless instructed otherwise by 
your organization.

Key Change Method selects the mechanism used when key change is made (SAv5 only)

MAC Algorithm selects the SHA (Secure Hash Algorithm) or AES (Advanced Encryption 
Standard) and number of octets (AES is only available for SAv5)

Key Wrap Algorithm selects the AES key wrap algorithm to use
Opt. Critical Functions The DNP Specification defines functions that must be protected by Secure 
Authentication, such as Relay Controls, and functions that may optionally be protected. Those 
optional functions are shown by a pull-down list that occurs after clicking in the Opt. Critical 
Functions. Functions checked in this pull-down list are included in protection processing 
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Statistic Thresholds is used to set thresholds for each security category (SAv5 only)

 

Additional implementation information on Secure Authentication Version 5 (SAv5) is contained in 
the section: Secure Authentication V5 Implementation Notes. 

26.6. DNP3 – Exchange Mode

26.6.1. DNP3 – Exchange Mode Line Monitor
No additional setup is required. If cabling is correct and Interoperability settings entered, Line 
Monitoring can be started by selecting the Start button.

26.6.2. DNP3 – Exchange Mode Master Simulation
Master Simulation operation works best if the Destination and Source addresses are entered 
globally, from Properties and the Protocol tab.

 

Data can then be obtained by transmitting the Class 1/2/3/0 exchange.
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26.6.3. DNP3 – Exchange Mode RTU Simulation
Most DNP3 masters acquire data from an Outstation using Class Data scans. Each response 
to a Class Data scan includes a set of one or more DNP3 data objects appropriate to the class 
being requested. 

• Class 0 is the static class and contains all static object groups, those that report the current 
values of analog, binary, and counter input points

• Classes 1, 2, and 3 are event classes and contain all event/data change object groups. The 
ASE2000 does not differentiate between classes 1, 2, and 3. A request for any or all event 
classes will cause the ASE2000 to respond with all enabled event object group data

To configure a response to a Class 0 data scan, the static object groups that can be included in 
a Class 0 scan response must be configured with point information, discussed in the Exchange 
Properties Menu section. To configure a response to a Class 1/2/3 data scan, the change 
event object groups that can be included in a Class 1/2/3 scan response must be configured. 
Applicable object groups for both static and event data are shown below.

Static Class Objects Event Class Objects
Object 
Group

Description Object 
Group

Description

1 Binary Input (1-bit) 2 Binary Input Change (1-bit)
3 Binary Input (2-bit) 4 Binary Input Change (2-bit)
10 Binary Output Status
20 Binary Counter 21 Binary Counter Change
22 Frozen Counter 23 Frozen Counter Change
30 Analog Input 31 Analog Change Event
32 Frozen Analog Input 33 Frozen Analog Event
40 Analog Output Status

By following instructions in the Exchange Properties Menu section and Object List Subsection, 
each exchange is configured with the correct number of points and point simulation parameters. 
A configured exchange can be included in a Class Data response, simply set the Exchange’s 
Transmit	flag. 
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In RTU Simulation mode, after receiving a request for Class 0, 1, 2, or 3 data, the ASE2000 
generates a response message from all enabled and properly configured exchanges in the 
requested class or classes. 

26.7. DNP3 – Task Mode
Virtually all Task Mode setup starts by first configuring points/objects in the RTU data base. For 
example:

The configuration shown above creates 16 Binary Inputs, 16 Analog Inputs, and 4 Frozen 
Counters.

26.7.1. DNP3 – Task Mode Line Monitor
No additional setup is required. If cabling is correct, Line Monitoring can be started by selecting 
the Start button. 

While it is best to accurately enter the RTU/point data base as described, completeness is not 
required for Line Monitor operations. An undefined input point is automatically added to the data 
base when detected.
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26.7.2. DNP3 – Task Mode Master Simulation
Master Simulation operation works by selecting a task group (Acquire Static Data in the example 
below) in the Tasks View and an individual task within that group. The best way to obtain DNP3 
input data is to continuously transmit the All Static Data Scan task.
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To issue supervisory controls in Task Mode Master Simulation, select the Controls task group 
and provide the desired values as shown below.

 

26.7.3. DNP3 – Task Mode RTU Simulation
Task mode RTU Simulation is mostly automatic. Task Mode starts by selecting a pre-configured 
device, with point object types and indices, such as shown below, already defined. The ASE2000 
automatically generates scan responses consistent with data in this table. There is no need to 
modify any exchanges. NOTE: If Binary or Analog control points are to be simulated, the points 
must be defined in the device configuration. For Binary points this would be Binary Input Status 
points. For Analog controls, this would be Analog Input Status points as shown below.
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The following rules explain how responses are generated from the table below. Point modeling 
is the ability to specify point value changes and is supported by performing data entry in the Raw 
and Increment columns.

• Static objects are always sent with a variation that includes flag (quality code) information
• Event objects are always sent with time
• The Raw column contains the last value sent for the corresponding point/object. A value shown 

in normal video has already been transmitted. A new value can be entered. It appears dim until 
sent, after which it is redisplayed in normal video

• For Binary points, an event is generated on the scan following entry of a new Raw value
• Binary points can be configured to change in every scan response by entering a 1 in the 

Increment column. Each response will then include an event with a state different from the 
prior response 

• Analog points can be configured to change in every scan response by entering a non-zero 
value in the Increment column. Each response will then include a value that will differ from 
the previously transmitted value by the increment amount. Over time, values will ramp up and 
down between high and low limits. A new analog value generated due to a non-zero increment 
is reported as an analog change event
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26.8. DNP3	–	Certification	Tests
For a complete description of the procedure to run the DNP3 Certification Tests, refer to the 
Help section “DNP3 Certification Test Procedures” or the document “ASE2000 Version 2 DNP3 
Certification Procedures”.

26.9. Secure Authentication Version 5 Implementation Notes
Important! Applied Systems Engineering recommends that the Test Set’s Secure Authentication 
implementation should be limited to a lab environment. Use of Test Sets in a production 
environment could lead to security violation issues. 

SAv5 introduces the concept of a Certificate Authority. The Certificate Authority is basically the 
keeper of all secrets, and its interface to a master is not defined by the specification. As a lab 
tool the test set incorporates the Certificate Authority functionality into the test set, as the test set 
needs to know these secrets. 

Storage of production secrets in the Test Set could constitute a security violation issue. Please 
consult your organization’s security professionals for advice regarding your particular situation.

26.9.1. General
• SAv5 adds three more tasks. 

 – User Status Change. This allows the addition, deletion and modification of user status.
 – User Certificate. This allows the addition, deletion and modification of user certificates.
 – Update Key Change. This performs an update key change sequence as defined by the 
update key change method option.

• A predefined user “Common” is created as user one.
• SAv5 requires quite a bit of state to be maintained. If is highly advised that the Test Set’s 

“connect” functionality be utilized when tasks are sent individually. It probably won’t work as 
expected otherwise.

• SAv5 provides three basic modes of update key management as described below.
• To exercise SAV5 you need to perform the following tasks:

 – Select the desired update key management.
 – Distribute and install the appropriate keys.
 – “Connect” to the device.
 – Issue the “Update Key Change” task. This will establish the update key.
 – Continue normal operation, which will establish session keys…

26.9.2. Shared Update Keys
• Fully supported. This is basically the V2 mode of operation with regards to update key 

management. Update keys for each user are persisted.

26.9.3. Symmetric Update Key Change
• Fully supported. Key change methods 3, 4 and 5 are supported. A symmetric key is shared 

between the Test Set and the device. The symmetric key is persisted.

26.9.4. Asymmetric Update Key Change
• This implementation requires Windows Vista SP1 or better. Key Sizes greater than 1024 

require Windows 8 or better. The Key Change Method selection will not display these options 
for the incorrect Windows version.

• Each RTU requires a RSA key pair, the RTU uses the private key and the master needs the 
public key.
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• Each user requires a DSA key pair, the master uses the private key and each RTU needs the 
public key. 

• The test set requires the appropriate private or public RSA and DSA keys depending on the 
test set operation mode. If the appropriate keys are not available to the test set, the messages 
will be flagged as an error.

 – Master mode: User private key and outstation public key.
 – RTU mode: Outstation private key and user public key.
 – Monitor mode: Outstation private key and user public key.

• In general asymmetric key pairs are created by a third party certificate authority which may be 
imported by the test set. However the test set does provide some rudimentary key management 
that may be useful in a lab environment only.

• New Private /Public key pairs may be created by the test set.
• Private /Public key pairs may be imported. 

 – PKCS#12 certificate files using the PFX or P12 format. 
 – XML file according to RFC 3275.

• Public keys may be imported.
 – X509 certificate files using the CRT/CER/DER/PEM format. 
 – PKCS#7 data files using the P7S/P7M/P7B format. 
 – XML file according to RFC 3275.

• Public key of a private/public key pair may be exported. This is a self-signed certificate.
 – X509 certificate files using the CRT/CER/DER/PEM format. 
 – PKCS#7 data files using the P7S/P7M/P7B format. 
 – XML file according to RFC 3275.

• Private keys may not be exported.
• Please note that the following discussion regarding AES-GMAC also pertains to asymmetric 

update key methods that utilize AES-GMAC.

26.9.5. AES-GMAC MAC Algorithm
AES-GMAC is a new optional MAC algorithm for SAv5. This implementation requires Windows 
Vista SP1 or better. The MAC Algorithm selection will not display these options for the incorrect 
Windows version.

However GMAC use comes with some caveats. These caveats are probably not unique to the 
Test Set; you will probably find them in any implementation.

AES-GMAC requires a dynamic initialization vector. This means that the values used for this 
vector may change each time a MAC calculation is performed. Supposedly the master and 
outstation are in agreement on these values at all times. This is mostly true, but not always. The 
problem components are identified here.

• User Number. The value for the user number is not generally known for the User Status Change 
variation. It may be best not to use GMAC if users need to be dynamically maintained. The 
Test Set makes the following assumptions based on the operation.

 – Delete – the user number test set option.
 – Change – the user number test set option.
 – Add – zero

• Key Change Sequence Number. If GMAC is used the specification requires that the KSQ 
number is persistent. The Test Set doesn’t do this, but in any case the specification provides no 
mechanism to synchronize the KSQ explicitly. However the KSQ number can be synchronized 
if the master performs a Key Status Request, the response will contain the outstation’s KSQ.

• Challenge Sequence Number. Basically the same problem, the specification provides no 
explicit mechanism to synchronize the CSQ number on startup or whenever they get out of 
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synchronization for any reason. If a connection protocol (LAN/WAN) is used the CSQ should be 
reset to zero during a new connection, but there is no requirement for this. For a connectionless 
protocol (Serial or UDP) the outstation will probably need to be reset each time the master 
restarts. If for some reason the CSQ get out of synchronization, a TCP/IP connection can be 
reset, otherwise both the master and the outstation will need to be reset.
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27. Harris	5k/6k	–	Protocol	Specific	
Most test set operations are independent of the specific protocol being used and are described 
in the non-protocol specific topics. The most common protocol specific activity is defining the 
message structure for a particular RTU. This involves defining the number and types of points 
(analog, digital, and accumulator) configured in the device (RTU, IED) under test. This information 
enables the test set to issue the proper data scan request and to parse and correctly display 
information in data response messages. The following sections will describe the protocol specific 
considerations, if any, for Task and Exchange operational modes and, within those modes, any 
communication mode (Line Monitor, Master Simulation, and RTU Simulation) protocol specific 
considerations.

27.1. Harris 5k/6k – Exchange Mode 
For Exchange Mode, protocol specific tasks are editing Exchange Definition and setting RTU 
address information. To ensure that ASE2000 correctly transmits and processes responses from 
Harris 5000/6000 Data Dump and Status Dump exchanges modify the corresponding exchange 
definitions to match the I/O port configuration of the RTU. The following information is required 
to properly modify the exchange definitions for the Data Dump and Status Dump exchange 
templates:
• The number of applicable data ports contained in the RTU. For Data Dump, the total number of 

analog and pulse accumulator input ports. For Status Dump, the total number of Status input 
ports.

• For each port, the type and number of points to request

Note: A Data Dump request reads all analog and pulse accumulator ports. A Status 
Dump request reads status (digital) ports.

One unusual requirement in configuring an exchange definition for Harris 5k/6k is that in addition 
to editing the “To Master” section of the exchange definition which is a requirement for most 
protocols, it is also necessary to edit the “To RTU” portion of the exchange definition.

27.1.1. Harris	5k/6k	–	Edit	Exchange	Definition	for	Data	Dump
The following example illustrates configuring a Data Dump exchange definition for 8 analog and 
4 accumulator points.

Right-click the Data Dump exchange in the Exchange List view and select Edit Exchange 
Definition. In the “To RTU” section, select the 3rd entry in the list (Data: 0 Words), select Replace 
Element, select Constant, then OK.

27
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Expand that element (Constant: 1 word, value 00x) and set the Value to 8.
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Add another port specifier entry by selecting the 3rd element in the list under “To RTU” then 
select Add Element, select Constant, then OK.

Expand the newly added element and set Value to 4 then OK
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The “To RTU” section has now been modified to request 8 points (Analogs) from the 1st Data 
Dump port and 4 points (Accumulator) from the 2nd Data Dump port.

Edit the “From RTU” portion of the Data Dump exchange to specify the number and type of points 
to be returned from each port. One of the confusing aspects of the Harris 5000/6000 protocol 
is that there is port status information intermixed with the data returned from the RTU. So, for 
each port, the RTU response message contains data values followed by port status for that port 
followed by data values and port status for the next port. For the Data Dump response, this is 
repeated for each port. The screen shot below shows the default exchange definition which is 
one analog port and one pulse accumulator port.

Edit the entries as shown on the following screen shot to specify one analog port with 8 points 
and one pulse accumulator with 4 points. 
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Set count for 
number of Analog 
and Pulse 
Accumulator 
ports

Set count for 
number of Analog 
and Pulse 
Accumulator 
points

27.1.2. Harris 5k/6k – Set RTU ID and Group
The RTU ID and Group number can be set for all exchanges from the Tools>Properties>Protocol 
tab or individually on the Exchange List view.

27.1.3. Harris 5k/6k – Exchange Mode Line Monitor
No additional setup is required. If cabling is correct Line Monitoring can be started by selecting 
the Start button. 

27.1.4. Harris 5k/6k – Exchange Mode Master Simulation
If the Communication Properties, Exchange Definition, and RTU ID have been configured, Master 
Simulation operations can be performed. No additional setup is required.

27.1.5. Harris 5k/6k – Exchange Mode RTU Simulation
If the Communication Properties, Exchange Definition, and RTU ID have been configured, Master 
Simulation operations can be performed. No additional setup is required. Note, if the RTU ID is 
set to * the test set will respond to any RTU ID.

27.2. Harris 5k/6k – Task Mode
For all protocols, Task Mode setup starts by first configuring an RTU and RTU point configuration 
in the device data base or selection of an existing RTU definition. See the non-protocol specific 
section “Task Mode Device Selection and Configuration”. Note, when configuring the points for 
a Harris 5k/6k device, it is necessary to specify the point type for each port. 

Group Type Command Point Type
Analog Data Dump Analog
Pulse (Accumulator) Data Dump Pulse Accumulator
Digital Status Dump Digital
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The steps described below for activating Line Monitor, Master Simulation, and RTU Simulation 
activities assume the correct RTU configuration has been selected.

27.2.1. Harris 5k/6k – Task Mode Line Monitor
No additional setup is required. If cabling is correct, Line Monitoring can be started by selecting 

the Line Monitor icon  on the bottom of the test set screen and then selecting the 

Start button.  

While it is best to accurately enter the RTU/point data base as described, it is not required for 
Line Monitor operations. An undefined input point is automatically added to the data base when 
detected.

27.2.2. Harris 5k/6k – Task Mode Master Simulation
Master Simulation operation works by selecting a Task Group and then a Task Activity within that 
group. 

With the desired Task Activity selected, execute the function one time using the Send Once icon 
or continuously by selecting the Start Button.

27.2.3. For Harris 5k/6k, the Task Activities are:
• Analog and Accumulator Static Scan (Uses Data Dump command)
• Analog Static Scan (Uses Data Dump command)
• Accumulator Static Scan (Uses Data Dump command)
• Status Static Scan (Uses Status Dump command)

27.2.4. Harris 5k/6k – Task Mode RTU Simulation
Task Mode RTU Simulation utilizes the RTU and Point Data previously configured for the device 
to generate responses to master commands for data values. When RTU Simulation mode is 
selected, the Raw and Increment fields on the Point List view are enterable. This provides the 
capability of changing the simulation value for individual points and to control whether the value 
will change (Increment value) on successive scans.
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28. IEC	60870-5	–	Protocol	Specific	
Most test set operations are independent of the specific protocol being used and are described 
in the non-protocol specific topics. The most common protocol specific activity is defining the 
message structure for a particular RTU. This involves defining the number and types of points 
(analog, digital, and accumulator) configured in the device (RTU, IED) under test. This information 
enables the test set to issue the proper data scan request and to parse and correctly display 
information in data response messages. The following sections will describe the protocol specific 
considerations, if any, for Task and Exchange operational modes and, within those modes, any 
communication mode (Line Monitor, Master Simulation, and RTU Simulation) protocol specific 
considerations.

28.1. IEC 60870-5 – Exchange Properties Menu
This Exchange Properties Menu is only available when in Exchange Mode and provides the 
ability to change message processing options. This menu is requested by selecting first an 
Exchange, then the Edit pull-down list, and Edit Exchange Properties option. It is also possible 
to request this menu by double-clicking on the rectangle at the left edge of the exchange.

Following is a sample Edit Properties Menu generated from either of these actions.

28
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28.2. IEC 60870-5 – Fields
Name is used to identify the exchange on the Line Monitoring and Messages views. This field is 
normally not modified since default names reflect exchange functionality. In some cases, a user 
may create two similar exchanges, in which case the name can be changed for differentiation. 
For example, one Single Point exchange may be used for points 100 to 109, while a second 
might be for points 110 to 119, in which case names such as Single Point 100-109 and Single 
Point 110-119 might be meaningful. The name is not used by ASE2000 internal processing.

Frequency defines how often a message is to be transmitted (in seconds). It is applicable in 
Master Simulation Mode when communication is started with the Send Continuous or Start 
button, and in RTU Simulation Mode. It is not applicable in Line Monitoring Mode.

When Send Continuous is selected, the selected exchange message is sent immediately and, 
thereafter, at regular intervals specified by the Frequency. 

When Start is selected in Master Simulation mode, each exchange with its Transmit flag set is 
transmitted at the associated frequency. The first transmission occurs at the frequency interval 
after Start, with subsequent transmissions periodically thereafter. For example, if two exchanges 
both have the Transmit flag set, one with a frequency of 2.0 seconds and another with 3.0 
seconds, the first exchange is sent 2 seconds after Start is pressed and every 2 seconds 
thereafter. The second exchange is sent 3 seconds after Start is pressed and every 3 seconds 
thereafter.

A special frequency value of 0 seconds (along with setting the Transmit flag) causes the exchange 
to be sent once immediately after Start is pressed. This is typically used with the STARTDT 
ACT exchange for IEC 60870-5-104 protocol, and also commonly used with the Interrogation 
exchange for both IEC 60870-5-101 and IEC 60870-5-104.

Note that frequency settings define the desired transmission rate. An exchange is never sent 
before processing of the prior exchange has terminated, either because the entire response has 
not yet been received or because no response has been received and the response timeout 
period has not yet expired.

► For IEC 60870-5-101 protocol in master simulation mode, the ASE2000 normally sends 
Class 1 and Class 2 requests in addition to the exchanges manually configured for 
transmission. These exchanges do not have to be explicitly enabled. Please see the 
Properties tab section for more discussion.

In RTU Simulation mode, frequency defines how often information objects are queued for 
transmission. For example, if a Single Point exchange is configured for transmission2 with a 10 
second frequency, then it is inserted into the Class 2 response queue every 10 seconds. After 
insertion, it is sent based on its queue position.

Display	and	Event	flags are as defined in the main ASE200 document. There is no special 
meaning for IEC protocols.

Transmit	flag causes a message to be transmitted according to rules discussed for the frequency 
setting, above. For Master Simulation for IEC 60870-5-104 protocol, it is important that the 
STARTDT message be enabled for transmission at a 0.0 second frequency.

2 For 101, in response to Class 1 and Class 2 requests; for 104, automatically.
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Interrogation	flag is unique to IEC protocol and applies when operating in RTU Simulation 
and Exchange modes. When enabled for a Monitor-Direction Process-Information ASDU (IEC 
terminology for input points), it causes that ASDU to be queued for transmission after receipt of an 
Interrogation request. Integrated Total ASDUs are queued in response to Counter Interrogation 
requests. Other applicable ASDUs are queued in response to General Interrogation requests. 
There is no special processing for Group Interrogations.

Data Link Layer Function (IEC 60870-5-101 only) is used to select the Data Link function code 
for transmission. Except for one case, this field is informational and should not be altered. The 
one case where it can be changed is to switch between User	Data	(No	Confirm) and User Data 
(Confirm). If the default function code is either of these, it can be safely modified to the other. 
The setting (Confirm or Not) is not used for processing incoming messages.

Data Link Layer PRM and FCV checkboxes define whether or not the PRM and FCV bits 
should be set in the function code byte. The ASE2000 always sets there fields correctly based 
on the Data Link function code. If modified, an incorrectly formatted message will be sent. The 
checkboxes are included in this menu only for that purpose, that is, to transmit an incorrectly 
formatted message to verify error handling by another IEC device.

DL Addr (IEC 60870-5-101 only) defines the exchange’s data link address. Either an ‘*’ or specific 
value can be entered. An ‘*’ instructs the ASE2000 to use the system default (see Properties Tab 
and Protocol). 

If the system default is also ‘*’, then, on reception, any address is considered valid. On transmission 
in Master Simulation mode, 0 is used. On transmission in RTU Simulation mode, the data link 
address extracted from the corresponding request message is used.

If the value is not ‘*’, then the entered value is used for both transmission and reception. In this 
case, a message received with any other address is considered invalid.

Comm Addr defines the exchange’s common address of ASDU. Either an ‘*’ or specific value 
can be entered. An ‘*’ instructs the ASE2000 to use the system default (see Properties Tab and 
Protocol). 

If the system default is also ‘*’, then, on reception, any address is considered valid. On transmission 
in Master or RTU Simulation mode, 0 is used. 

If the value is not ‘*’, then the entered value is used for both transmission and reception. In this 
case, a message received with any other address is considered invalid.

ASDU Type ID defines the exchange’s application data type, such as Single Point or Measured 
Value. While this field can be changed from the associated pull-down list, there should be no 
reason to do so since the ASE2000 provides one exchange for every ASDU Type. The Type 
and the exchange name should coincide as it would be confusing to change one without also 
changing the other.

Cause Of Transmission, in general, should not be modified except for Process Information 
ASDUs in the Monitor Direction, and then only when operating in Exchange and RTU Simulation 
modes. For these Exchanges, the Cause Of Transmission defines the value used in all messages 
sent except Interrogation responses (in which case, the cause is changed to “Interrogated”). The 
ASE2000 assigns one of the many acceptable settings when the exchange is created.
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Test, when checked, sets the Test Flag in the cause of transmission octet in messages transmitted 
by the ASE2000. This field has no impact on the ability of the ASE2000 to identify incoming 
messages.

P/N, when checked, sets the P/N Flag in the cause of transmission octet in messages transmitted 
by the ASE2000. This field has no impact on the ability of the ASE2000 to identify incoming 
messages.

Variable	Structure	Qualifier/Count defines the number of Information Objects to include when 
transmitting this message. It has no impact on message reception. It should only be modified 
for ASDU Types that support multiple objects, such as most Process Information ASDUs in the 
Monitor Direction. The number of entries in the Information Object table adjusts to the entered 
count.

SQ sets the exchanges SQ (sequential) flag. When SQ is set, an information object address 
can only be entered only for the first object. Addresses for other objects are assumed to be 
sequential ascending from the first. When SQ is clear, information object addresses can and 
should be entered for all objects.

Object Class is used in RTU Simulation mode. Two transmission queues are maintained: one 
for class 1 and one for class 2. 

Information Object Table supports object information entry for use in RTU Simulation mode. 
The value of each object can be entered directly into this table. Other information such as quality 
codes and point modeling parameters can be entered from the object properties menu, accessed 
by double clicking on the   target at the left of the object line.

The number of objects in each exchange is defined by the value in the Count filed (discussed 
above). 



ASE2000 V2 Communication Test Set User Manual 191

Different properties can be entered for each object. However, when a new object is created, 
its initial properties are copied from the object above where the new objects were created. The 
easiest way to create multiple objects with the same property setting is to start with one object, 
enter its properties, and then set the count to the desired number of objects. This last action 
creates the new objects with duplicate settings to the first.

Properties for the various information objects are described in the following section.

28.3. IEC 60870-5 – Information Object Properties
Information in this section is used in RTU Simulation (and Exchange) modes. It defines information 
to be sent to the controlling station for each object.

Data can be entered either from the Edit Exchange Properties menu or from a menu specific 
to each Information Object.

28.3.1. IEC 60870-5 – Enterable from the Edit Exchange Properties Menu
Information common to all ASDU types is shown on the Edit Exchange Properties menu. 
Specific Information Object menus are displayed when double-clicking on a single Information 
Object or by clicking on the Object Properties button. These include:

Address – the information object address. When the SQ flag is set, the address can be set for 
the first object only. When SQ is cleared, it can be set for all objects

Value – the object (point) value

28.3.2. IEC 60870-5 – Enterable from the Information Object Properties 
Menu

Time Fields
Objects that include Time (event objects) allow setting of the Time Qualifier properties. 

Single Point

SPI is the object value (state), either On or Off
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Quality shows quality codes applicable to this ASDU type
Mask, if 1, instructs the ASE2000 to toggle the value of this object each time it is sent. If 0, the 
value is not toggled

Double Point
Double and single point information is the same except that the single point’s SPI field is replaced 
with DPI for a double point.

Step Position

VTI is the object value

Quality shows quality codes applicable to this ASDU type

Transient State is an additional flag to indicate transient or non-transient status

Bitstring

BSI is the object value

Quality shows quality codes applicable to this ASDU type

Measured Values

NVA is the name of the object value used for Normalized objects. SVA is used for scaled objects 
and FVA for floating point object
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Quality shows quality codes applicable to this ASDU type

Increment specifies an amount to add to the value after each ASE2000-generated response. 
The new value is used in the next response. Values are incremented to a maximum, then 
decremented by the same amount to a minimum. The cycle is repeated. Maximum and minimum 
values are set by the ASE2000. They can be viewed and changed from the Properties dialog 
and Point tab

Totals

BCR is the point value

Quality shows quality codes applicable to this ASDU type

Increment specifies an amount to add to the value after each ASE2000-generated response. 
The new value is used in the next response. Values wrap to 0 after exceeding a maximum. The 
maximum is set by the ASE2000 and can be observed and changed from the Properties dialog 
and Point tab

Protection Events

SPE identifies the type of event

Quality shows quality codes applicable to this ASDU type
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28.4. IEC 60870-5 – Protocol Tab
Certain protocol specific properties can entered from the Protocol Tab in the Properties menu. 
This menu is accessed by selecting the Tools pull-down list and the properties option.

28.4.1. IEC 60870-5-101 Protocol Tab
The IEC 60870-5-101 Protocol Menu is shown below.

DL Addr is the Data Link address, as discussed in the Exchange Properties Menu section

Comm Addr is the Common address of ASDU, as discussed in the Exchange Properties Menu 
section

System Time defines time values to use in all applicable messages sent by the ASE2000, 
both event time stamps and time synchronization messages. When the System time option is 
checked, time is extracted from the host PC. When unchecked, the user specified value is used.

Force Errors contains a list of error-generating instructions that can be followed in preparing a 
message for transmission. Options are:



ASE2000 V2 Communication Test Set User Manual 195

Parity Generates a parity error in the first octet. IEC 60870-5-101 uses even parity. 
This selection requires an ASE manufactured communication card, and also 
requires that the Native Asynch Mode box on the Communication properties 
tab is not checked

Checksum Generates a checksum error
Framing Generates a framing error near the start of the message by changing a stop bit 

from 1 to 0 This selection requires an ASE manufactured communication card, 
and also requires that the Native Asynch Mode box on the Communication 
properties tab must is not checked

FCB:0 Transmits the FCB bit state as 0
FCB:1 Transmits the FCB bit state as 1
NAK Messages Where appropriate, sends a NAK in place of an ACK
No Data Link Acks Never sends Data link acknowledgement messages
Randomly Select Generate an occasional error by applying rules for one of the other Force 

Error options enabled. If this option is not checked, all enabled errors (where 
possible) are processed for every transmission

28.4.2. IEC 60870-5-104 Protocol Tab
The IEC 60870-5-104 Protocol Menu is shown below.

 

Comm Addr is as explained for IEC 60870-5-101
System Time is as explained for IEC 60870-5-101
Force Errors contains a list of error-generating instructions that can be followed in preparing a 
message for transmission. Options are:
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Xmt Seq Error + Increases the Xmit sequence number one more than normal
Xmt Seq Error - Increases the Xmit sequence number one less than normal
Rec Seq Error + Increases the Receive sequence number one more than normal
Rec Seq Error - Increases the Receive sequence number one less than normal
No Supervisory 
Functions

Never transmits a supervisory message 

No unnumbered 
function confirm

Does not confirm reception of unnumbered functions (primarily TESTFR)

Randomly Select Generate an occasional error by applying rules for one of the other Force 
Error options enabled. If this option is not checked, all enabled errors (where 
possible) are processed for every transmission

Randomly Select Generate an occasional error by applying rules for one of the other Force 
Error options enabled. If this option is not checked, all enabled errors (where 
possible) are processed for every transmission

28.5. IEC 60870-5-101 Tab
This section discusses options available from the IEC 60870-5-101 Properties page, accessed 
by selecting the Tools pull-down menu and the Properties tab. 

Asynch Properties
IEC 60870-5-101 protocol octets are transmitted as 8 data bits, 1 stop bit, and even parity. As 
for all serial protocols, the ASE2000 sets these parameters as defined by the protocol but allows 
them to be changed (primarily for device consistency testing). Sending a message after any 
parameter is changed will cause a data reception error at any compliant device
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Interoperability Options
There are three addressing components, the Data Link (DL) address, Common address of 
ASDU, and Information Object address. The protocol allows the size of these fields to vary from 
system to system, although they must be the same for all devices in a given system. 

Also, each address can be structured or not. A structured address implies that the total address 
size, for example 2 octets (16 bits), is logically structured into two subfields of, for example, 8 
bits each. This is purely an interpretation convention. For example, assume the value of a 2-octet 
Common Address is 513. This is hex 0x201. If interpreted as an unstructured number, the value 
is 513. If interpreted as a structured number composed of two 8-bit subfields, the value could be 
displayed as 2.1 (the high 8-bit value is 2 and the low 8-bit value is 1). 

The IEC 60870-5-101 menu allows specification of both the address sizes, whether they should be 
interpreted as structured or unstructured values, and how structured values should be displayed.

1-octet addresses can only be unstructured

2-octet addresses can be unstructured, or structured with an address format of 8.8. This displays 
the 2-octet, 16-bit field, as two 8-bit values

3-octet addresses can be can be unstructured, or structured with an address format of:
• 8.8.8 - three 8-bit values,
• 16.8 - a 16-bit value followed by an 8-bit value, or
• 8.16 – an 8-bit value followed by a 16-bit value

DL Address is the data link address size, 0, 1, or 2 octets. 0 octets is allowed only for balanced 
mode

Common Address is the common address of ASDU size, 1 or 2 octets
Information Object is the information object address size, 1, 2, or 3 octets
Cause of Transmission is the size of the cause of transmission field, 1 or 2 octets. For 2 octets, 
the first is the cause and the second contains an origination address 

Balanced Mode Options
Enabled is set to enable balanced mode, clear for unbalanced mode
Controlling Station Direction (A -> B) For balanced mode, indicates that the DIR bit is set in 
messages originating from the Controlling station. If not selected, the DIR bit is set in messages 
originating from the controlled station. Not used inn unbalanced mode

Unbalanced Mode Options
Class Scan Period is only used when operating as a master (controlling station) in unbalanced 
mode. In addition to exchanges that are explicitly enabled for transmission, this option instructs 
the ASE2000 how often to issue a Class 1 or Class 2 request

Short Ack is set to transmit the 1-octet Short Ack code when applicable. If not set, then the multi-
octet Data Link acknowledgement message is sent

Short Ack Class Response is set when RTU is to send a Short Ack code when no data is 
available instead of a negative response code
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Misc. Options
Time Base – Select Local time or UTC time
Max Term. Wait (secs) – When a termination code is expected but not received, selecting this 
option will end polling after the specified number of seconds

RTU Simulation Options
Copy Control Output Value to Input – When enabled, control operation data values received 
from the master station are copied to their mapped input points. Writing ‘Off’ to a control is 
represented by a value of zero and ‘On’ defaults to one.  To invert this interpretation, select the 
‘Invert Trip/Close Value’ check box.

Add the control output point number enclosed in square brackets, [X], to the description field 
of the input point to create a link.  Only points of the same type may be linked.  It is a one-way 
link.  Individual points may be inverted by prefixing the point ID with an exclamation point such 
as [!23].

Binary link – [20] appears in the Description field for Point DI 12:  Digital Input point 12 and 
Digital Input point 20 are linked and control operations (Single Command) to DI 20 will change 
the value of DI 12

Negated binary link – [!21] appears in the Description field for Point DI 10:  Write commands to 
DI 21 change the value of DI 10 to the opposite value

Analog link – [201] appears in the Description field for Point AI 103:  A value set (Set Point 
Command) to AI 201 will be set as the value of AI 103

Use short exception time types – Send time information in three octets (milliseconds, seconds, 
& minutes) instead of seven octets
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28.6. IEC 60870-5-104 Tab
This section discusses options available from the IEC 60870-5-104 Properties page, accessed 
by selecting the Tools pull-down menu and the Properties tab. 

Interoperability Options
Common Address is the common address of ASDU size, 1 or 2 octets
Information Object - The IEC 60870-5-104 address component is 3-octets in length. It can 
be displayed as a structured or unstructured value. Please refer to the prior IEC 60870-5-101 
section for more information

Timers (Secs)
These timers are defined by the IEC 60870-5-104 specification. They are used in master and 
RTU simulation modes, but not in Monitoring Mode. All values are in seconds.

Send APDUs (t1) – Maximum amount of time between transmission of a message and reception 
of an acknowledgement
Ack/No Data (t2) – Maximum amount of time between reception of a message and transmission 
of a corresponding acknowledgement
Idle Test (t3) – Maximum time period for no message activity, after which a Test message is sent

Outstanding APDUs
Max Xmt (k) Maximum number of APDU messages that will be sent before waiting for an 
acknowledgement
Max Rcv (w) Maximum number of APDU messages that will be received before sending an 
acknowledgement



ASE2000 V2 Communication Test Set User Manual 200

LAN/WAN Options 
Connection Type – Currently, IEC 60870-5-104 only allows stream 
Port – The default is 2404
Host – Host to which a connection should be issued; used for Master Simulation mode only. 
Either a fixed IP address or remote node name can be entered

Misc. Options
Time Base – Select Local time or UTC time
Max Term. Wait (secs) – When a termination code is expected but not received, selecting this 
option will end polling after the specified number of seconds

RTU Simulation Options
Copy Control Output Value to Input – When enabled, control operation data values received 
from the master station are copied to their mapped input points. Writing ‘Off’ to a control is 
represented by a value of zero and ‘On’ defaults to one.  To invert this interpretation, select the 
‘Invert Trip/Close Value’ check box.

Add the control output point number enclosed in square brackets, [X], to the description field 
of the input point to create a link.  Only points of the same type may be linked.  It is a one-way 
link.  Individual points may be inverted by prefixing the point ID with an exclamation point such 
as [!23].

Binary link – [20] appears in the Description field for Point DI 12:  Digital Input point 12 and 
Digital Input point 20 are linked and control operations (Single Command) to DI 20 will change 
the value of DI 12

Negated binary link – [!21] appears in the Description field for Point DI 10:  Write commands to 
DI 21 change the value of DI 10 to the opposite value

Analog link – [201] appears in the Description field for Point AI 103:  A value set (Set Point 
Command) to AI 201 will be set as the value of AI 103

Quick-Start IEC 60870-5-101 / IEC 60870-5-104

This section presents the quickest way to start ASE2000 communication for an IEC protocol. 
There are separate requirements for Line Monitor, Master Simulation, and RTU Simulation 
operation, and for Task and Exchange modes.
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28.7. IEC 60870-5 – All Modes and Operational Types
For IEC 60870-5-101, all Interoperability sizes must be entered from the IEC 60870-5-101 
properties menu. This is not required for IEC 60870-5-104.

28.8. IEC 60870-5 – Exchange Mode

28.8.1. IEC 60870-5 – Exchange Mode Line Monitor
No additional setup is required. If cabling is correct and Interoperability settings entered, Line 
Monitoring can be started by selecting the Start [communications] button. 

28.8.2. IEC 60870-5 – Exchange Mode Master Simulation
Master Simulation operation requires entry of the Common Address of ASDU and, for 101 only, 
the Data Link address. Entry is made from Properties and the Protocol tab.

To obtain initial data for all points, the Interrogation exchange should be enabled with a 
transmission frequency of 0.0 seconds, causing it to be sent once at startup. For IEC 60870-5-
104, the STARTDT exchange must be similarly enabled.

No further setup is required. Select Start.

28.8.3. IEC 60870-5 – Exchange Mode RTU Simulation
RTU simulation requires entry of the Common Address of ASDU. The Data Link address may 
be entered, but is not required. If the default setting of ‘*’ is unmodified, the ASE2000 transmits 
every response message using the Data Link address contained in the associated request. 
(Remember that Data Link address is sued for IEC 60870-5-101, but not IEC 60870-5-104).

The major additional setup step is to configure input point data ASDUs. (No setup is required for 
analog or digital control outputs.) For each Process Information ASDU in the Monitor direction to 
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be sent to the master, edit transmission information from the Exchange Proprieties menu. The 
example presented below is for Single Points. While other properties than those shown can be 
entered, a basic RTU simulation configuration requires entry only of those shown.

28.9. IEC 60870-5 – Task Mode
Virtually all Task Mode setup starts by first configuring points/objects in the RTU data base. For 
example:

The configuration shown above creates 24 Single Points, 16 Measured Values, and 24 Double 
Points with consecutive Information Object address starting at the address contained under the 
First Point ID column.
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28.9.1. IEC 60870-5 – Task Mode Line Monitor
No additional setup is required. If cabling is correct and Interoperability settings entered, Line 
Monitoring can be started by selecting the Start button. 

While it is best to accurately enter the RTU/point data base as described, completeness is not 
required for Line Monitor operations. An undefined input point is automatically added to the data 
base when detected.

28.9.2. IEC 60870-5-101 Task Mode Master Simulation
Master Simulation operation works by selecting a task group in the middle of the Tasks View 
and an individual task within that group. The best way to obtain process (input) data from an IEC 
60870-5-101 Controlled Device (RTU) is to:

• Select and send once the General Interrogation task from within the Acquire Static Data 
grouping

 

• Select and play continuously the Class Scan task from within the Acquire Exception Data 
grouping
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28.9.3. IEC 60870-5-104 Task Mode Master Simulation
IEC 60870-5-104 does not have a Class Scan function since the Controlled Station sends point 
data independently of requests from the Controlling Station. Whether the ASE2000 sends a 
General Interrogation message periodically or only once is controlled by the Frequency property. 
The default value, 2.000 seconds, causes a General Interrogation to be sent once every 2 
seconds. A Frequency setting of -1 causes a General Interrogation to be sent only once when 
the task is started, while keeping communication open until stopped by the user. This is different 
from the Send Once option, which causes a General Interrogation to be sent once when the task 
is started, but then stops communication when the General Interrogation completes.
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28.9.4. IEC 60870-5 – Task Mode RTU Simulation
No additional setup is required. While RTU Simulation is active, input point values and states can 
be entered from the Point Values view.

Raw values entered are transmitted at the next opportunity. Other use of this view is described 
in the main ASE2000 Version 2 document.

28.9.5. IEC 60870-5 – Task Mode File Transfer
This section provides details on use of the Task Mode file transfer capabilities. These procedures 
are the same for IEC 60870-5-101 and IEC 60870-5-104.

The File Operations task group has two tasks: Read File and Write File. Prior to starting either 
operation, values for four properties must be entered.
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To help locate and enter both the local file (Controlling Station file on disk) and remote file 
(Controlled Station Common Address/Information Object Address), browse functions are 
supported by clicking the right edge of either the Local File Name or Information Object Address 
fields.
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Once all parameters are entered, select the desired operation (Read or Write) and the Send 
Once target to initiate the file action.
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29. Modbus	–	Protocol	Specific	
Most test set operations are independent of the specific protocol being used and are described 
in the non-protocol specific topics. The most common protocol specific activity is defining the 
message structure for a particular RTU. This involves defining the number and types of points 
(analog, digital, and accumulator) configured in the device (RTU, IED) under test. This information 
enables the test set to issue the proper data scan request and to parse and correctly display 
information in data response messages. The following sections will describe the protocol specific 
considerations, if any, for Task and Exchange operational modes and, within those modes, any 
communication mode (Line Monitor, Master Simulation, and RTU Simulation) protocol specific 
considerations.

29.1. Modbus – Exchange Mode
For Exchange Mode, protocol specific tasks are editing Exchange Definition and setting RTU 
address information.

29.1.1. Modbus	–	Edit	Exchange	Definition
Configure one or more Read exchanges (Read Coil Status, Read Input Status, Read Holding 
Reg, Read Input Regs) with device point information. The specific Read exchange(s) to configure 
is a function of how points are configured in the device. In the following example, the device 
configuration consists of 16 Input Coil points and 8 Analog points in Input Registers. 
 
From the Exchange view, right-click on the line containing the Read Coil Status exchange and 
select Edit Exchange Definition. 

29
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Under the “To Master” section, expand the element “Digital: unknown quantity of blocks”, set 
“Repeat Count” to 2 (8 digital points per block), then OK.

From the Exchange view, right-click on the line containing the Read Input Regs exchange and 
select Edit Exchange Definition. 
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Under the “To Master” section, expand the element “Analog: unknown quantity of blocks”, set 
“Repeat Count” to 8 (1 analog point per count), then OK.

29.1.2. Modbus – Set RTU ID and Group
The RTU ID and Group number can be set for all exchanges from the Protocol > Properties 
display or individually on the Exchange List view.

29.1.3. Modbus – Exchange Mode Line Monitor
No additional setup is required. If cabling is correct Line Monitoring can be started by selecting 
the Start button. 

29.1.4. Modbus – Exchange Mode Master Simulation
If the Communication Properties, Exchange Definition, and Slave device number have been 
configured, Master Simulation operations can be performed. No additional setup is required.

29.1.5. Modbus – Exchange Mode RTU Simulation
If the Communication Properties, Exchange Definition, and Slave device number have been 
configured, Master Simulation operations can be performed. No additional setup is required

29.1.6. Modbus – Task Mode
For all protocols, Task Mode setup starts by first configuring an RTU and RTU point configuration 
in the device data base or selection of an existing RTU definition. See the non-protocol specific 
section “Task Mode Device Selection and Configuration”. Note, when configuring the points for 
a Modbus device, it is necessary to specify the type of digital and analog points. This is done in 
the “Group Type” as follows:

Group Type Definition Point Type
CS Coil Status Digital
IS Input Status Digital
HR Holding Register Analog
IR Input Register Analog

The steps described below for activating Line Monitor, Master Simulation, and RTU Simulation 
activities assume the correct RTU configuration has been selected.

29.1.7. Modbus – Task Mode Line Monitor
No additional setup is required. If cabling is correct, Line Monitoring can be started by selecting 

the Line Monitor icon  on the bottom of the test set screen and then selecting the 

Start button.

While it is best to accurately enter the RTU/point data base as described, it is not required for 
Line Monitor operations. An undefined input point is automatically added to the data base when 
detected.

29.1.8. Modbus – Task Mode Master Simulation
Master Simulation operation works by selecting a Task Group and then a Task Activity within that 
group.

With the desired Task Activity selected, execute the function one time using the Send Once icon 
or continuously by selecting the Start Button.
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For Modbus, the Task Groups are Acquire Data and Controls. The Acquire Data task Activities 
are Read Coil Status, Read Input Status, Read Holding Regs, and Read Input Regs. The above 
display illustrates Read Coil Status and the display below illustrates the Read Input Regs activity.

29.1.9. Modbus – Task Mode RTU Simulation
Task Mode RTU Simulation utilizes the RTU and Point Data previously configured for the device 
to generate responses to master commands for data values. When RTU Simulation mode is 
selected , the Raw and Increment fields on the Point List view are enterable. This 
provides the capability of changing the simulation value for individual points and to control 
whether the value will change (Increment value) on successive scans.  

Another method to change simulation values for individual points is to send control commands 
from the Master as described in the next section.
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29.1.10. Modbus	–	Configuring	Output	Controls	to	Change	Input	Point	
Values

To modify Coil Status and Holding Register values at the RTU by sending controls from the 
master station, select the “Copy Control Output Value to Input” feature from the Modbus tab in 
the Properties menu.  Writing “Off” to a coil causes ‘0’ to be written to the Input Coil; “On” is ‘1’.  
To invert this interpretation, select the “Invert Trip/Close Value” check box.  
 

When enabled, states written to output coil index ‘n’ will cause a change in the state of input coil 
‘n’, and similarly for writes to Output registers and values of Holding Registers.
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30
30. Telegyr	8979	–	Protocol	Specific	
Most test set operations are independent of the specific protocol being used and are described 
in the non-protocol specific topics. The most common protocol specific activity is defining the 
message structure for a particular RTU. This involves defining the number and types of points 
(analog, digital, and accumulator) configured in the device (RTU, IED) under test. This information 
enables the test set to issue the proper data scan request and to parse and correctly display 
information in data response messages. The following sections will describe the protocol specific 
considerations, if any, for Task and Exchange operational modes and, within those modes, any 
communication mode (Line Monitor, Master Simulation, and RTU Simulation) protocol specific 
considerations.

30.1. Telegyr 8979 – Exchange Mode
For Exchange Mode, protocol specific tasks are editing Exchange Definition and setting RTU 
address information.

30.1.1. Telegyr	8979	–	Edit	Exchange	Definition
Configure one or more Read exchanges (Analog Force Report, Analog Group Force Report, 
Indication Force Report) with device point information. The specific Read exchange(s) to 
configure is a function of how points are configured in the device. In the following example, the 
device configuration consists of 16 Indication and 8 Analog points.  

From the Exchange view, right-click on the line containing the Analog Force Report exchange 
and select Edit Exchange Definition. 

Under the “To Master” section, expand the element “Analog: unknown quantity of blocks”, set 
“Repeat Count” to 8 (1 analog point per block), then OK.
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From the Exchange view, right-click on the line containing the Indication Force Report exchange 
and select Edit Exchange Definition. 

Under the “To Master” section, expand the element “MCD: unknown quantity of blocks”, set 
“Repeat Count” to 2 (8 Indication points per count), then OK.

30.1.2. Telegyr 8979 – Set RTU ID and Group
The RTU ID can be set for all exchanges from the Tools>Properties>Protocol tab display or 
individually on the Exchange List view.

30.1.3. Telegyr 8979 – Exchange Mode Line Monitor
No additional setup is required. If cabling is correct Line Monitoring can be started by selecting 
the Start button. 

30.1.4. Telegyr 8979 – Exchange Mode Master Simulation
If the Communication Properties, Exchange Definition, and RTU ID have been configured, set 
the Start and Stop point numbers for the Analog Force Report and Indication Force Report on the 
Exchange Properties display or on the Exchange List display. Bring up the associated Exchange 
Properties display by double-clicking on the exchange name on the Exchange List display. In the 
following example, Start/Stop have been configured for 8 analog and 16 MCD points.
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30.1.5. Telegyr 8979 – Exchange Mode RTU Simulation
If the Communication Properties, Exchange Definition, and RTU ID have been configured, 
Master Simulation operations can be performed. No additional setup is required. RTU ID can be 
set to * (wild card) to respond to any RTU ID.

30.2. Telegyr 8979 – Task Mode
For all protocols, Task Mode setup starts by first configuring an RTU and RTU point configuration 
in the device data base or selection of an existing RTU definition. See the non-protocol specific 
section “Task Mode Device Selection and Configuration”. Note, when configuring the points for 
a Telegyr 8979 device, it is necessary to specify a Group Type for digital and analog points. This 
group information is used by the test set to determine which command to use when polling for 
data. This is done in the “Group Type” as follows:

Group Type Definition Point Type
ANG Analog related commands Analog
ADC Reference Analog Points Analog
IND Indication Points Digital (MCD)
SOE Sequence of Event (SOE) Digital
DIG Digital Input commands Digital
ACC Accumulator commands Pulse Accumulator

The steps described below for activating Line Monitor, Master Simulation, and RTU Simulation 
activities assume the correct RTU configuration has been selected.

30.2.1. Telegyr 8979 – Task Mode Line Monitor
No additional setup is required. If cabling is correct, Line Monitoring can be started by selecting 

the Line Monitor icon  on the bottom of the test set screen and then selecting the 

Start button. 
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While it is best to accurately enter the RTU/point data base as described, it is not required for 
Line Monitor operations. An undefined input point is automatically added to the data base when 
detected.

30.2.2. Telegyr 8979 – Task Mode Master Simulation
Master Simulation operation works by selecting a Task Group and then a Task Activity within that 
group. 

With the desired Task Activity selected, execute the function one time using the Send Once icon 
or continuously by selecting the Start Button.

For Telegyr 8979, the Task Groups are:
• Analog Data
• Indication Data
• SOE Data
• Digital Data
• Accumulator Data
• ADC Reference Data

 The above display illustrates Analog Data (Analog Force Report)  and the display below illustrates   
activity.
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30.2.3. Telegyr 8979 – Task Mode RTU Simulation
Task Mode RTU Simulation utilizes the RTU and Point Data previously configured for the device 
to generate responses to master commands for data values. When RTU Simulation mode is 
selected , the Raw and Increment fields on the Point List view are enterable. This 
provides the capability of changing the simulation value for individual points and to control 
whether the value will change (Increment value) on successive scans.  
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30.2.4. Telegyr 8979 – Mapping Output Controls to Change Input Point 
Values

To modify values at the RTU by sending controls from the master station, select the “Copy 
Control Output Value to Input” feature from the Telegyr 8979 tab in the Properties menu. 

Add the control point index enclosed in square brackets to the description field of the input point 
to create a link between that input point and an output point index, as shown in the screen shot 
below. The number within the square brackets defines the index of an output point. When a 
command is issued to that point, the state/value of the corresponding input point is changed. 

Analog output values are copied directly to an analog input point. For digital controls, a Trip 
command defaults to a value of zero and a Close command defaults to one.

Control commands to a trip/close point 
Binary	link	–	[1]	appears	in	the	Description	field	for	IND	point	1:  Controls to point 1 will 
change the state of indication point 1.

Analog	link	–	[6]	appears	in	the	Description	field	for	AI	point	AI	2:  A value written to analog 
output point 6 will change the value AI 2.
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As stated, the default for control outputs is to associate trip with 0 and close with 1. To invert this 
option, place a ‘!’ symbol before the point index. For example:

• [1] maps a trip to point 1 to ‘0’, and a close to point 1 to ‘1’
• [!1] maps a trip to point 1 to ‘1’, and a close to point 1 to ‘0’
• Comment text can be placed in the description field outside of the square brackets
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